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Chapter
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Preparing for installation
This chapter includes the following topics:
■

Restrictions on the NetBackup installation directory

■

Creating the user account to support the NetBackup web server

■

About compatibility between NetBackup versions

■

About Veritas Services and Operations Readiness Tools

■

Recommended SORT procedures for new installations

■

Recommended SORT procedures for upgrades

■

About NetBackup software availability

■

About storage device configuration

■

How to install NetBackup

■

About security certificates for NetBackup hosts

■

SCCM and Chef deployment tools and documentation now available

■

Support is discontinued for push installation of a master server

Restrictions on the NetBackup installation
directory
Each NetBackup supported file system defines restrictions on file and folder names
for the installation folder. Please consult the file system vendor provided
documentation for more details on the file and the folder name restrictions.
Additionally, NetBackup supports only certain characters for the installation folder
name. Use of non-supported characters can produce unexpected results and
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possibly result in lost data. The NetBackup supported characters for the installation
folder are:
■

UNIX/Linux
The POSIX fully portable file name characters (A–Z a–z 0–9 . _ -)

■

Windows
The printable characters within the ASCII 7-bit range

Note: On Traditional Chinese and Korean versions of Windows, if the NetBackup
client is installed to a path that contains a space, restore operations may fail. An
example of a path with a space is C:\Program Files. Make sure to install the
NetBackup client software to a path that does not contain a space on these versions
of Windows.

Creating the user account to support the
NetBackup web server
Beginning with NetBackup 8.0, the NetBackup master server includes a configured
web server to support critical backup operations. This web server operates under
user account elements with limited privileges. These user account elements must
be available on each master server (or each node of a clustered master server).
You can use numerous procedures to create users and groups in operating systems.
Some specific approaches are shown but other methods may accomplish the same
goal. The home directory path, user name, and group names are not hard-coded,
and can be changed. The default local user name is nbwebsvc, and the default
local group name is nbwebgrp.
Note: For UNIX and Linux platforms, the UID must be the same for each local
account in a clustered environment. Be sure that the local accounts are defined
consistently on all cluster nodes.
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To create the user account and the user group on non-AIX UNIX or Linux

1

Create the local group with the command shown:
Command: /usr/openv/netbackup/bin # groupadd group_name
Example: /usr/openv/netbackup/bin # groupadd nbwebgrp

2

Create the local user account with the command shown:
Command: /usr/openv/netbackup/bin # useradd -g group_name -c
comment -d /usr/openv/wmc user_name

Example: /usr/openv/netbackup/bin # useradd -g nbwebgrp -c
'NetBackup Web Services application account' -d /usr/openv/wmc
nbwebsvc

To create the user account and the user group on AIX

1

Create the local group with the command shown:
Command: # mkgroup group_name
Example: # mkgroup nbwebgrp

2

Create the local user account with the command shown:
Command: # mkuser home='home_directory_path' groups='group_name'
user_name

Example: # mkuser home='/usr/openv/wmc' groups='nbwebgrp' nbwebsvc
To create the user account and the user group on Windows
Note: You must use domain accounts in clustered environments on Windows.

Note: Web service user account names are limited to 20 characters.

1

Create the local user account with the command shown:
Command: C:\>net user user_name StrongPassword /add (where
StrongPassword is a strong password to associate with the account)
Example: C:\>net user nbwebsvc 1U*s7lQ# /add

2

Create the local group with the command shown:
Command: C:\>net localgroup group_name /add
Example: C:\>net localgroup nbwebgrp /add
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3

Make the new user a member of the new group with the command shown:
Command: C:\>net localgroup group_name user_name /add
Example: C:\>net localgroup nbwebgrp nbwebsvc /add

4

Grant the Log On As a Service right to the new user as follows:
■

Go to Control Panel > Administrative Tools > Local Security Policy.

■

Under Security Settings, click Local Policies and then User Rights
Assignment.

■

Right-click on Log on as a service and select Properties.

■

Add the local user.

■

Save your changes and close the Log on as a service properties dialog.

Installation of the NetBackup master server fails if any of these requirements are
not met. On Windows, you are asked to provide the password for the user account
as part of the installation process.

About compatibility between NetBackup versions
You can run mixed versions of NetBackup between master servers, media servers,
and clients. This back-level support lets you upgrade NetBackup one server at a
time, which minimizes the effect on overall system performance. Veritas supports
only certain combinations of servers and clients. The NetBackup catalog resides
on the master server. Therefore, the master server is considered to be the client
for a catalog backup. If your NetBackup configuration includes a media server, it
must use the same NetBackup version as the master server to perform a catalog
backup.
At NetBackup 8.1, it is critical to follow the longstanding requirement that the master
server is upgraded first. Then upgrade all media servers that are required to support
any 8.1 clients. Veritas recommends that you upgrade all your media servers before
upgrading any clients. After all master and all media servers are at NetBackup 8.1,
begin to upgrade your clients to 8.1. Pre-8.1 media servers are not able to backup
or restore NetBackup 8.1 clients.
For complete information about compatibility between NetBackup versions, refer
to the Veritas SORT website.
https://sort.veritas.com/
Veritas recommends that you review the End of Support Life information available
online.
https://sort.veritas.com/eosl
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See “About NetBackup software availability” on page 18.

About Veritas Services and Operations Readiness
Tools
Veritas Services and Operations Readiness Tools (SORT) is a robust set of
standalone and web-based tools that support Veritas enterprise products. For
NetBackup, SORT provides the ability to collect, analyze, and report on host
configurations across UNIX/Linux or Windows environments. This data is invaluable
when you want to assess if your systems are ready for an initial NetBackup
installation or for an upgrade.
Access SORT from the following webpage:
https://sort.veritas.com/netbackup
Once you get to the SORT page, more information is available as follows:
■

Installation and Upgrade Checklist
Use this tool to create a checklist to see if your system is ready for a NetBackup
installation or an upgrade. This report contains all the software and the hardware
compatibility information specific to the information provided. The report also
includes product installation or upgrade instructions, as well as links to other
references.

■

Hot fix and EEB Release Auditor
Use this tool to find out whether a release that you plan to install contains the
hot fixes that you need.

■

Custom Reports
Use this tool to get recommendations for your system and Veritas enterprise
products.

■

NetBackup Future Platform and Feature Plans
Use this tool to get information about what items Veritas intends to replace with
newer and improved functionality. The tool also provides insight about what
items Veritas intends to discontinue without replacement. Some of these items
include certain NetBackup features, functionality, 3rd-party product integration,
Veritas product integration, applications, databases, and the OS platforms.

Help for the SORT tools is available. Click Help in the upper right corner of the
SORT home page. You have the option to:
■

Page through the contents of the help similar to a book

■

Look for topics in the index

■

Search the help with the search option
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Recommended SORT procedures for new
installations
Veritas recommends new NetBackup users perform the three procedures that are
listed for an initial introduction to SORT. The tool has many other features and
functions, but these serve as a good introduction to SORT. In addition, the
procedures provide a helpful base of knowledge for other SORT functionality.
Table 1-1
Procedure

Details

Create a Veritas Account on the SORT
webpage

See “To create a Veritas Account on the
SORT page” on page 13.

Create generic installation reports

See “To create a generic installation checklist”
on page 14.

Create system-specific installation reports

See “To create a system-specific installation
report for Windows” on page 14.
See “To create a system-specific installation
report for UNIX or Linux” on page 15.

To create a Veritas Account on the SORT page

1

In your web browser, navigate to:
https://sort.veritas.com/netbackup

2

In the upper right corner, click Login, then click Register now.

3

Enter the requested login and contact information:
Email address

Enter and verify your email address

Password

Enter and verify your password

First name

Enter your first name

Last name

Enter your last name

Company name

Enter your company name

Country

Enter your country

Preferred language

Select your preferred language

CAPTCHA text

Enter the displayed CAPTCHA text. If necessary, refresh the
image.
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4

Click Submit.

5

When you receive your login information, you can log into SORT and begin
uploading your customized information.

To create a generic installation checklist

1

In your web browser, navigate to:
https://sort.veritas.com/netbackup

2

Find and select the Installation and Upgrade Checklist widget.

3

Specify the requested information
Product

Select the appropriate product from the drop-down menu.
For NetBackup select NetBackup Enterprise Server or
NetBackup Server.

Product version you
are installing or
upgraded to

Select the correct version of NetBackup. The most current
version is always shown at the top of the list.

Platform

Select the operating system that corresponds to the checklist
you want generated.

Processor

Select the correct processor type for your checklist.

Product version you
are upgrading from
(optional)

For new installations, do not make any selections. For
upgrades, you can select the currently installed version of
NetBackup.

4

Click Generate Checklist.

5

A checklist corresponding to your choices is created. You can modify your
selections from this screen, and click Generate Checklist to create a new
checklist.
You can save the resulting information as a PDF. Numerous options are
available for NetBackup and many of them are covered in the generated
checklist. Please spend time reviewing each section to determine if it applies
to your environment.

To create a system-specific installation report for Windows

1

Go to the SORT website:
https://sort.veritas.com/netbackup

2

In the Installation and Upgrade section, select Installation and Upgrade
custom reports by SORT data collectors.
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3

Select the Data Collectors tab

4

Select the radio button for Graphical user interface and download the correct
data collector for your platform.
The data collector is OS-specific. To collect information about Windows
computers, you need the Windows data collector. To collect information about
UNIX computers, you need the UNIX data collector.

5

Launch the data collector after it finishes downloading.

6

On the Welcome screen, select NetBackup from the product family section
and click Next.

7

On the System Selection screen, add all computers you want analyzed. Click
Browse to see a list of computers you can add to the analysis. Veritas
recommends starting the tool with an administrator or a root account.

8

When all systems are selected, review the System names section and click
Next.

9

In the Validation Options screen, under Validation options, select the version
to which you plan to upgrade.

10 Click Next to continue
11 The utility performs the requested checks and displays the results. You can
upload the report to My SORT, print the results, or save them. Veritas
recommends that you upload the results to the My SORT website for ease of
centralized analysis. Click Upload and enter your My SORT login information
to upload the data to My SORT.

12 When you are finished, click Finish to close the utility.
To create a system-specific installation report for UNIX or Linux

1

Go to the SORT website:
https://sort.veritas.com/netbackup

2

In the Installation and Upgrade section, select Installation and Upgrade
custom reports by SORT data collectors.

3

Select the Data Collector tab.

4

Download the appropriate data collector for your platform.
The data collector is OS-specific. To collect information about Windows
computers, you need the Windows data collector. To collect information about
UNIX computers, you need the UNIX data collector.

5

Change to directory that contains downloaded utility.
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6

Run ./sortdc
The utility performs checks to confirm the latest version of the utility is installed.
In addition, the utility checks to see it has the latest data. The utility then lists
the location of the log file for this session.

7

If requested, press Enter to continue.

8

Select the NetBackup Family at the Main Menu.

9

Select Installation/Upgrade report when prompted What task do you want
to accomplish?
You can select multiple options by separating your response with commas.

10 Specify the system or systems you want included in the report.
If you previously ran a report on the specified system, you may be prompted
to run the report again. Select Yes to re-run the report.
The utility again lists the location of the log files for the session.
The progress of the utility is displayed to the screen.

11 Specify NetBackup when prompted for the product you want installation or
upgrade reports.

12 Enter the number that corresponds to the version of NetBackup you want to
install.
The utility again lists the location of the log files for the session.
The progress of the utility is displayed to the screen.

13 The utility prompts you to upload the report to the SORT website if you want
to review the report online. The online report provides more detailed information
than the text-based on-system report.

14 When your tasks are finished, you can exit the utility. You have the option to
provide feedback on the tool, which Veritas uses to make improvements to the
tool.

Recommended SORT procedures for upgrades
Veritas recommends current NetBackup users perform the three procedures that
are listed for an initial introduction to SORT. The tool has many other features and
functions, but these serve as a good introduction to SORT for users who already
use NetBackup. In addition, the procedures provide a helpful base of knowledge
for other SORT functionality.
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Table 1-2
Procedure

Details

Create a Veritas Account on the SORT
webpage

See “To create a Veritas Account on the
SORT page” on page 13.

Create a system-specific upgrade report

See “To create a system-specific installation
report for Windows” on page 14.
See “To create a system-specific installation
report for UNIX or Linux” on page 15.

Review the future platform and feature plans. See “To review future platform changes and
feature plans” on page 17.
Review the hot fix and emergency
engineering binary release auditor
See “To review hot fix and emergency
information.
engineering binary information” on page 17.

To review future platform changes and feature plans

1

In your web browser, navigate to:
https://sort.veritas.com/netbackup

2

Find and select the NetBackup Future Platform and Feature Plans widget.

3

Select Display Information.

4

Review the information provided

5

Optional - sign in to create notification - Click Sign in and create notification.

To review hot fix and emergency engineering binary information

1

In your web browser, navigate to:
https://sort.veritas.com/netbackup

2

Find and select the NetBackup Hot Fix and EEB Release Auditor widget.

3

Enter the hot fix or emergency engineering binary (EEB) information.

4

Click Search.

5

The new page shows a table with the following columns:
Hot fix of EEB
Identifier

Shows the hot fix or EEB number that was entered on the
previous screen.

Description

Displays a description of the problem that is associated with
the hot fix or EEB.

Resolved in Versions

Provides the version of NetBackup where this issue is
resolved.
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About NetBackup software availability
NetBackup 8.1 is available in the following formats:
■

DVD media kit
All necessary software and documentation files are provided on several DVDs.
See “About the NetBackup media kit” on page 18.

■

Electronic Software Distribution (ESD) images
The DVD image files are posted and available for download on the MyVeritas
website.
See “About the NetBackup Electronic Software Distribution (ESD) images”
on page 19.

About the NetBackup media kit
The media kit includes a DVD for each supported UNIX platform or operating system
and one DVD for Windows. The label on each DVD provides a brief description of
its contents. Printed materials in the kit include a copy of the NetBackup Getting
Started Guide.
Table 1-3 describes the contents of each DVD.
Table 1-3

NetBackup 8.1 DVD contents

Platform OS

Contents

AIX 64-bit

Server and supported options

HP-UX IA64

Server and supported options

Linux RedHat x86_64

Server and supported options

Linux SUSE x86_64

Server and supported options

Solaris SPARC64

Server and supported options

Solaris x86-64

Server and supported options

Windows

■

Server and supported options

■

All x64 clients

Linux zSeries RedHat x64

Media server and supported options

Linux zSeries SUSE x64

Media server and supported options
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Table 1-3

NetBackup 8.1 DVD contents (continued)

Platform OS

Contents

UNIX clients 1

■

AIX

■

HP PA-RISC and IA64

■

Solaris SPARC and X86

UNIX clients 2

All Linux platforms

Clients in LiveUpdate format 1

■

AIX

■

HP IA64

■

All Linux platforms

■

Solaris SPARC and X86

■

HP PA-RISC

■

All Windows platforms

Clients in LiveUpdate format 2

OpsCenter for Windows

All Windows platforms

OpsCenter for UNIX/Linux

All UNIX/Linux platforms

OpenVMS (CD format)

NetBackup Client for OpenVMS

Note: The NetBackup vCenter plug-in for ESX is available electronically from the
MyVeritas download site. It is free to customers under maintenance contract. An
e-mail with access information to the MyVeritas download site was sent when
NetBackup 7.6.1 became generally available. More information is available.
See “About the NetBackup Electronic Software Distribution (ESD) images”
on page 19.

About the NetBackup Electronic Software Distribution (ESD) images
The ESD images for NetBackup 8.1 are available for download from the MyVeritas
webpage. The images adhere to a 1.8G size limitation.
To ensure the accuracy of the ESD download, some of the product images have
been split into smaller, more manageable files. Before you uncompress any file,
you must first join the split image files that you can identify as 1 of 2 and 2 of 2.
A Download Readme.txt file on MyVeritas describes how to join the files together.
See “About NetBackup software availability” on page 18.
See “About the NetBackup media kit” on page 18.
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About storage device configuration
Reliable use of NetBackup depends on the proper configuration of your storage
devices. To ensure reliable backups and restores, you must first install and configure
devices to work with the operating system.
Before you install NetBackup, use the following guidelines to configure storage
devices to work with the operating system:
New installations

Before you install NetBackup, Veritas recommends that you
install and configure your devices with the latest version of
drivers.

Connections and settings

To prepare and connect new devices, perform the following
tasks:
■

■

Configuration

NetBackup installation

Set the SCSI ID (target). Make sure that it is set it to an
available SCSI ID.
Physically attach your device to a compatible host bus
adapter where that SCSI ID is available.
Compatible means that both the device and the host bus
adapter are of the same type. For example, single-ended,
high-voltage differential, low voltage differential, or Fibre
Channel.

To configure storage devices to work with the operating
system, refer to the following documentation:
■

The instructions from the device and the operating system
vendors.

■

The NetBackup Device Configuration Guide. See the
chapter that is appropriate for your operating system.
http://www.veritas.com/docs/DOC5332

After all storage devices are installed, configured, and verified
to work with the operating system, you can install NetBackup.

Warning: An improperly configured device can lead to backup failures, data loss,
or both.
See “Installation and upgrade requirements for UNIX and Linux” on page 31.
See “Installation and upgrade requirements for Windows and Windows clusters”
on page 53.
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Locating supported robot types
You can find a list of the supported robot types in the NetBackup Hardware and
Cloud Storage Compatibility List (HCCL).
For your convenience, Veritas periodically updates this document on the Veritas
support website
To find the latest robot types that this release supports
◆

Click on the following link to access the NetBackup Hardware and Cloud
Storage Compatibility List (HCCL):
http://www.netbackup.com/compatibility

How to install NetBackup
For new NetBackup installations, install the software in the following order:
Step 1

Install master server software.

Step 2

Install media server software (NetBackup Enterprise only).

Step 3

Install the NetBackup Remote Administration Console (optional).

Step 4

Install client software.

Step 5

Install any NetBackup add-on products (such as language packages).

Before you proceed with any installation procedure, be sure to review the installation
requirements.
See “Installation and upgrade requirements for UNIX and Linux” on page 31.
See “Installation and upgrade requirements for Windows and Windows clusters”
on page 53.

About the NetBackup preinstall checker
The server installer for both the UNIX/Linux and the Windows platforms includes a
preinstall checker. This feature helps to determine if your server is ready for a
successful installation or upgrade.
The check runs automatically when you start an installation on a master or a media
server. The results of the check are shown at the following point:
■

UNIX/Linux upgrade script
After you answer the question “Is this host the master server”.

■

Windows installation wizard
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On the Ready to Install the Program screen, where the Installation Summary
appears.
One of the tests that is performed is a comparison of the locally installed Emergency
Engineering Binary (EEB) updates with the fixes included with the version of
NetBackup being installed. If any of the preinstall tests fail, a message appears to
indicate what type of action is required.
Some test failures are considered minor and let you continue with the installation
or the upgrade. Critical test failures prevent the installation or the upgrade from
happening. The output informs you that other action must be taken before you can
proceed safely with the installation or the upgrade.
The preinstall check results are stored in the following locations:
■

UNIX
In the installation trace file in the following path:
/usr/openv/tmp

■

Windows
In the following directory:
%ALLUSERSPROFILE%\Symantec\NetBackup\InstallSummary\

See “About Veritas Services and Operations Readiness Tools” on page 12.

About the NetBackup Product Improvement Program
The NetBackup Product Improvement Program captures installation deployment
and product usage information.
During the NetBackup installation, you are enrolled in the NetBackup Product
Improvement Program and send this information automatically and securely to
Veritas. The information that Veritas receives becomes part of a continuous quality
improvement program that helps understand how customers configure, deploy, and
use the NetBackup product. This information is then used to help Veritas identify
improvements in product features, testing, technical support, and future
requirements.
To learn more about the NetBackup Product Improvement Program, refer to the
NetBackup license agreement section 17.18 Data Collection; Data Protection
Regulations. The following describes where to find the license agreement:
■

UNIX
In the base directory of the UNIX images on the DVD media or from the
downloaded media images from MyVeritas, see the file LICENSE.

■

Windows
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From the DVD media or the downloaded media images from MyVeritas, start
the installation wizard (Browser.exe). On the Home page, click Installation.
On the Installation page, select either Server Software Installation or Client
Software Installation. On the Welcome page, click Next to advance to the
License Agreement page.
You still have the ability to opt-out of the program. On your master server or media
server, change the TELEMETRY_UPLOAD option from the default YES to NO. More
information on this is available.
http://www.veritas.com/docs/000112586

About security certificates for NetBackup hosts
NetBackup uses security certificates for authentication of NetBackup hosts. The
NetBackup security certificates conform to the X.509 Public Key Infrastructure (PKI)
standard. A master server acts as the Certificate Authority (CA) and issues security
certificates to hosts.
NetBackup provides two types of NetBackup host security certificates: Host ID-based
certificates and host name-based certificates. Host ID-based certificates are based
on Universally Unique Identifiers (UUID) that are assigned to each NetBackup host.
The NetBackup master server assigns these identifiers to the hosts.
Any security certificates that were generated before NetBackup 8.0 are now referred
to as host name-based certificates. NetBackup is in the process of replacing these
older certificates with newer host ID-based certificates. The transition will be
completed in future releases and the use of host name-based certificates will be
eliminated. However, the transition is ongoing and NetBackup 8.1 continues to
require the older host name-based certificates for certain operations.

SCCM and Chef deployment tools and
documentation now available
With the NetBackup 8.1 release, Veritas now supports the use of System Center
Configuration Manager (SCCM) and Chef for NetBackup deployment. Veritas has
tested and validated several different deployment paths. Documentation and
templates for both SCCM and Chef are available. See SORT for additional details
around the support and use of SCCM and Chef.
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Support is discontinued for push installation of
a master server
Starting with this NetBackup release, support for push or silent installation of a
master server is discontinued.
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NetBackup licenses
This chapter includes the following topics:
■

About NetBackup license requirements

■

About license key entry

■

Frequently asked questions about license keys

About NetBackup license requirements
To install NetBackup master server or media server software, you must enter a
NetBackup product license.
To obtain licenses, you must order a license SKU when you order your NetBackup
products.
After you place your order, Veritas sends you an email with a license certificate that
includes the following information:
List of NetBackup licenses
purchased

This list includes all of the licenses for the products that you
ordered.
Keep this list in a secure location. You may be asked for a
product license if you ever need to contact technical support
for assistance.

Serial number for access to
download NetBackup
products

Instead of a DVD media kit, you can use this serial number
to download the Electronic Software Distribution (ESD)
images for NetBackup product installation.
Go to the following website and enter this serial number to
download the ESD images to your system:
http://my.veritas.com

NetBackup licenses
About license key entry

When you install NetBackup, Veritas recommends that you enter all other product
licenses on the master server when you are prompted. Although you can add these
licenses later, it is easier to enter them when you install the master server software.
For detailed information on how to administer NetBackup licenses, refer to the
NetBackup Administrator’s Guide, Volume I.
http://www.veritas.com/docs/DOC5332

About license key entry
Licenses for all NetBackup SKUs must be entered on the master server. Licenses
for some SKUs must also be entered on the media server, depending on the
capabilities that you require for the media server.
Table 2-1 describes the licenses that must be entered on each server.
Table 2-1

Required licenses for NetBackup media servers

Media server type

Required licenses (based on media server
capabilities)

Enterprise media servers

■

NetBackup Enterprise Server 8.1 UNX

■

NetBackup Enterprise Server 8.1 WIN/LNX/SOLX64

■

■

NetBackup Standard Infrastructure 8.1 XPLAT1 Front
End TBYTE
NetBackup Enterprise Infrastructure 8.1 XPLAT1 Front
End TBYTE
NetBackup Platform Base

■

NetBackup Option Library Based Tape Drive 8.1 XPLAT

■

NetBackup Option Shared Storage Option 8.1 XPLAT

■

NetBackup Option NDMP 8.1 XPLAT

■

NetBackup Media Server Encryption Option for Enterprise
Server, UNIX
NetBackup Media Server Encryption Option for Enterprise
Server, Windows/Linux

■

■

SAN media servers

■

NetBackup Enterprise Client, UNIX

■

NetBackup Enterprise Client, Windows/Linux

■

Media Server Encryption Option for SAN Media Server
(Enterprise Client), UNIX
Media Server Encryption Option for SAN Media Server
(Enterprise Client), Windows/Linux

■

Enter licenses by using one of the following methods:

26

NetBackup licenses
Frequently asked questions about license keys

■

During NetBackup master server and media server installation (recommended)
The installation script prompts you to enter the licenses for all NetBackup
products that you plan to install.

■

NetBackup Administration Console
After NetBackup master server or media server installation, open the console
and click Help > License Keys.

■

Command-line interface (UNIX only)
After NetBackup master server or media server installation, use the following
command:
/usr/openv/netbackup/bin/admincmd/get_license_key

Note: You can log on to a NetBackup server from almost any server in a system
to view, enter, and administer licenses. When you administer licenses remotely,
make sure that you view the licenses of the system you intend to change. You do
not want to add or change a license on the wrong server.

Frequently asked questions about license keys
Veritas customers have asked the following questions about how to manage license
keys.
Table 2-2
Question

Answer

Is the license system for
NetBackup the same as the
license system in other
Veritas products?

NetBackup uses a common license system that other Veritas
products also use. Please remember, however, that the
common license system provides flexibility in the license
features that each product implements. For example,
NetBackup does not have a node-locked license system, but
some other products do.

Can I use NetBackup if all I
have is a media kit?

No. The media kit by itself does not allow any access to
NetBackup. You always need a license key (either permanent
or evaluation). License keys should always be delivered with
the media kit, so you should never find yourself with a media
kit and no key.
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Table 2-2

(continued)

Question

Answer

What does the license key
look like? What information
does it contain?

The key is a serial number (for example:
xxxx-xxxx-xxxx-xxxx-xxxx-xxx). The key contains
information on the following:

■

Whether the key is for NetBackup Server or NetBackup
Enterprise Server
Whether the key is for a server, a client, an agent, or an
option (and which one)
Whether the key is a permanent key or an evaluation key

■

Information about how and where the key was generated

■

■

Is the license key serialized? Yes, serialization information is embedded in the key.
Can I see reports on what
license keys I have?

Yes. Information about license keys is stored on the master
server.
To access the information, open the NetBackup
Administration Console and select Help > License Keys.
On UNIX servers, you can also run the following command:
/usr/openv/netbackup/bin/admincmd/get_license_key
For more information on how to view reports, refer to the
NetBackup Administrator’s Guide, Volume I.
http://www.veritas.com/docs/DOC5332

How do I enable options and When you install NetBackup, you are prompted to enter the
agents?
license keys for all options and agents.
If you purchase an agent or other add-on product at a later
date, you can enter its license key manually. Open the
NetBackup Administration Console and select Help >
License Keys.
On UNIX servers, you can also run the following command:
/usr/openv/netbackup/bin/admincmd/get_license_key
Some options require that you have your original NetBackup
DVDs, because additional binaries must be installed. You
should always keep your NetBackup DVDs in a safe place.
Should I save license keys
Yes. Always store copies of your license keys in a secure
after they have been entered? place.
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Table 2-2

(continued)

Question

Answer

What should I do if I have lost Veritas has a record of all license keys that are issued to
my license key(s)?
customers. Customers who lose their license key(s) can call
Order Management to get copies of their license keys.
If you have purchased NetBackup from a Veritas partner,
you need to contact that partner for information on your key.
How are large volume orders Many NetBackup installations are very large, and the license
handled?
keys are long. License keys that you enter multiple times can
be time-consuming. You can request a single license key for
each type of NetBackup component you purchase. For
example, you can obtain one license key for use with 50
Oracle agents. Site licenses enable unrestricted use for
specific NetBackup agents or options.
You still need a unique license key for each type of
NetBackup component that you purchase. Separate license
keys are required for components like NetBackup Server, a
Lotus Notes agent, or any NDMP option.
What about license keys for Site licenses are handled much like large volume orders are.
customers with site licenses? The certificate for a site license states that the license key is
good for unlimited copies.
Do I need a license key to
enable NetBackup Remote
Administration Consoles?

No. NetBackup Remote Administration Consoles do not
require special license keys. You can install them on any
computer with access to the master server.

Can a license key be used
multiple times?

Yes. You can use your license keys multiple times. You are,
however, legally bound to install and use only the number of
NetBackup servers, clients, agents, and options for which
you purchase licenses.

How do existing customers
get license keys?

All NetBackup customers who have current maintenance
contracts with Veritas automatically receive the latest version
of NetBackup. You receive the NetBackup media kit and
license keys for every component for which you purchased
licenses.
If your maintenance is through a Veritas partner, you upgrade
through the partner. Contact the partner for more details.
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Table 2-2

(continued)

Question

Answer

What if I do not get the right
license keys?

If you believe that you received an incorrect license key,
contact Order Management using the number on your license
key certificate. Technical support does not issue permanent
license keys. You can obtain license keys only through Order
Management. Technical support can provide temporary
one-month license keys to you while issues regarding
permanent license keys are resolved.

What does an evaluation
license enable?

The evaluation license enables unrestricted use of
NetBackup, its agents, and its options for a predetermined
period of time.

Am I notified when an
To find out when a license key expires, open the NetBackup
evaluation is about to expire? Administration Console and select Help > License Keys.
On UNIX servers, you can also run the following command:
/usr/openv/netbackup/bin/admincmd/get_license_key
What happens when an
evaluation license expires?

The NetBackup services or daemons are shut down. When
you attempt to use the product you are informed that its
evaluation period has expired.

Does NetBackup save the
backup configuration and
catalog information when
evaluation license expire?

Yes. Customers who add a permanent license to an
evaluation version of NetBackup have immediate access to
their catalog information and configuration information.

How do I upgrade from an
evaluation license to a
permanent license?

It is easy. When you purchase a permanent license, you add
that license to NetBackup. All the configuration information
and catalog data from your evaluation version is retained.
To enter your permanent license key, open the NetBackup
Administration Console and select Help > License Keys.
On UNIX servers, you can also run the following command:
/usr/openv/netbackup/bin/admincmd/get_license_key
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Installing server software
on UNIX systems
This chapter includes the following topics:
■

Installation and upgrade requirements for UNIX and Linux

■

How the installation script works

■

About mounting the NetBackup software media

■

Installing NetBackup master server software on UNIX

■

Installing NetBackup media server software on UNIX

■

About pushing client software from a master server to clients

Installation and upgrade requirements for UNIX
and Linux
Table 3-1 describes the requirements to prepare your UNIX and Linux systems for
NetBackup installation. Use this table as a checklist to address each item.
For the most up-to-date information about installation requirements, Veritas
recommends use of the SORT website. More information about SORT is available.
See “About Veritas Services and Operations Readiness Tools” on page 12.
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Table 3-1

Check Requirement

NetBackup installation and upgrade requirements for UNIX and
Linux

Details

Operating
System

■

For a complete list of compatible UNIX and Linux operating systems, refer to the
Software Compatibility List (SCL) at the following website:
http://www.netbackup.com/compatibility
https://sort.veritas.com/netbackup

Memory

■

Master servers in a production environment with several database agents enabled
should have a minimum of 16 GB of memory and four cores each.
Media servers in a production environment with several database agents enabled
should have a minimum of 4 GB of memory each.
Any client in a production environment should have a minimum of 512 MB of memory.

■

■
■

For reasonable performance of the NetBackup interfaces, you need 512 MB of RAM.
Of that space, 256 MB must be available to the interface program (jnbSA or jbpSA).

For additional information about memory requirements, refer to the NetBackup Backup
Planning and Performance Tuning Guide.
http://www.veritas.com/docs/DOC5332
Disk space

■

■

The exact amount of space that is required depends on the hardware platform. More
information about this topic is available.
NetBackup Release Notes for 8.1
http://www.veritas.com/docs/DOC5332
NetBackup catalogs contain information about your backups that become larger as
you use the product. The disk space that the catalogs require depends primarily on
the following aspects of your backup configuration:
■ The number of files that are backed up.
■

The frequency of your backups.

■

The amount of time that you set to retain your backup data.

If space is an issue, you can install NetBackup on an alternate file system. The installation
lets you select an alternate install location, and creates the appropriate link from
/usr/openv.

Note: The value for disk space is for initial installation only. The NetBackup catalog
requires considerably more space once the master server is placed in a production
environment. For additional information on sizing requirements for the NetBackup catalog,
refer to the NetBackup Backup Planning and Performance Tuning Guide.
http://www.veritas.com/docs/DOC5332
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Table 3-1

Check Requirement
General
requirements

Details
■

■

■

■

■

Clustered
systems

NetBackup installation and upgrade requirements for UNIX and
Linux (continued)

■

■

■

■

Ensure that the gzip and the gunzip commands are installed on the local system.
The directories where these commands are installed must be part of the root user’s
path environment variable setting.
All NetBackup installation DVDs or ESD images, appropriate licenses, and the root
password for all servers.
A server of a supported hardware type that runs a supported version of its operating
system (with applicable patches), adequate disk space, and supported peripherals.
For details on these requirements, refer to the NetBackup Release Notes.
http://www.veritas.com/docs/DOC5332
All NetBackup servers must recognize and be recognizable by their client systems.
In some environments, this means that each must be defined in the other’s
/etc/hosts file. Other environments may use the Network Information Service (NIS)
or Domain Name Service (DNS).
The minimum screen resolution configuration is 1024x768, 256 colors.
Ensure that each node in the NetBackup cluster can run the ssh command or its
equivalent. The root user must be able to perform a remote logon to each node in
the cluster without entering a password. This remote logon is necessary for installation
and configuration of the NetBackup server and any NetBackup agents and options.
After installation and configuration are complete, it is no longer required.
You must install, configure, and start the cluster framework before you install
NetBackup.
You must have defined a virtual name using DNS, NIS, or the /etc/hosts file. The
IP address is defined at the same time. (The virtual name is a label for the IP address.)
Begin the upgrade from the active node, and then upgrade the inactive nodes.

More information about cluster requirements is available.
Veritas NetBackup Clustered Master Server Administrator’s Guide
http://www.veritas.com/docs/DOC5332
NFS
compatibility

Veritas does not support installation of NetBackup in an NFS-mounted directory. File
locking in NFS-mounted file systems can be unreliable.

Kernel
reconfiguration

For some peripherals and platforms, kernel reconfiguration is required.
For more details, see the NetBackup Device Configuration Guide.
http://www.veritas.com/docs/DOC5332

Red Hat Linux

For Red Hat Linux, NetBackup requires server networking.
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Table 3-1

Check Requirement

NetBackup installation and upgrade requirements for UNIX and
Linux (continued)

Details

Other backup
software

Veritas recommends that you remove any other vendor backup software currently
configured on your system before you install this product. Other vendor backup software
can negatively affect how NetBackup installs and functions.

Web Services

Beginning with NetBackup 8.0, the NetBackup master server includes a configured
Tomcat web server to support critical backup operations. This web server operates under
user account elements with limited privileges. These user account elements must be
available on each master server (or each node of a clustered master server). You must
create these required account elements before installation. More information is available:
See “NetBackup master server web server user and group creation” on page 164.

Note: Veritas recommends that you save the details of the user account that you use
for the NetBackup Web Services. A master server recovery requires the same NetBackup
Web Services user account and credentials that were used when the NetBackup catalog
was backed up.

Note: If the NetBackup PBX is running in secure mode, please add the web service
user as authorized user in PBX. More information about determining PBX mode and how
to correctly add users is available.
http://www.veritas.com/docs/000115774
By default, the UNIX installation script attempts to associate the web server with user
account nbwebsvc and group account nbwebgrp. You can override these default values
with the NetBackup installation answer file. You must populate the NetBackup installation
answer file on the target host before you start the UNIX installation script. Populate the
NetBackup installation answer file with custom web server account names as shown.

1

Log in to the server as root.

2

Open the file /tmp/NBInstallAnswer.conf with your preferred text editor. Create the
file if it does not exist.

3

Override the default web server user account name by adding the line shown:
WEBSVC_USER=custom_user_account_name

4

Override the default web server group account name by adding the line shown:
WEBSVC_GROUP=custom_group_account_name

5

Save and close the file.
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Do not mix non-English versions of Windows and UNIX platforms
unless master and media servers are NetBackup appliances
Do not mix non-English versions of Windows and UNIX platforms unless your master
servers and media servers are NetBackup appliances. If you mix non-English
versions of Windows and UNIX platforms, differences in operating system
architecture and encodings may cause non-ASCII file names and folder names to
display incorrectly within the user interface. This issue may cause functional failures.

NetBackup installations on environments that run different versions
of UNIX-based operating systems
NetBackup can be installed in environments that run different versions of
UNIX-based operating systems as long as the system locales are identical. The
use of different locales across UNIX platforms may cause non-ASCII file names
and folder names to display incorrectly within the user interface. This issue may
cause functional failures.

Special installation guidelines for Solaris systems
Several kernel-tunable parameters, such as Message Queue, Semaphore, and
Shared Memory Parameters, can affect NetBackup performance. If you adjust these
values, you may prevent your system performance from slowing down or even
reaching a deadlock state.
More information about tunable parameters is available online.
■

Recommended NetBackup *NIX semaphore tuning values
(Linux/Solaris/HP-UX/AIX)
http://www.veritas.com/docs/000081309

■

Tuning Solaris 10 for NetBackup
http://www.veritas.com/docs/000035120

■

Tuning Solaris 10 shared memory for NetBackup Media Server processes (bptm
/ bpdm)
http://www.veritas.com/docs/000034846
While this link refers to NetBackup 6.x, the information remains valid for
NetBackup 7.x and NetBackup 8.x.

For more information about parameter definitions and examples, see the NetBackup
Backup Planning and Performance Tuning Guide on the support website.
http://www.veritas.com/docs/DOC5332

35

Installing server software on UNIX systems
Installation and upgrade requirements for UNIX and Linux

Special installation guidelines for HP-UX systems
Use the following guidelines when you install NetBackup on HP-UX systems:
■

Install NetBackup on a file system that supports long file names.

■

During NetBackup installation, the following error may occur when the NetBackup
database is created:
SQL error (-832) -- Connection error: Insufficient system
resources - failed to allocate a SYSV semaphore

To correct the error, increase the number of semaphores in the HP-UX kernel.
For details on how to change HP-UX parameters, see the NetBackup Backup
Planning and Performance Tuning Guide, Chapter 11: OS-Related Tuning
Factors.
http://www.veritas.com/docs/DOC5332

Special guidelines for AIX master servers
Because of known memory problems, Veritas recommends you reset memory
values for AIX master servers. Veritas recommends that you run the commands
shown:
■

ulimit -s unlimited

■

ulimit -d unlimited

■

ulimit -m unlimited

These changes set the physical memory size, the data area size, and the stack
size to unlimited. These changes resolve known memory problems for AIX. Be sure
to stop and restart the NetBackup daemons after you change the ulimit value.

Special installation guidelines for UNIX clustered environments
Use the following guidelines when you install NetBackup in clustered systems:
■

Ensure that each node in the NetBackup cluster can run the ssh command. The
root user must be able to perform a remote login to each node in the cluster
without entering a password. This remote login is necessary for installation and
configuration of the NetBackup server and any NetBackup options. After
installation and configuration are completed, it is no longer required.

■

You must install, configure, and start the cluster framework before you install
NetBackup. For additional installation prerequisites and installation notes, see
the NetBackup Clustered Master Server Administrator’s Guide.
http://www.veritas.com/docs/DOC5332
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■

You must have defined a virtual name using DNS, NIS, or /etc/hosts. The IP
address is defined at the same time. (The virtual name is a label for the IP
address.) Use this virtual name and IP address only for the NetBackup resource.

How the installation script works
When you install NetBackup server software, client software is also installed.
When you install NetBackup 8.1, the following options are also installed if the
platform supports them:
■

BMR Master Server

■

NDMP

■

Veritas Product Authentication and Authorization (NetBackup Access Control)

■

Vault

■

BMR Boot Server

■

DB2

■

Encryption

■

Informix

■

LiveUpdate agent

■

Lotus Notes

■

Oracle

■

SAP

■

Snapshot Client

■

Sybase

After installation is complete, a valid license key for each option must be entered
to enable its functionality. Each option must also be configured as needed.
In addition to server software and options, the installation script performs the
following tasks:
Host names

Places the host name in the
/usr/openv/netbackup/bp.conf file on the server.
For clustered environments, the script places the virtual host
name in the /usr/openv/netbackup/bp.conf file on the
server.
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Automatic startup and
shutdown scripts

Adds the automatic startup and shutdown scripts to the
appropriate directories on the various supported platforms.

PBX

If the computer where you install NetBackup does not already
have PBX and the platform supports it, the installation script
installs PBX.
If PBX already exists on the computer, the installation script
performs one of the following tasks:
■

■

Updates the existing version if it is older than the version
that is included with 8.1.
Does not update PBX if the existing version is the same
or later than the version that is included with 8.1.

About mounting the NetBackup software media
Use the examples in the following table as guidelines when you mount NetBackup
DVDs. Check with your hardware vendor to see if you may need to use other flags
or options.
Table 3-2

Flags and options for mounting NetBackup DVDs

Flags or options

Defined

-v, -t, -F

Specifies the type of file system to mount.

-o

Translates the file names properly if required.

-r

Specifies that you want to mount the DVD for reading.

device_path

Specifies the name of the DVD drive.

mount_point

Specifies the directory where you want to mount the DVD.

See “Mounting NetBackup software media on UNIX or Linux systems” on page 38.

Mounting NetBackup software media on UNIX or Linux systems
The following procedure describes how to mount the NetBackup DVD on UNIX or
Linux systems.
To mount the NetBackup DVD on UNIX or Linux systems

1

Log in as root.

2

Create a mount point (all except Solaris).
mkdir /dvd
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3

(Conditional) on HP-UX systems earlier than 11.23, start PFS daemons.
nohup pfs_mountd &
nohup pfsd &

4

Issue the appropriate mount command for your operating system.
AIX

mount -v cdrfs -r device_path
mount_point

AIX

smitty cdrfs
or
smitty mountfs

HP-UX earlier than 11.23

pfs_mount -o xlat=unix device_path
mount_point
To find the device path, you can run ioscan
-fn.

HP-UX later than 11.23

mount -F cdfs device_path
mount_point

Linux

mount device_path mount_point

Solaris

If Volume Manager (vold) is running, the
DVD mounts automatically.
If vold is not running, start it as follows:
/usr/sbin/vold &

Installing NetBackup master server software on
UNIX
The master server manages backups, archives, and restores. The master server
is where the NetBackup catalog resides which includes the internal databases that
contain information about NetBackup configuration and backups.
Use the following guidelines for a new master server installation:
Designate master server

Designate the computer that you want to be the master server
and install the master server software on that computer first.
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EMM server

You must configure EMM on the master server. All master
servers must have their own EMM configuration. Remote
EMM or shared EMM is no longer supported.

Licenses

During master server installation, you must enter a NetBackup
base product license. You must also enter licenses for any
additional NetBackup product options or agents that are used
on the server or its clients. These additional licenses must
be entered on the master server.
If you add or make and save any license updates in the
NetBackup-Java Administration Console, you must restart
the console.
For more information on how to administer NetBackup
licenses, see the NetBackup Administrator’s Guide, Volume
I.
http://www.veritas.com/docs/DOC5332

To install NetBackup master server software

1

Log in to the server as root.

2

Use one of the following methods to start the installation script:
DVD

■

■

■

Insert the NetBackup Server DVD for the appropriate
platform into the drive.
Check the DVD label to identify its contents.
See “About the NetBackup media kit” on page 18.
If necessary, mount the DVD.
See “About mounting the NetBackup software media”
on page 38.
Enter the following command:
dvd_directory/install
The dvd_directory is the path to the directory where
you can access the DVD.

ESD images (downloaded
files)

■

■

Navigate to the location where the installation images
reside.
Enter the following command:
./install
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When the following message appears press Enter to continue:
Veritas Installation Script
Copyright 1993 - 2016 Veritas Corporation, All Rights Reserved.

Installing NetBackup Server Software

Please review the VERITAS SOFTWARE LICENSE AGREEMENT located on
the installation media before proceeding. The agreement includes
details on the NetBackup Product Improvement Program.
For NetBackup installation and upgrade information specific to your
platform and to find out if your installed EEBs or hot fixes are
contained in this release, check out the Veritas Services and
Operations Readiness Tools (SORT) Installation and Upgrade Checklist
and Hot fix and EEB Release Auditor, respectively, at
https://sort.veritas.com/netbackup.
ATTENTION! To help ensure a successful upgrade to NetBackup 8.1,
please visit the NetBackup 8.x Upgrade Portal:
http://www.veritas.com/docs/000115678.
Do you wish to continue? [y,n] (y)

4

When the following message appears press Enter to continue:
Is this host a master server? [y/n] (y)

5

If you need to perform a disaster recovery of your master server, select Y when
prompted. Press Enter for the default N.
Do you want to do a disaster recovery on this master server? [y/n]
(n)

The disaster recovery process requires additional steps and information that
is not covered in this manual. More information is available.
Veritas NetBackup Troubleshooting Guide

6

For the NetBackup installation location, enter the appropriate platform
information as follows:
■

When the following question appears, press Enter to accept the default
(y).
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The NetBackup and Media Manager software is built
for use on <platform> hardware. Do you want to install
NetBackup and Media Manager files? [y,n] (y)
■

When the following question appears, select where to install NetBackup
and Media Manager software:
NetBackup and Media Manager are normally
installed in /usr/openv.
Is it OK to install in /usr/openv? [y,n] (y)

The path displayed for Solaris is /opt/openv.
To accept the default (y), press Enter.
To change the installation location, type n and press Enter. Then enter the
appropriate destination.
Additional information about installation folder restrictions is available.
See “Restrictions on the NetBackup installation directory” on page 8.

7

Enter the Netbackup server or Enterprise server License.

8

Type y, then follow the prompts to add license keys for other NetBackup options
and agents.
Although you can add licenses later, you should enter them now. If you add
any licenses later through the NetBackup Administration Console, you must
restart the console.

9

After all licenses are entered, type q to quit the License Key Utility and complete
the server software installation.

10 Verify or enter the correct computer name when prompted by the following
message:
Installing NetBackup Enterprise Server version: 8.1
If this machine will be using a different network interface than
the default (name), the name of the preferred interface
should be used as the configured server name. If this machine
will be part of a cluster, the virtual name should be used as the
configured server name.
The domainname of your server appears to be "domain". You
may choose to use this domainname in your configured NetBackup
server name, or simply use "name" as the configured
NetBackup server name.
Would you like to use "name.domain" as the configured NetBackup server
name of this machine? [y, n] (y)
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Note: Incorrect information for the domain name results in failures during the
configuration of Authentication Broker and NetBackup Access Controls. To
correct this problem, use the bpnbaz -configureauth command to configure
Authentication Broker. More information about the bpnbaz -configureauth
command is available.
Veritas NetBackup Commands Reference Guide
http://www.veritas.com/docs/DOC5332
■

To accept the displayed (default) name, press Enter.

■

To change the displayed (default) name, type n and enter the name that
you want.

■

For a clustered NetBackup server, enter the virtual name for the NetBackup
server and not the actual local host name.

11 Identify or verify the master server by answering the following question when
it appears:
Is <name> the master server? [y, n] (y)
■

To accept the displayed name (which is the name that you identified in the
previous step), press Enter.

■

If you entered a virtual name for the server in the previous step, the
installation script presents the following question:
Is this server part of a cluster installation?

If the answer is yes, press y and answer the series of cluster configuration
questions that appear.
If the answer is no, press n.

12 Identify whether there are any media servers for this master server by answering
the following question when it appears:
Do you want to add any media servers now? [y, n] (n)
■

If there are no media servers for this master server, press Enter and
proceed to the next step.

■

If there are media servers for this master server, type y and enter the name
of each media server.
When you enter the media server names, you must enter the computer
name and the domain name. For example:
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alpha.domain.com

Where alpha is the computer name and domain.com is the domain name.
The media server names that you enter here are added to the bp.conf file
on the master server, automatically. After you install the media server
software later, the master server can then communicate with the media
servers immediately.
■

To add a media server to an existing and an operational NetBackup
environment, you cannot use the procedures in this guide. For complete
details on how to add a media server to an existing and an operational
NetBackup environment, see the NetBackup Administrator's Guide, Volume
II.
http://www.veritas.com/docs/DOC5332

13 When the following message appears, press Enter and accept the default
name of the EMM server. You must configure EMM on the master server. All
master servers must have their own EMM configuration. Remote EMM or
shared EMM is no longer supported.
NetBackup maintains a centralized catalog (separate from the
image catalog) for data related to media and device
configuration, device management, storage units, hosts and host
aliases, media server status, NDMP credentials, and other
information. This is managed by the Enterprise Media Manager
server.
Enter the name of the Enterprise Media Manager (default: <name>)

14 Answer the following question when it appears:
Do you want to start the NetBackup job-related processes so backups and
restores can be initiated? [y, n] (y)
■

If you have (or want to have) a clustered NetBackup server, type n.

■

For non-clustered installations, press Enter to accept the default answer
(y) and start the NetBackup processes and the EMM server.
You must start these processes now because the EMM server must be
running when you install any media servers later.

15 For a clustered NetBackup master server, repeat these steps on every node
on which you want to run NetBackup.
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16 (Conditional) On a clustered NetBackup master server, you must obtain the
Certificate Authority certificate and the host certificate for each inactive node.
More information is available:
See “Generate a certificate on the inactive nodes of a clustered master server”
on page 161.

17 (Conditional) If you use cloud storage in your NetBackup environment, you
must update your cloud configuration file. More information is available.
See “Update cloud configuration file on the master server immediately after
install or upgrade to NetBackup 8.1” on page 139.

18 After your initial installation is complete, you can install any other NetBackup
add-on products (such as language packages).

Continuing with NetBackup software installation
After you have installed the master server software, you are ready to install media
server software or client software depending on your environment.
■

If you have media servers in your system, you are ready to install media server
software.
See “Installing NetBackup media server software on UNIX” on page 45.

■

If there are no media servers in your environment, you are ready to install client
software on client computers.
■

See “Installing UNIX clients locally” on page 102.

■

To install client software on clients from the master server location
(recommended), you must first install the client type software on the master
server.
See “Installing client type software on a master server” on page 51.

Installing NetBackup media server software on
UNIX
This section describes how to install a new NetBackup media server. Use this
information to install the server software on a computer with no existing version of
NetBackup.
Media server software manages the robotic and the storage devices within your
NetBackup environment.
After you have installed the master server and the EMM server software, you are
ready to install media server software on media server computers.
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Use the following guidelines when you install new media servers:
Designate media
servers

Designate the computers that you want to be media servers and
install the media server software on them.

Clusters

New or initial NetBackup media servers cannot be installed as
clusters.

EMM server

The EMM server must be installed and running before you install
media server software.

License keys

When you install NetBackup media server software, you must enter
a NetBackup product license. You must also enter a license for any
additional NetBackup product options or agents that are used on
the server or its clients. These additional licenses must be entered
on each media server.
For more information on how to administer NetBackup licenses,
see the NetBackup Administrator's Guide, Volume I.
http://www.veritas.com/docs/DOC5332

Note: If you make and save any license changes in the
NetBackup-Administration Console, you must restart the console.
IBMzSeries RedHat
These platforms are supported for use as media servers only.
and IBMzSeries SUSE
CA Certificate
fingerprint

You must know the CA Certificate fingerprint of the master server
at time of installation. More information is available about the details
on the CA Certificate fingerprint and its role in generation of security
certificates.
https://www.veritas.com/support/en_US/article.000127129

Authorization Token

In some cases, the installer requires an authorization token to
successfully deploy security certificates. More information is
available about the details on authorization tokens and their role in
generation of security certificates.
https://www.veritas.com/support/en_US/article.000127129

To install NetBackup media server software

1

Log in to the server as root.

2

Use one of the following methods to start the installation script:
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DVD

■

■

■

47

Insert the NetBackup Server DVD for the appropriate
platform into the drive.
Check the DVD label to identify its contents.
See “About the NetBackup media kit” on page 18.
If necessary, mount the DVD.
See “About mounting the NetBackup software media”
on page 38.
Enter the following command:
dvd_directory/install
The dvd_directory is the path to the directory where
you can access the DVD.

ESD images (downloaded
files)

■

■

Navigate to the location where the installation images
reside.
Enter the following command:
./install

3

When the following message appears, press Enter to continue:
Veritas Installation Script
Copyright 1993 - 2016 Veritas Corporation, All Rights Reserved.

Installing NetBackup Server Software

Please review the VERITAS SOFTWARE LICENSE AGREEMENT located on
the installation media before proceeding. The agreement includes
details on the NetBackup Product Improvement Program.
For NetBackup installation and upgrade information specific to your
platform and to find out if your installed EEBs or hot fixes are
contained in this release, check out the Veritas Services and
Operations Readiness Tools (SORT) Installation and Upgrade Checklist
and Hot fix and EEB Release Auditor, respectively, at
https://sort.veritas.com/netbackup.
ATTENTION! To help ensure a successful upgrade to NetBackup 8.1,
please visit the NetBackup 8.x Upgrade Portal:
http://www.veritas.com/docs/000115678.
Do you wish to continue? [y,n] (y)
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Indicate if the current computer is the master server by answering the following
question when it appears:
Is this host the master server? [y,n]

5

Verify or enter the correct computer name when prompted by the following
message:
Installing NetBackup Enterprise Server version: 8.1
If this machine will be using a different network interface than
the default (name), the name of the preferred interface
should be used as the configured server name. If this machine
will be part of a cluster, the virtual name should be used as the
configured server name.
The domainname of your server appears to be "domain". You
may choose to use this domainname in your configured NetBackup
server name, or simply use "name" as the configured
NetBackup server name.
Would you like to use "name" as the configured NetBackup server
name of this machine? [y, n] (y)

Note: Incorrect information for the domain name results in failures during the
configuration of Authentication Broker and NetBackup Access Controls. To
correct this problem, use the bpnbaz -configureauth command to configure
Authentication Broker. More information about the bpnbaz -configureauth
command is available.
Veritas NetBackup Commands Reference Guide
http://www.veritas.com/docs/DOC5332

6

■

If the displayed (default) media server name is correct, press Enter.

■

If the displayed (default) media server name is not correct, type n and enter
the correct name.

Identify the name of the master server when prompted with this question:
What is the fully qualified name of the master server?

If the master server is clustered, enter the virtual name of the master server.

7

For the NetBackup installation location, enter the appropriate platform
information as follows:
■

When the following question appears, press Enter to accept the default
(y).
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The NetBackup and Media Manager software is built
for use on <platform> hardware. Do you want to install
NetBackup and Media Manager files? [y,n] (y)
■

When the following question appears, select where to install NetBackup
and Media Manager software:
NetBackup and Media Manager are normally
installed in /usr/openv.
Is it OK to install in /usr/openv? [y,n] (y)

The path displayed for Solaris is /opt/openv.
To accept the default (y), press Enter.
To change the installation location, type n and press Enter. Then enter the
appropriate destination.
Additional information about installation folder restrictions is available.
See “Restrictions on the NetBackup installation directory” on page 8.

8

After you confirm the installation location for the binaries, the installer fetches
the certificate authority certificate details.
Getting CA certificate details.
Depending on the network, this action may take a few minutes. To
continue without setting up secure communication, press Ctrl+C.

Be aware if you press Ctrl+C, this action requires you to rerun the installation
or continue with the installation without the required security components. If
these security components are absent, backups and restores fail.

9

When prompted, review the fingerprint information and confirm that it is
accurate.
Master server [master_name] reports CA Certificate fingerprint
[fingerprint]. Is this correct? [y/n] (y)

After you confirm the fingerprint information, the installer stores the certificate
authority certificate details.
Storing CA certificate.
Depending on the network, this action may take a few minutes. To
continue without setting up secure communication, press Ctrl+C.

Be aware if you press Ctrl+C, this action requires you to rerun the installation
or continue with the installation without the required security components. If
these security components are absent, backups and restores fail.
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10 After the Certificate Authority certificate is stored, the installer fetches the host
certificate.
Getting host certificate.
Depending on the network, this action may take a few minutes. To
continue without setting up secure communication, press Ctrl+C.

Be aware if you press Ctrl+C, this action requires you to rerun the installation
or continue with the installation without the required security components. If
these security components are absent, backups and restores fail.

11 (Conditional) If prompted for the Authorization Token, please enter it.
An authorization token is required in order to get the host
certificate for this host. At the prompt, enter the authorization
token or q to skip the question. NOTE: The answer entered will
not be displayed to the terminal.
Enter the authorization token for master_server_FQDN or q to skip:

12 Enter the NetBackup Server or NetBackup Enterprise Server license key.
13 Type y, then follow the prompts to add license keys for other NetBackup options
and agents.
Although you can add license keys later, you should enter them now. If you
add any license keys later through the NetBackup-Java Administration Console,
you must restart the console.

14 After all license keys are entered, type q to quit the License Key Utility and
complete the server software installation.

15 When the following message appears, press Enter and accept the default
name of the EMM server. You must configure EMM on the master server. All
master servers must have their own EMM configuration. Remote EMM or
shared EMM is no longer supported.
Enter the name of the Enterprise Media Manager (default: <name>)

The master server name is displayed by default.

16 Repeat steps 1 through 15 to install media server software on any remaining
media servers.
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About pushing client software from a master
server to clients
You can increase the speed of client installation by pushing the software from the
master server to the clients. This method eliminates the need for a local installation
at each client.
The following describes how to prepare your NetBackup environment for client
software installation from the master server.
■

Install the client type software on the master server. Be sure to install all of the
client types that pertain to your NetBackup configuration.
See “Installing client type software on a master server” on page 51.

■

Before you can push client software from the master server, each client name
must be assigned to a NetBackup policy. Policies are created on the master
server.
When you create a policy, you must identify the policy type, which indicates the
operating system on the clients that are assigned to that policy. Without a policy,
the remote installation (or push) fails because the master server does not know
the operating system of the client.
For information on how to create NetBackup policies, refer to the NetBackup
Administrator's Guide, Volume I.
http://www.veritas.com/docs/DOC5332

■

After the required policies are created, you can push client software from the
master server to the clients.
See “About remote installation methods for UNIX/Linux clients” on page 116.

Installing client type software on a master server
Client type software must be installed on the master server to perform the following
operations:
■

Assign clients to NetBackup policies so that those clients can be backed up.

■

Install (or push) client software from the master server to clients.
For each UNIX client type, the client installation script lets you install the client
software onto the master server. You can then install (or push) the client software
from the master server to the clients.

To install client type software on a master server

1

Log in to the server as root.

2

Use one of the following methods to start the installation script:
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DVD

■

■

■
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Insert the NetBackup UNIX Clients DVD into the
drive.
See “About the NetBackup media kit” on page 18.
If necessary, mount the DVD.
See “About mounting the NetBackup software media”
on page 38.
Enter the following command:
dvd_directory/install
The dvd_directory is the path to the directory where
you can access the DVD.

ESD images (downloaded
files)

■

■

Navigate to the location where the installation images
reside.
Enter the following command:
./install

3

When the following message appears, press Enter to continue:
Veritas Installation Script
Copyright 1993 - 2016 Veritas Corporation, All Rights Reserved.

Installing NetBackup Client Software

Please review the VERITAS SOFTWARE LICENSE AGREEMENT located on
the installation media before proceeding. The agreement includes
details on the NetBackup Product Improvement Program.
For NetBackup installation and upgrade information specific to your
platform and to find out if your installed EEBs or hot fixes are
contained in this release, check out the Veritas Services and
Operations Readiness Tools (SORT) Installation and Upgrade Checklist
and Hot fix and EEB Release Auditor, respectively, at
https://sort.veritas.com/netbackup.
Do you wish to continue? [y,n] (y)

4

Select all of the client types that you want to install and follow the installation
prompts.

Chapter
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Installing server software
on Windows systems
This chapter includes the following topics:
■

Installation and upgrade requirements for Windows and Windows clusters

■

Requirements for Windows cluster installations and upgrades

■

Performing local, remote, or clustered server installation on Windows systems

■

Post-installation tasks for NetBackup cluster environments

■

Verifying Windows cluster installations or upgrades

■

Installing NetBackup servers silently on Windows systems

Installation and upgrade requirements for
Windows and Windows clusters
Table 4-1 describes the requirements to prepare your Windows systems for
NetBackup installation. Use this table as a checklist to address each item.
For the most up-to-date information about installation requirements, Veritas
recommends use of the SORT website. More information about SORT is available.
See “About Veritas Services and Operations Readiness Tools” on page 12.
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Caution: Veritas supports moving the NetBackup catalog to a non-default location
on a Windows cluster after installation or upgrade. Before any upgrades, however,
you must move the NetBackup catalog back to the default location for the upgrade
to succeed. Do not attempt a NetBackup upgrade if the catalog is not in the default
location. You master server is rendered unusable if you fail to move the database
back to the default location before upgrade. More information is available.
https://www.veritas.com/support/en_US/article.000118358
Table 4-1

Check Requirement
Operating
system

Memory

NetBackup installation and upgrade requirements for Windows
and Windows clusters

Details
■

Make sure that you have applied the most current operating system patches and
updates. If you are not certain that your operating system is current, contact your
operating system vendor and request the latest patches and upgrades.

■

For a complete list of compatible Windows operating systems, refer to the Software
Compatibility List (SCL) at the following website:
http://www.netbackup.com/compatibility

■

Master servers in a production environment with several database agents enabled
should have a minimum of 16 GB of memory and four cores each.
Media servers in a production environment with several database agents enabled
should have a minimum of 4 GB of memory each.

■

For additional information about memory requirements, refer to the NetBackup Backup
Planning and Performance Tuning Guide.
http://www.veritas.com/docs/DOC5332
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Table 4-1

Check Requirement
Disk space

NetBackup installation and upgrade requirements for Windows
and Windows clusters (continued)

Details
■

An NTFS partition.

■

The exact amount of space that is required to accommodate the server software and
the NetBackup catalogs depends on the hardware platform. More information about
this topic is available.

■

■

■

NetBackup Release Notes for 8.1
http://www.veritas.com/docs/DOC5332
For upgrades, you must have an additional 500 MB of disk space on the drive where
Windows is installed. After the upgrade is complete, this additional space is not
needed.
NetBackup catalogs contain information about your backups that become larger as
you use the product. The disk space that the catalogs require depends primarily on
the following aspects of your backup configuration:
■ The number of files that are backed up.
■

The frequency of your backups.

■

The amount of time that you set to retain your backup data.

Veritas recommends that you have a minimum available disk space of 5% in any Disk
Storage Unit volume or file system.

Note: The value for disk space is for initial installation only. The NetBackup catalog
requires considerably more space once the master server is placed in a production
environment. For additional information on sizing requirements for the NetBackup catalog,
refer to the NetBackup Backup Planning and Performance Tuning Guide.
http://www.veritas.com/docs/DOC5332
General
requirements

Make sure that you have all of the following items:
■

NetBackup installation DVDs or ESD images

■

Appropriate license keys

■

Administrator account and password for all servers

■

Screen resolution configured for at least 1024x768, 256 colors.
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Table 4-1

Check Requirement
Remote and
cluster
installations

Details

NetBackup installation and upgrade requirements for Windows
and Windows clusters (continued)
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Table 4-1

Check Requirement

NetBackup installation and upgrade requirements for Windows
and Windows clusters (continued)

Details
In addition to all previously stated installation requirements, the following guidelines apply
to remote installations and cluster installations:
■

■

■

■

■

■

■

■

All nodes in the cluster must run the same operating system version, service pack
level, and NetBackup version. You cannot mix versions of server operating systems.
The installation account must have administrator privileges on all remote systems or
on all nodes in the cluster.
The source system (or primary node) must run Windows 2008/2008 R2
Server/Windows 2012/2012 R2/Windows 2016.
For Windows 2008 R2, clusters are only supported on Enterprise and Data Center
editions and not Standard edition.
The destination PC (or clustered nodes) must have Windows 2008/2008 R2/Windows
2012/2012 R2/Windows 2016.
The Remote Registry service must be started on the remote system.
The NetBackup installer can enable and start the Remote Registry service on the
remote system. If the Remote Registry service is not started, the installation receives
the following error message:
Attempting to connect to server server_name failed with the
following error: Unable to connect to the remote system. One
possible cause for this is the absence of the Remote Registry
service. Please ensure this service is started on the remote
host and try again.
NetBackup virtual name and IP address
Have the virtual name and IP address for NetBackup available. You must provide
this information during installation.
Cluster support changes for media servers
You cannot perform a new installation of a clustered media server.
Windows Server Failover Clusters (WSFC)
■ The shared disk that the NetBackup Group uses must already be configured in
the cluster and online on the active node.
■ Install NetBackup from the node with the shared disk (that is, the active node).
■

■

■

Computer or host names cannot be longer than 15 characters.

Cluster server (VCS) clusters:
All NetBackup disk resources must be configured in Veritas Enterprise Administrator
(VEA) before you install NetBackup.
Cluster node device configuration and upgrades
When you upgrade clusters, the ltid and the robotic daemons retrieve the device
configuration for a particular cluster node from the EMM database. The cluster node
name (provided by gethostname) stores or retrieves the device configuration in the
EMM database. The cluster node name is used when any updates are made to the
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Table 4-1

Check Requirement

NetBackup installation and upgrade requirements for Windows
and Windows clusters (continued)

Details
device configuration, including when ltid updates the drive status. The cluster node
name is only used to indicate where a device is connected. The NetBackup virtual
name is employed for other uses, such as the robot control host.
More information about cluster requirements is available.
Veritas NetBackup Clustered Master Server Administrator’s Guide
http://www.veritas.com/docs/DOC5332

Remote
Administration
Console host
names

You must provide the names of the Remote Administration Console hosts during master
server installation.

NetBackup
communication

Make sure that your network configuration allows all servers and clients to recognize and
communicate with one another.
Generally, if you can reach the clients from a server by using the ping command, the
setup works with NetBackup.

CIFS-mounted
file systems

■

NetBackup services and port numbers must be the same across the network.

■

Veritas suggests that you use the default port settings for NetBackup services and
Internet service ports. If you modify the port numbers, they must be the same for all
master servers, media servers, and clients. The port entries are in the following file:
%SYSTEMROOT%\system32\drivers\etc\services. To change the default
settings, you must perform a custom installation of NetBackup or manually edit the
services file.

Veritas does not support installation of NetBackup in a CIFS-mounted directory. File
locking in CIFS-mounted file systems can be unreliable.

Storage devices Devices such as robots and standalone tape drives must be installed according to the
manufacturers’ instructions and recognized by the Windows software.
Server names

When you are prompted for server names, always enter the appropriate host names. Do
not enter IP addresses.

Mixed versions

Make sure to install NetBackup servers with a release level that is at least equal to the
latest client version that you plan to use. Earlier versions of server software can encounter
problems with later versions of client software.
See “About compatibility between NetBackup versions” on page 11.
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Table 4-1

Check Requirement

NetBackup installation and upgrade requirements for Windows
and Windows clusters (continued)

Details

Installations on
Windows
2008/2008 R2
Server Core,
2012/2012 R2
Server
Core/Windows
2016

You can only install NetBackup on these computers with the silent installation method.

Other backup
software

Remove any other vendor’s backup software currently configured on your system. The
backup software of another vendor can negatively affect how NetBackup installs and
functions.

Web Services

Beginning with NetBackup 8.0, the NetBackup master server includes a configured
Tomcat web server to support critical backup operations. This web server operates under
user account elements with limited privileges. These user account elements must be
available on each master server (or each node of a clustered master server). More
information is available:

See “Installing NetBackup servers silently on Windows systems” on page 78.

See “NetBackup master server web server user and group creation” on page 164.

Note: Veritas recommends that you save the details of the user account that you use
for the NetBackup Web Services. A master server recovery requires the same NetBackup
Web Services user account and credentials that were used when the NetBackup catalog
was backed up.

Note: If the NetBackup PBX is running in secure mode, please add the web service
user as authorized user in PBX. More information about determining PBX mode and how
to correctly add users is available.
http://www.veritas.com/docs/000115774
CA Certificate
fingerprint

(Conditional) For media servers and clients only:
You must know the CA Certificate fingerprint of the master server at time of installation.
More information is available about the details on the CA Certificate fingerprint and its
role in generation of security certificates.
https://www.veritas.com/support/en_US/article.000127129

Authorization
Token

(Conditional) For media servers and clients only:
In some cases, the installer requires an authorization token to successfully deploy security
certificates. More information is available about the details on authorization tokens and
their role in generation of security certificates.
https://www.veritas.com/support/en_US/article.000127129
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See “Installation and upgrade requirements for UNIX and Linux” on page 31.

Requirements for Windows cluster installations
and upgrades
In addition to the normal server requirements, NetBackup cluster installations require
special considerations.
The following describes the guidelines for NetBackup cluster installations and
upgrades on Windows systems:
Table 4-2

Windows cluster requirements for installation and upgrade

Item

Requirement

Server operating system

The source and the destination systems must run Windows
2008, 2008 R2, 2012, 2012 R2, or 2016 Server.

Privileges

To perform clustered installations, you must have
administrator privileges on all of the remote nodes in the
cluster. Veritas recommends that you keep a record of all
nodes in the cluster and what software exists on each node.

NetBackup virtual name and Have the virtual name and IP address for NetBackup
IP address
available. You must provide this information during
installation.
Operating system on nodes

All clustered nodes must use the same operating system
version, service pack level, and NetBackup version. You
cannot run mixed server versions in a clustered environment.

Cluster support changes for
media servers

Clustered media servers are not supported.

Windows Server Failover
Clusters (WSFC)

■

■

■

Before you begin the install or the upgrade, take all
NetBackup resources offline except for the shared disk
resource, the virtual IP, and the virtual name.
Install or upgrade NetBackup from the active node (the
node with the shared disk resource, virtual IP, and virtual
name).
The computer or the host names cannot be longer than
15 characters.
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Table 4-2

Windows cluster requirements for installation and upgrade
(continued)

Item

Requirement

Cluster Server (VCS) clusters ■

■

All NetBackup disk resources must be configured in
Veritas Enterprise Administrator (VEA) before you install
NetBackup.
You must take the VCS NetBackup resource offline before
you begin the install or the upgrade.

Note: Make sure that shared disk and IP resources are
online during the install or the upgrade on active node.
Cluster node device
configuration and upgrades

When you upgrade clusters, the ltid and the robotic
daemons retrieve the device configuration for a particular
cluster node from the EMM database. The cluster node name
(provided by gethostname) stores or retrieves the device
configuration in the EMM database. The cluster node name
is used when any updates are made to the device
configuration, including when ltid updates the drive status.
The cluster node name is only used to indicate where a
device is connected. The NetBackup virtual name is employed
for other uses, such as the robot control host.

Performing local, remote, or clustered server
installation on Windows systems
Use the following procedure to perform a local, a remote, or a clustered install of
NetBackup on a Windows computer.
To install NetBackup 8.1 server software on a local, remote, or clustered
Windows server

1

2

Log on to the system. Be sure to log on with administrator privileges.
■

For local installations, log on to the system where you want to install
NetBackup.

■

For remote installations, log on to a system with network access to all of
the hosts where you want to install NetBackup.

■

For cluster installations, log on to the active node (the node with the shared
disk).

Start the NetBackup Installation Wizard with one of the following methods:
■

DVD media
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Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.
■

ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

3

On the initial browser screen (Home), click Installation.

4

On the Installation screen, click NetBackup Server Software Installation.

5

On the Welcome screen, review the content and click Next.

6

(Conditional) If you previously installed NetBackup 8.1 on this host, you see
the Program Maintenance dialog.

7

■

Select Modify to change installation settings for the local host, or to use
the local host as a platform to perform push installation to remote hosts.

■

Select Repair to restore NetBackup 8.1 to its original state on the local
host.

■

Select Remove to remove NetBackup 8.1 from the local host.

On the License Agreement screen, do the following and click Next:
I agree to and accept the terms of the license agreement.
You must select this item to install the software.

8

On the Veritas NetBackup Installation Type screen, provide the following
information:
Where to install

■

■

■

For a local installation, select Install to this
computer only.
For a remote installation, select Install to multiple
computers on your network.
For a cluster installation, select Install a clustered
Master Server.
This option is available only if the installation process
determines that your system is configured for a
Windows Server Failover Cluster (WSFC) or VCS
clustered environment.

Typical

Select this option to install NetBackup with the default
settings.

Custom

Select this option to install NetBackup with the settings
that you want.

Click Next.
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9

On the NetBackup License Key and Server Type screen, provide the following
information:
License Key

Enter the product license that you received with your
product.
The license that you provide determines which
components you can select. For example, you can click
the icon next to NetBackup Master Server only if you
enter a master server license.
For remote and cluster installations:

Note: The license that you enter here gets pushed to
the other nodes. Your license may enable add-on
products. If you push NetBackup to nodes that have an
add-on product already installed, your license works for
the add-on product(s).
During this installation process, the following occurs to
verify that you have proper credentials to perform remote
installations:
■

■

When you select a clustered system for installation,
NetBackup determines if you have proper
administrator credentials on all nodes in the cluster.
If you do not have the proper credentials, the system
is not added to the list.
If you have the proper credentials, NetBackup
performs a second check to determine if a license
is needed. If a license is needed and one was not
entered, the system cannot be added to the list. You
must enter a valid license to install on that node. If
you enter an invalid license, this screen remains
visible until a valid license is entered.

NetBackup Master Server

Click this icon to install master server software.

NetBackup Media Server

For local or remote installations, click this icon to install
media server software.

Disaster Recovery Master
Server

Select this option to perform a disaster recovery of your
master server. The disaster recovery process requires
additional steps and information that is not covered in
this manual. More information is available.
Veritas NetBackup Troubleshooting Guide

10 On the NetBackup Web Services screen, specify the account type and the
account details.
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What types of acccounts
should we use?

Select either Local or Domain (Active Directory).
Select Local if you want to associate the web server
with a user and a group account that exist on the local
host.
Select Domain (Active Directory) if you want to
associate the web server with a user and a group
account that exist on a trusted Windows domain.

What are the existing
account details

Specify the information as shown:
■

■

■

■

Domain - If you chose the Domain (Active
Directory) account type, specify the name of the
domain to which the user and the group accounts
belong.
Group - Specify the name of the group account to
associate with the web server.
User - Specify the name of the user account to
associate with the web server. For security reasons,
do not specify a user account that has administrative
privileges on the host.
Password - Specify the password of the user
account in the User field.

Note: After installation, you cannot change the user
account for the NetBackup web server. Do not delete
this account, as you cannot reconfigure the account for
the web server after installation.

More information is available.
See “Installation and upgrade requirements for Windows and Windows clusters”
on page 53.

11 (Conditional) This step applies only to the local installations that are Custom.
For Typical installations, skip to the next step.
This step describes how to select and configure the NetBackup Installation
Folder, NetBackup Port Numbers, and the NetBackup Services.
■

NetBackup Installation Folder
On this screen, you can select where the NetBackup files are installed.
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Destination Folder

By default, NetBackup files are installed to the following
location:
C:\Program Files\VERITAS
To change the folder destination where NetBackup is
installed:
■

Click Change.

■

Browse to the preferred location and designate a
new or an existing folder.
Click Next.

■

Additional information about installation folder
restrictions is available.
See “Restrictions on the NetBackup installation
directory” on page 8.

Click Next.
■

NetBackup Port Numbers
On this screen, you can change port numbers, if it is necessary in your
configuration.
You may need to change a port number if you encounter conflicts when
NetBackup and another industry product try to share the same port. Another
example is if a port conflict occurs with a firewall, which may cause security
issues.
To change a port number, select the port number that you want to replace
and type the new number.
Click Next.

■

NetBackup Services
On this screen, provide the following startup account and startup type
information for NetBackup services:
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Log On

Specify either Local System account or This
account.
By default, the Local System account is selected,
so that NetBackup uses the built-in system account.
When this option is selected, the fields below it are
disabled.
To specify a different account:
■ Select This account.
■

Startup Type

Enter the account information in the following
fields:
Domain
Username
Password

This option determines whether NetBackup services
start automatically if you need to restart the
NetBackup host. The default is Automatic.
To start NetBackup services manually after a restart,
select Manual.

Start job-related NetBackup By default, job-related services are set to start
services following
automatically after the installation has completed.
installation
To prevent job-related services from starting
automatically, click on the box to clear the check
mark.
Safe Abort Option

This option determines how the installation proceeds
if a restart is required as part of the installation.
If you select this option and the installation process
determines that a restart is required, the installation
stops. The system is then rolled back to its original
state.
If you do not select this option, the installation
proceeds even if the installation process determines
that a restart is required.

Click Next.

12 On the NetBackup System Names screen, provide the following information:
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Master Server Name

(Conditional) For local master server installations, enter
the name of the local computer. For a cluster installation,
enter the cluster virtual server name.
For media server installations, you must change the
name to the master server name to which the media
server is configured.

Additional Servers

Enter the names of any additional NetBackup master
servers and media servers that you want to
communicate with this server. Include the names of
computers where you plan to install NetBackup later.
To enter more than one name, separate each name
with a comma or press Enter after each name.

Media Server Name

This field appears only for local NetBackup Enterprise
media server installations.
When you install media server software, this field
defaults to the local server name.

EMM Server Name

The EMM (Enterprise Media Manager) server contains
all of the information about NetBackup volume
configuration and device configuration.
Accept the default name of the EMM server. You must
configure EMM on the master server. All master servers
must have their own EMM configuration. Remote EMM
or shared EMM is not supported.
Consider the following in regard to the EMM server:
■

■

Veritas does not support EMM server installation on
a CIFS-mount.
If the NetBackup system shares drives by using the
Shared Storage Option (SSO), all NetBackup servers
must use the same host to store device information.

For more information on EMM servers and EMM
databases, refer to the NetBackup Administrator's
Guide, Volume I.
http://www.veritas.com/docs/DOC5332
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OpsCenter Server Name
(Optional)

OpsCenter is a web-based administration and
management tool for NetBackup.
If you have an OpsCenter server or plan to install one,
enter the server name or the IP address for that server
here.
For a clustered server, do not use the virtual name.
Instead, use the actual host name of the cluster node.

Click Next.

13 After you confirm you want to continue, the installer fetches the certificate
authority certificate details. You have the option to click Cancel to halt this
action. Be aware if you click Cancel, this action requires you to rerun the
installation or continue with the installation without the required security
components. If these security components are absent, backups and restores
fail.

14 Enter the Certificate Authority Fingerprint as prompted.
After you confirm the fingerprint information, the installer stores the certificate
authority certificate details. You have the option to click Cancel to halt this
action. Be aware if you click Cancel, this action requires you to rerun the
installation or continue with the installation without the required security
components. If these security components are absent, backups and restores
fail.

15 After the Certificate Authority certificate is stored, the installer fetches the host
certificate. You have the option to click Cancel to halt this action. Be aware if
you click Cancel, this action requires you to rerun the installation or continue
with the installation without the required security components. If these security
components are absent, backups and restores fail.
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16 (Conditional) If prompted by the Security Token screen, enter the security
token.
If you were issued a security token, enter it below.
The token format is 16 upper case letters. Alternatively, you can also select
the Proceed without providing a security token option. When the option is
selected, this warning is shown:
In some environments, failure to provide a security token can result in
failed backups. Contact your backup administrator if you have questions.
After you enter a security token, you have the option to click Cancel to halt the
deployment of the host certificate. Be aware if you click Cancel, this action
requires you to rerun the installation or continue with the installation without
the required security components. If these security components are absent,
backups and restores fail.

17 (Conditional) For remote installations only:
On the Veritas NetBackup Remote Hosts screen, specify the hosts where
you want NetBackup installed.
■

Windows Destination Systems
Right-click Windows Destination Computers and select from the
drop-down menu, or use the following methods:
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Browse

Click here to search the network for the hosts where
you want to install NetBackup.
■ On the Available Systems dialog box, select
the computer to add and click Next.
■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.
■ If you plan to install to multiple remote
computers, click the box next to Remember
User Name and Password. Selecting this option
prevents the need to enter this information for
each remote computer.
■ Click OK.
■

On the Remote Destination Folder dialog box,
verify or change the Destination Folder where
NetBackup is installed.
The default location is C:\Program
Files\Veritas.
If you plan to install to multiple remote computers
and you want to use the same location, click the
box next to Use this folder for subsequent
systems. Selecting this option prevents the need
to enter the location for each remote computer.

Import

Click here to import a text file that contains a list of
host names. When you create the text file, the host
names must be defined in the following format:
Domain\ComputerName
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Add

Click here to add a host manually.
■ On the Manual Remote Computer Selection
dialog box appears, enter the Domain and the
Computer Name, then click OK.
■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.
If you plan to add and install to multiple remote
computers, click the box next to Remember
User Name and Password. Selecting this option
prevents the need to enter this information for
each remote computer.
■ Click OK.
■

■

■

On the Remote Destination Folder dialog box,
verify or change the Destination Folder where
NetBackup is installed.
The default location is C:\Program
Files\Veritas\.
If you plan to install to multiple remote computers
and you want to use the same location, click the
box next to Use this folder for subsequent
systems. Selecting this option prevents the need
to enter the location for each remote computer.
Click OK.

Remove

To remove a host from the Destination Systems
list, select the host and click here.

Change

Click here to change the destination for NetBackup
file installation on the selected remote host.

Click Next.

18 (Conditional) For cluster installations only:
On the NetBackup Remote Hosts screen, specify the remote system
information for installation on those computers.
■

On the initial screen, right-click Browse.

■

On the Available Systems dialog box, select the computer that you want
to add. Control-click to select multiple computers.
Click Next.

71

Installing server software on Windows systems
Performing local, remote, or clustered server installation on Windows systems

■

On the Remote Computer Login Credentials dialog box, enter the user
name, password, and domain that NetBackup is to use on the remote
system(s).
If you intend to add more remote computers, click the check box next to
Remember user name and password.
When you provide credentials, you select cluster nodes and add them to
the Windows Destination Systems list. These are the nodes on which
you remotely install NetBackup. Make sure that you select your local host
when you select systems to install.
Each time you choose a system, NetBackup performs system and license
checks. For example, it verifies the system for a server installation that
matches the type that you selected, as follows:
■

NetBackup not
installed

Considers the remote to be verified.

■

NetBackup already
installed

Compares the installation type on that system to the
installation type that you request.

■

Invalid combination

Notifies you of the problem and disallows the choice.
One example of an invalid combination is to try to install
a Remote Administration Console on a remote system
that is already a master server.

■

Remote system not a Notifies you of the problem and disallows the choice.
supported platform or
level

The installation procedure also verifies that you have proper administrator
credentials on the remote system. If you do not have administrator
credentials, the Enter Network Password screen appears, and prompts
you to enter the administrator’s user name and password.
Click OK and continue selecting destination systems.
This process repeats for each node that you select. You can elect to retain the
user name and password. In that case, you are prompted only when the user
name or password is not valid.
Note the following about the push-install process in a clustered environment:
■

You can install NetBackup on any number of nodes. However, the clustering
service sets the limit for the number of nodes in a cluster, not NetBackup.

■

Language packages and other NetBackup add-on products cannot be
installed with the push method. Add-on products must be installed on each
individual node in the cluster group. For instructions on how to install these
products, refer to the NetBackup documentation that supports each product.
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■

NetBackup pushes to the other nodes only the license keys you enter at
the beginning of the installation. Your license keys may enable add-on
products. If you push NetBackup to nodes that have an add-on product
already installed, your key works for that product.

Click Next.

19 (Conditional) For cluster installations only:
On the Cluster Settings screen, you provide the virtual and the physical
network information.
For new installations, the following configuration settings that you enter apply
to all nodes:
Create a new Cluster
Group

For new cluster installations, select this option.

IPv4 Clusters

The default cluster setting is IPv4.
Enter the following addresses:
■

■

IPv6 Clusters

Virtual IPv4 Address
The IP address to which the virtual server name should
resolve.
For new cluster installations, you must enter the address
manually.
IPv4 Subnet Mask
Identifies a subnetwork so that IP addresses can be
shared on a local area network. This number correlates
directly to the virtual IP address of the cluster.

To enable IPv6 clusters, select this option.
Enter the following IP address:
■

Virtual IPv6 Address
The IPv6 address must be entered in CIDR format.

NB Cluster Group Name The name that is used to identify a NetBackup service group
or resource group. The resources in any resource group are
related and interdependent.
Virtual Host Name

The name by which NetBackup is known in the cluster.
When you install the client software, this host name must
be added to the Additional Servers field on the NetBackup
System Names screen.
The server uses this name when it communicates with the
client nodes.
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Path to Shared Data

A directory on one of the shared disks in the cluster where
NetBackup stores configuration information. If the letter for
the disk (or drive) does not appear in the pull-down list, enter
only the letter.

Public Network

For NetBackup clustered environments, select a public
network that is assigned to the node of the cluster.

Warning: You must not select a private network that is
assigned to this cluster.
Cluster Configuration

After you set all of the parameters, click this icon to configure
the cluster for use with NetBackup. The Next icon is not
available until after successful cluster configuration.
The text box provides the following information about the
configuration:
■

■
■

Identifies any existing clusters or NetBackup cluster
groups.
Indicates a successful configuration.
Identifies any problems or errors that occurred during
the configuration (configuration failure).

Note: If you click Cancel after a successful cluster
configuration for new installations, a pop-up message
appears. The message asks if you are sure that you want
to proceed with the cancelation. To cancel the installation
and remove the new cluster group, click Yes. To continue
with the installation and retain the new cluster group, click
No and then click Next.
If the cluster configuration fails, see the NetBackup Clustered
Master Server Administrator's Guide for information about
how to resolve the problem.
http://www.veritas.com/docs/DOC5332

When the successful cluster configuration message appears, click Next.

20 On the Ready to Install the Program screen, review the Installation Summary
that shows your selections from the previous steps.
Note: Veritas recommends that you review the summary screen for any warning
messages. You can prevent installation and upgrade issues if you resolve any
problems before you continue the installation.
Then select one of the following options:
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■

Click Install to start the installation.

■

Click Back to view the previous screens and make any changes, then return
to this screen and click Install.

■

Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears
that shows you the installation progress. This process may take several minutes.
For remote and cluster installations, up to five installations occur simultaneously.
When an installation is completed, another one begins so that a maximum of
five installations are in progress.

21 On the Installation Complete screen, select from the following options:
View installation log file

The installation log file provides detailed installation
information and shows whether any errors occurred.
Examine the installation log at the following location:
%ALLUSERSPROFILE%\Symantec\
NetBackup\InstallLogs\

Note: When you perform a remote or a cluster
installation to multiple computers, this option only lets
you view the log for the local computer. Each computer
that you selected for installation contains its own
installation log file. To view the log file of a remote
computer, open a Windows Explorer window and enter
\\<COMPUTERNAME>.
Search the installation log for the following error
indications:
■

Strings that include Return Value 3.

■

Important log messages that are color coded as
follows:
Yellow = warning.
Red = error.
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Finish

Select one of the following to complete the installation:
■

■

If you are done installing software on all servers,
click the box next to Launch NetBackup
Administration Console now and click Finish.
The NetBackup Administration Console starts a
Configuration Wizard so that you can configure your
NetBackup environment.
If you have more server software to install, click
Finish.
You can move on to the next computer and install
the necessary server software.

22 (Conditional) On a clustered NetBackup master server, you must copy the
Certificate Authority certificate and the host certificate to the inactive node.
More information is available:
See “Generate a certificate on the inactive nodes of a clustered master server”
on page 161.
If you performed a disaster recovery of the master server, you must first
generate the token and then copy it to each of the inactive nodes. More
information about how to handle disaster recoveries is available.
Veritas NetBackup Troubleshooting Guide

23 (Conditional) If you use cloud storage in your NetBackup environment, you
must update your cloud configuration file. More information is available.
See “Update cloud configuration file on the master server immediately after
install or upgrade to NetBackup 8.1” on page 139.

24 Repeat the steps in this procedure for any other servers.
25 After all server software is installed, you are ready to install client software.
See “About NetBackup client installation” on page 86.
See “Post-installation tasks for NetBackup cluster environments” on page 76.
See “Verifying Windows cluster installations or upgrades” on page 77.

Post-installation tasks for NetBackup cluster
environments
After NetBackup server software is installed in a cluster, note the possible actions
you may need to take:
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Obtain certificates

You must obtain the Certificate Authority certificate and the
host certificate for each inactive node. More information is
available:
See “Generate a certificate on the inactive nodes of a
clustered master server” on page 161.

Restart

You may need to restart each of the cluster nodes after the
installation is complete.

WSFC and VCS clusters

Under normal circumstances, cluster configuration is one of
the final steps when you install NetBackup in a cluster. If this
step is not done or does not complete successfully, you can
use the bpclusterutil command from the active node to
perform this step.
For information on how to run bpclusterutil, see the
NetBackup Commands Reference Guide.
http://www.veritas.com/docs/DOC5332

WSFC clusters

Any NetBackup resources that you took offline come back
online automatically.

See “Verifying Windows cluster installations or upgrades” on page 77.

Verifying Windows cluster installations or
upgrades
The Cluster Administration console lets you verify the installation or upgrade and
view your current system structure.
To verify a successful WSFC cluster installation or upgrade through the
Cluster Administration console

1

During a cluster installation, you can open the Cluster Administration console
to see your current structure.

2

After you have completed the installation and the configuration process, the
console shows the new cluster group configuration.

To verify a successful VCS cluster installation or upgrade through the Cluster
Manager console

1

During a cluster installation, you can open the Cluster Administration console
to see your current structure.

2

After you have completed the installation and the configuration process, the
console shows the new cluster group configuration.
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See “About NetBackup server configuration” on page 130.

Installing NetBackup servers silently on Windows
systems
A silent installation avoids the need for interactive input in the same manner as
performing a remote installation. Silent installations are not supported for master
servers or if you want to run the NetBackup services as a specific user rather than
the local system.
To perform a silent installation, you must first modify the appropriate NetBackup
script. After script modification, you can run the script to initiate the silent installation.
Note: For Windows 2008 Server Core systems, you can only install NetBackup
with this procedure.
To install NetBackup server software silently

1

Log on as administrator to the system where you want to install NetBackup.

2

Insert the NetBackup installation DVD or navigate to the location where the
ESD images (downloaded files) reside.

3

Open Windows Explorer and copy the contents of the X86 or the X64 directory
to a temporary directory on your hard drive. Choose the directory that is
associated with the platform type that you want to install.

4

Since the source files are read-only, you must change the permissions for the
copied files to allow the installation or the update.

5

In the temporary directory where the copied files reside, select the appropriate
script to modify:
■

To install a media server, edit silentmedia.cmd

■

To install a NetBackup Remote Administration Console, edit
silentadmin.cmd

6

Edit the following lines as needed for your installation:
■
■

SET ADDITIONALSERVERS=media1,media2,media3

Enter the names of any additional NetBackup master servers and media
servers that you want to communicate with this host. Include the names of
servers where you plan to install NetBackup later.
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If no other servers are to communicate with this host, remove this line from
the script.
■

SET ABORT_REBOOT_INSTALL=num

This line lets you determine how you want the installation to continue if a
restart is required. Select from the following settings:
0 (zero, default)

By default, a silent installation does not abort if it is determined
that a restart is required. If you leave this setting at 0, select one
of the following tasks:
■ After the installation is complete, check the installation log
to see if a restart is required.
If the string in use appears anywhere in the log, you must
restart the system manually.
■ Force an automatic restart after the installation is complete.
To force an automatic restart, before you run the script,
remove the following option from the silent installation
command script (silent*.cmd):
REBOOT="ReallySuppress"

Warning: A forced restart occurs with no warning to the user.
It does not cancel the installation or roll back the system to its
original state.
1 (one)

Select this setting to abort the installation if it is determined that
a restart is required.
If a restart is needed, this setting cancels the installation and the
system is rolled back to its original state.

■

SET CA_CERTIFICATE_FINGERPRINT=fingerprint

You must know the CA Certificate fingerprint of the master server at time
of installation. More information is available about the details on the CA
Certificate fingerprint and its role in generation of security certificates.
https://www.veritas.com/support/en_US/article.000127129
■

SET AUTHORIZATION_TOKEN=token

In some cases, the installer requires an authorization token to successfully
deploy security certificates. More information is available about the details
on authorization tokens and their role in generation of security certificates.
https://www.veritas.com/support/en_US/article.000127129
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Caution: Because providing the authorization token in plain text presents
a security risk, restrict access to the silentmedia.cmd file to read access.
Grant read access to NetBackup administrators and system administrators
only. Delete the silentmedia.cmd file after successful installation.

7

Save the script and run it.

8

Examine the installation log at the following location:
%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\

Search the installation log for the following error indications:
■

Strings that include Return Value 3.

■

Important log messages are color coded as follows:
Yellow = warning.
Red = error.

After all server software is installed, you are ready to install client software.
See “About NetBackup client installation” on page 86.
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About the administrative
interfaces
This chapter includes the following topics:
■

About the NetBackup Administration Console

■

Installing the NetBackup Administration Console

■

Installing multiple versions of the NetBackup Administration Console on Windows

■

Removing earlier versions of the NetBackup Administration Console on Windows

■

About the NetBackup Remote Administration Console

■

Installing the NetBackup Remote Administration Console

About the NetBackup Administration Console
The NetBackup Administration Console can be used to administer one or more
UNIX or Windows NetBackup servers. It provides all of the standard NetBackup
server interfaces. The console can be used to create backup policies, manage
volumes, view status, monitor tape drives, and other operations.
The NetBackup Administration Console is installed when you install or upgrade
NetBackup server packages.

Installing the NetBackup Administration Console
You do not need to install the NetBackup Administration Console separately.
NetBackup includes an administration console for all the supported versions of
NetBackup. More information about supported versions of NetBackup is available.
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https://sort.veritas.com/eosl
Note: Veritas recommends that after you install or upgrade NetBackup server
software, you should uninstall older versions of the Remote Administration Console
(Windows and Java) present on the host. If the native NetBackup Administration
Console for Windows is present, it is automatically uninstalled when you install or
upgrade the NetBackup server software.
A NetBackup environment may contain multiple servers with multiple NetBackup
versions. You can install and remove multiple versions of the NetBackup
Administration Console. More information is available.
See “Installing multiple versions of the NetBackup Administration Console on
Windows” on page 82.
See “Removing earlier versions of the NetBackup Administration Console on
Windows” on page 83.

Installing multiple versions of the NetBackup
Administration Console on Windows
To install multiple versions of the NetBackup Administration Console in a mixed
version environment, note the following restrictions and guidelines:
Updates

Only the most recent version of the NetBackup Administration
Console can be updated (or patched).

auth.conf file

The NetBackup-Java Capabilities Authorization configuration
file (auth.conf), must always be located in
install_path\java. For example, C:\Program
Files\Veritas\java. The file must exist there regardless
of how many versions of the console are installed, or in which
directories they are installed.
The file is only used for administering NetBackup on this
Windows host, and default settings exist if the file is not
present. For more information about these defaults, see the
section "Authorizing NetBackup users" in the NetBackup
Administrator's Guide, Volume I.
http://www.veritas.com/docs/DOC5332

Console version location

You must install each console version to a different folder.
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To install earlier versions of the NetBackup-Java Administration Console

1

Insert the appropriate version NetBackup Windows installation media with the
NetBackup-Java Administration Console that you want to install.

2

For NetBackup 7.0 and 7.1 versions, select Installation and click Java
Windows Administration Console Installation.

3

If a different version of the Java console has already been installed, specify a
new folder location to prevent overwriting the earlier installation.
For example, specify C:\Program Files\Veritas\nbjava65 for version 6.5
Java consoles.

4

To complete the installation, click Finish.

See “Removing earlier versions of the NetBackup Administration Console on
Windows” on page 83.
See “Installing the NetBackup Administration Console” on page 81.

Removing earlier versions of the NetBackup
Administration Console on Windows
In some cases, you can remove earlier versions of the NetBackup Administration
Console by using the Add/Remove Programs feature. You can use this method
if the version that you want to remove appears in the list of programs.
If the version that you want to remove does not appear in the list of programs, you
must manually remove it. Use the following procedure.
To manually remove earlier versions of the NetBackup Administration Console

1

Remove the folder where the earlier version NetBackup Administration Console
is installed.

2

Remove the appropriate menu item from the Start > Programs > NetBackup
menu.

3

Remove any relevant desktop shortcuts.

About the NetBackup Remote Administration
Console
The NetBackup Remote Administration Console is an interface-only version of
NetBackup that you can use to administer NetBackup servers from another
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computer. The computer that runs the NetBackup Remote Administration Console
does not require NetBackup software.
The following is a brief description of the NetBackup Remote Administration Console
operation:
■

The console lets you perform all NetBackup operations exactly like the
NetBackup Administration Console on a local NetBackup server. You can create
backup policies, manage volumes, view status, monitor tape drives, and perform
other operations.

■

The console displays the name of the server it administers, rather than a local
host name.

■

The console can only administer other NetBackup servers. It cannot act as a
master or a media server.

Installing the NetBackup Remote Administration
Console
The procedure shown details how to install the NetBackup Remote Administration
Console on a non-NetBackup computer.
To install the NetBackup Remote Administration Console

1

On the computer where you want to install the remote administration console,
do one of the following:
■

Insert the appropriate DVD that contains the NetBackup software.
On Windows systems with Autorun enabled, the installation starts
automatically.
On Windows systems with Autorun disabled, navigate to the DVD directory
and run Browser.exe.

■

Navigate to the location where the downloaded files reside and run
Browser.exe.

Note: You cannot install NetBackup Remote Administration Console on a
computer where NetBackup server software is already installed.

2

On the initial screen, select Installation.

3

On the Installation screen, click NetBackup Administration Console
Installation (x64 only).

4

On the Welcome screen, review the content and click Next.
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5

On the License Agreement screen, accept the agreement and click Next.

6

On the NetBackup Installation Type screen, select Install to this computer
only and Typical Installation and then click Next.
If an earlier version of the console already exists, you have the following options:
■

Cancel the installation and remove the earlier version of the console. Then
run the new console installation again.

■

Specify an alternate installation location for the new version of the console.

7

On the Ready to Install the Program screen, review the Installation Summary
and click Install.

8

On the Installation Complete screen, click Finish.

9

To open the console, click Start > Programs > Veritas NetBackup >
NetBackup Version Administration Console.

Note: NetBackup includes an administration console for all the supported versions
of NetBackup. More information about supported versions of NetBackup is available.
https://sort.veritas.com/eosl
See “About the NetBackup Remote Administration Console” on page 83.
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Installing NetBackup client
software
This chapter includes the following topics:
■

About NetBackup client installation

■

About NetBackup client installation on Windows

■

About NetBackup client installation on UNIX/Linux

About NetBackup client installation
By definition, NetBackup servers are also clients. When you install NetBackup
server software, client software is also installed.
When you install client software, you perform a true client installation since no server
software is installed.
Client software can be installed locally at each individual computer or remotely.
The operating system determines which clients can be installed remotely.
Windows

A Windows host can only push client software to Windows
clients.
NetBackup does not need to be installed on the host that is
used to perform the remote client installation.

UNIX or Linux

A NetBackup UNIX or Linux server can only push client
software to UNIX or Linux clients.
NetBackup software and client type software must be installed
on the server that is used to perform the remote client
installation.
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Note: Additional steps are required to deploy clients in a secure environment where
the clients do not have direct connectivity to the master server. More information
on this topic is available. See the topic on deploying certificates on clients without
connectivity to the master server in the Veritas NetBackup Security and Encryption
Guide.

Note: All scripts must be stored and run locally. One recommendation is that scripts
should not be world-writable. Scripts are not allowed to be run from network or
remote locations. Any script that is created and saved in the NetBackup db_ext
(UNIX) or dbext (Windows) location needs to be protected during a NetBackup
uninstall.
For more information about registering authorized locations and scripts, review the
knowledge base article:
http://www.veritas.com/docs/000126002
For more information about your specific database agent, review the documentation
for that agent:
http://www.veritas.com/docs/DOC5332

About NetBackup client installation on Windows
The NetBackup client installation wizard for Microsoft Windows lets you select the
appropriate setup and installation options from a series of wizard screens. After
you select options, a window appears that lets you verify your selections before the
installation begins.
While the installation is in progress, a dialog box provides details of the installation
and the setup progress. When the installation is completed, a final window shows
the results.
Note the following when you install NetBackup client software on Windows systems:
Client installation restrictions You cannot install NetBackup client software on the
computers that currently have NetBackup server software.
In these cases, you must first remove the NetBackup server
software.
See “Removing NetBackup server and client software from
Windows servers, clusters, and clients” on page 155.
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User permissions

■

By default on Windows 2008, 2008 R2, 2012, 2012 R2,
and 2016 Server systems, only administrators have write
permission to the Program Files directory.

■

NetBackup writes log files and progress files to the
following location:
Program Files\Symantec\NetBackup\Logs
To perform backups and restores with the Backup,
Archive, and Restore interface, users must have write
permission to the Logs directory. Users without write
permission to this directory receive an error message,
and the backup or restore is canceled. The administrator
account has write permission by default, but you must
ensure that other users also have write permission.

About Windows client installation methods and requirements
You can install NetBackup clients on Windows systems with the following methods:
Table 6-1

Installation methods and requirements

Method

Requirements

Details

Local installation

To install NetBackup client
software locally, the system must
meet the following configuration
requirements:

The installation wizard installs the
client software only on the
computer where you run the
installation.

■

■

■

Microsoft Windows 2008/Vista, See “Installing NetBackup
Windows 2008 R2/Windows 7, Windows clients locally or
Windows 2012/2012
remotely” on page 90.
R2/Windows 8, or Windows
2016
Any TCP/IP transport that is
Windows Sockets compliant.
(Use of the TCP/IP transport
that comes with the server or
the operating system is
recommended.)
A network adapter that your
TCP/IP transport supports

88

Installing NetBackup client software
About NetBackup client installation on Windows

Table 6-1
Method

Installation methods and requirements (continued)
Requirements

Details

Remote installation To install NetBackup client
The installation wizard scans the
software remotely, the system must network for available clients where
meet the following configuration
you can install the client software.
requirements:
The source computer must run
■ All the requirements for local
Windows 2008, 2008 R2, 2012, or
installations must be met.
2016 Server.
■ The source system must run
Also, a remote installation requires
Windows 2008, 2008 R2, 2012, system administrator privileges.
2012 R2, or 2016 Server.
Note: You cannot install clients
■ Administrator privileges are
remotely from NetBackup Windows
required for the user that
performs remote installations. servers to UNIX computers.
■ Remote Registry service must
See “Installing NetBackup
be started on the remote
Windows clients locally or
system.
remotely” on page 90.
If the Remote Registry service
is not started, the installation
receives this error message:
Attempting to connect to server server_name
failed with the following error: Unable to
connect to the remote system. One possible
cause for this is the absence of the Remote
Registry service. Please ensure this service
is started on the remote host and try again.

Silent installation

The requirements for silent
A silent installation is a process
installation are the same as the
that does not require interactive
requirements for a local installation. input. However, you must edit the
silentclient.cmd file before
you run it.
See “Installing NetBackup
Windows clients silently”
on page 97.

An NTFS disk partition is required for all installation types.
The NetBackup client version that you install must be the same or earlier than the
installed version of NetBackup server software. Later client versions cannot be
used with earlier server versions.
See “About compatibility between NetBackup versions” on page 11.
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See “About NetBackup client installation” on page 86.

Installing NetBackup Windows clients locally or remotely
Use this procedure to install NetBackup on your local computer or on multiple
computers on your network. You can stop the installation process at any time by
clicking Cancel or by clicking Back to return to the previous window.
When you install Windows clients remotely, note the following:
Requirements

Review the requirements for Windows client installation.
See “About Windows client installation methods and
requirements” on page 88.

Privileges

You must have administrator privileges on the remote clients
for the NetBackup installation to complete successfully.

Client name entries

During installation, the client name is written to the registry
in lowercase. For backups to work, the policies on the
NetBackup server must specify the client names in lowercase.

Note: After client installation, you may need to restart the system for the changes
to take effect. A message appears to alert you if a restart is necessary.
To install NetBackup client software locally or remotely on Windows systems

1

Log on as administrator on the host where you want to install the client software.

2

Start the NetBackup Installation Wizard with one of the following methods:
■

DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■

ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

3

On the initial screen, select Installation.

4

On the Installation screen, select NetBackup Client Software Installation.

5

On the Welcome screen, review the content and click Next.

6

(Conditional) If you previously installed NetBackup 8.1 on this host, you see
the Program Maintenance dialog.
■

Select Modify to change installation settings for the local host, or to use
the local host as a platform to perform push installation to remote hosts.
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■

Select Repair to restore NetBackup 8.1 to its original state on the local
host.

■

Select Remove to remove NetBackup 8.1 from the local host.

7

On the License Agreement screen, accept the terms of the agreement and
click Next.

8

On the Veritas NetBackup Client Installation Type screen, provide the
following information:
Where to install

For a local installation, select Install to this computer
only.
For remote installation, select Install to multiple
computers on your network.
The procedure does not install the client on the local
host unless you add it to the list of systems that you
want to install.

Typical

Select this option to install NetBackup with the default
settings.

Custom

Select this option to install NetBackup with the settings
that you want.

Click Next.

9

(Conditional) This step applies only to local Custom installations.
On the Veritas NetBackup Client Destination Folder screen, you can select
where the NetBackup files are installed.
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Destination Folder

By default, NetBackup files are installed to the following
location:
C:\Program Files\VERITAS
To change the folder destination where NetBackup is
installed:
■

Click Change.

■

Browse to the preferred location and designate a
new or an existing folder.
Click Next.

■

Additional information about installation folder
restrictions is available.
See “Restrictions on the NetBackup installation
directory” on page 8.

Note: For upgrades, you cannot change the destination.

10 (Conditional) This step applies only to Custom installations.
On the NetBackup Options screen, select from the following options:
At System Startup

Ports

Enable or disable the following options:
■

Start NetBackup Client Service Automatically
By default, this option is enabled so that NetBackup
services are available immediately after system
startup.

■

Start NetBackup Client Job Tracker Automatically
By default, this option is disabled. To start this option
manually after installation, click Start > All
Programs > Veritas NetBackup > NetBackup
Client Job Tracker.

On this screen, you can change port numbers, if it is
necessary in your configuration.
You may need to change a port number if you encounter
conflicts when NetBackup and another industry product
try to share the same port. Another example is if a port
conflict occurs with a firewall, which may cause security
issues.
To change a port number, select the port number that
you want to replace and type the new number.

Click Next.
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11 On the NetBackup Services screen, provide the following startup account
and startup type information for NetBackup client services:
Log On

Specify either Local System account or This account.
By default, the Local System account is selected, so
that NetBackup uses the built-in system account. When
this option is selected, the fields below it are disabled.
To specify a different system account:

Safe Abort Option

■

Select this option.

■

Enter the account information in the following fields:
Domain
Username
Password

This option determines how the installation proceeds if
a restart is required as part of the installation or upgrade.
If you select this option and the installation process
determines that a restart is required, the installation (or
upgrade) stops. The system is then rolled back to its
original state.
If you do not select this option, the installation (or
upgrade) proceeds even if the installation process
determines that a restart is required.

12 On the NetBackup System Names screen, the following fields are populated
automatically. Changes are not normally required. Except for the Client Name,
you can make changes as needed for your configuration.
Client Name

Do not change this name.

Master Server Name

If necessary, change this name to the appropriate
master server where the client backup images are to
be stored.

Additional Servers

Enter all of the master server and media server names
that you want this client to access.
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13 After you confirm you want to continue, the installer fetches the certificate
authority certificate details. You have the option to click Cancel to halt this
action. Be aware if you click Cancel, this action requires you to rerun the
installation or continue with the installation without the required security
components. If these security components are absent, backups and restores
fail.

14 On the Confirm the CA fingerprint screen, select I recognize the fingerprint
for this host. Proceed with the certificate deployment. if the fingerprint
displayed is one you recognize and trust. Click Next to continue.
If you do not recognize or trust the displayed fingerprint, select Proceed without
the certificate deployment.
After you confirm the fingerprint information, the installer stores the certificate
authority certificate details. You have the option to click Cancel to halt this
action. Be aware if you click Cancel, this action requires you to rerun the
installation or continue with the installation without the required security
components. If these security components are absent, backups and restores
fail.

15 After the Certificate Authority certificate is stored, the installer deploys the host
certificate. You have the option to click Cancel to halt this action. Be aware if
you click Cancel, this action requires you to rerun the installation or continue
with the installation without the required security components. If these security
components are absent, backups and restores fail.

16 (Conditional) If prompted by the Authorization Token screen, enter the security
token.
Please enter an authorization token
The token format is 16 upper case letters. Alternatively, you can also select
the Proceed without providing a security token option. When the option is
selected, this warning is shown:
In some environments, failure to provide a security token can result in
failed backups. Contact your backup administrator if you have questions.
After you enter a security token, you have the option to click Cancel to halt the
deployment of the host certificate. Be aware if you click Cancel, this action
requires you to rerun the installation or continue with the installation without
the required security components. If these security components are absent,
backups and restores fail.
If this installation is a remote installation, the specification of an authorization
token is optional. Contact your backup administrator to determine if authorization
tokens are required for your environment.
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17 On the Veritas NetBackup Remote Hosts screen, specify the hosts where
you want NetBackup installed.
■

Destination Systems
Right-click the Windows Destination Computers icon and select from the
drop-down menu , or use the following icons:
Browse

Click here to search the network for the hosts where
you want to install NetBackup.
■ On the Available Systems dialog box, select
the computer to add and click Next.
■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.
■ If you plan to install to multiple remote
computers, click the box next to Remember
User Name and Password. Selecting this option
prevents the need to enter this information for
each remote computer.
■ Click OK.
■

On the Remote Destination Folder dialog box,
verify or change the Destination Folder where
NetBackup is installed.
The default location is C:\Program
Files\Veritas.
If you plan to install to multiple remote computers
and you want to use the same location, click the
box next to Use this folder for subsequent
systems. Selecting this option prevents the need
to enter the location for each remote computer.

Import

Click here to import a text file that contains a list of
host names. When you create the text file, the host
names must be defined in the following format:
Domain\ComputerName
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Add

Click here to add a host manually.
■ On the Manual Remote Computer Selection
dialog box appears, enter the Domain and the
Computer Name, then click OK.
■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.
If you plan to add and install to multiple remote
computers, click the box next to Remember
User Name and Password. Selecting this option
prevents the need to enter this information for
each remote computer.
■ Click OK.
■

■

■

On the Remote Destination Folder dialog box,
verify or change the Destination Folder where
NetBackup is installed.
The default location is C:\Program
Files\Veritas.
If you plan to install to multiple remote computers
and you want to use the same location, click the
box next to Use this folder for subsequent
systems. Selecting this option prevents the need
to enter the location for each remote computer.
Click OK.

Remove

To remove a host from the Destination Systems
list, select the host and click here.

Change

Click here to change the destination for NetBackup
file installation on the selected remote host.

Click Next.

18 On the Ready to Install the Program screen, review the Installation Summary
that shows your selections from the previous steps.
Note: Veritas recommends that you review the summary screen for any warning
messages. You can prevent installation and upgrade issues if you resolve any
problems before you continue the installation.
Then select one of the following options:
■

Click Install to start the installation.
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■

Click Back to view the previous screens and make any changes, then return
to this screen and click Install.

■

Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears
that shows you the installation progress. This process may take several minutes.
Up to five remote installations occur simultaneously. When a remote installation
is completed, another one begins so that a maximum of five installations are
in progress.
If you click Cancel after you click Install, the installation does not stop
immediately. Installation continues on all remote hosts where the installation
has already started. Any specified hosts after that point do not get client
software installed.
NetBackup considers any remote installations that were completed when you
clicked Cancel to be successful.

19 On the Installation Complete screen, click Finish.
Examine the installation log on the following location:
%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\

An installation log file provides detailed installation information and shows
whether any errors occurred.
Note: When you perform a remote installation to multiple computers, this option
only lets you view the log for the local computer. Each computer that you
selected for installation contains its own installation log file. To view the log file
of a remote computer, open a Windows Explorer window, enter
\\COMPUTERNAME, and navigate to the InstallLogs directory.
Search the installation log for the following error indications:
■

Strings that include Return Value 3.

■

Important log messages are color coded as follows:
Yellow = warning.
Red = error.

Installing NetBackup Windows clients silently
A silent installation process does not require interactive input. It does, however,
require that you edit the silentclient.cmd file before you run it.
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Silent installations of NetBackup clients are not supported if you want to run the
NetBackup services as a user instead of a local administrator.
To install NetBackup with a custom services account, refer to the following topics:
See “Installing NetBackup Windows clients locally or remotely” on page 90.
Use the following procedure to perform a silent installation of a local NetBackup
client.
To perform a silent installation of NetBackup client software on Windows

1

Insert the NetBackup installation DVD in the drive or navigate to the location
where the ESD images (downloaded files) reside.

2

In a Microsoft Windows Explorer window, navigate to the DVD drive.

3

Copy the contents of the directory shown to a temporary folder on your hard
drive. For example, C:\temp.
PC_Clnt\x64

4

Since the original source files are read-only, change the permissions for the
copied files on the hard drive to allow the update.

5

In the temporary directory, use a text editor to edit the silentclient.cmd file
so the script installs the client software as needed.

6

Run the silentclient.cmd script.

7

To verify that the installation was successful, check the installation log file in
the following directory:
%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs

How to configure NetBackup clients
You can configure NetBackup clients by performing one of the following actions:
To add servers or media
servers:

■

Start the Backup, Archive, and Restore interface.

■

Click File > Specify NetBackup Machines.

To display and change the
client properties:

■

Start the Backup, Archive, and Restore interface.

■

Click File > NetBackup Client Properties.
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To display and change the
server properties:

■

Open the NetBackup Administration Console.

■

Expand Host Properties and click Clients.

■

In the right pane, right-click on the client and choose
Properties.
In the dialog box that appears, on the Servers tab, all
NetBackup servers that require access to your Windows
client must be listed.

For complete information on client configuration, see the NetBackup Administrator's
Guide, Volume I.
http://www.veritas.com/docs/DOC5332

About NetBackup client installation on UNIX/Linux
You can install UNIX/Linux clients either locally at the client computer or remotely
from your UNIX/Linux NetBackup server. To install client software remotely from a
UNIX/Linux NetBackup server, the client type software must first be installed on
the UNIX/Linux server.
Note the following when you install NetBackup client software on UNIX/Linux
systems:
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UNIX/Linux package
consolidation

Many of the add-on products and database agents are now
installed with the NetBackup client package. Separate
installation for these products is no longer needed.
The following products are now included in the NetBackup
8.1 client package (if the platform supports the product):
■

BMR Boot server

■

DB2

■

Encryption

■

Informix

■

LiveUpdate agent

■

Lotus Notes

■

Oracle

■

SAP

■

Snapshot Client

■

Sybase

The binaries for the listed products are laid down with the
client package. A valid license is still required to enable the
product. If product configuration was required previously
(such as db2_config), configuration is still required.
The French, Japanese, and Chinese language packages
remain as separate add-ons. The process to install and
upgrade these products remains the same.
gzip and gunzip
commands

The gzip and the gunzip commands must be installed on
each system. The directories where the commands are
installed must be part of the root user’s PATH environment
variable setting.
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NetBackup-Java compatibility To initiate a backup or a restore from a UNIX/Linux client,
the following graphical interfaces are available:
■

Clients that are compatible with NetBackup-Java may use
the NetBackup-Java interface (jbpSA). Several versions
of the interface exist. Use the -h option and review the
-r options to find out which versions are supported.

■

Clients that are not compatible with NetBackup-Java can
use the bp interface.

More information about compatibility with graphical interfaces
is available. Refer to the NetBackup Software Compatibility
List (SCL).
http://www.netbackup.com/compatibility

Note: If a client is listed in the Client Selections for Backup
Policies section of the SCL but not in the NetBackup
Administration Consoles section, the client is supported for
backup and restore, but it does not support any of the
available graphical interfaces.

About UNIX/Linux client installation methods
You can install NetBackup clients on UNIX/Linux systems with the following methods:
Local installations

■

This method installs the client software on the computer
where you run the installation script.

■

To install clients to a location other than the default, you
must create and link a directory before you install the
client software. First create the directory where you want
the software to reside, then create /usr/openv as a link
to that directory.
On IBM zSeries Linux clients, you must transfer the
NetBackup DVD or ESD image contents to a location that
is readable by the virtual Linux environment. You can
transfer the image with NFS mounting commands.

■

See “Installing UNIX clients locally” on page 102.
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Remote (push) installations

■

■

■

■
■

■

You can "push" the client software from your UNIX/Linux
NetBackup server to your UNIX/Linux client computers.
The UNIX/Linux client must be a true client and not a
media server or a master server. The preferred installation
method is to push the client software.
Before you can push to a UNIX/Linux client, you must first
install the NetBackup client type software on the server.
Then, you must create a policy that includes the client
name.
http://www.veritas.com/docs/DOC5332
See “Installing client type software on a master server”
on page 51.
You cannot install Windows client software remotely from
a NetBackup UNIX/Linux server.
Firewalls can prevent remote client installation.
Clients such as the IBM zSeries Linux may not have a
locally mounted DVD device or access to the NetBackup
DVD or ESD images. In these cases, you must push the
client software from a UNIX/Linux master server or a
media server.
The following remote installation methods are available:
See “Installing client software with the ssh method”
on page 117.
See “Installing client software with the sftp method”
on page 118.
See “Installing client software on UNIX clients using
password-less ssh method” on page 119.

See “About NetBackup client installation” on page 86.

Installing UNIX clients locally
The following procedure installs the NetBackup client software on a local computer.
To install client software locally on a UNIX client

1

Use one of the following methods to start the installation script:
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DVD

■

■

■

Insert the NetBackup UNIX Clients DVD into the
drive.
See “About the NetBackup media kit” on page 18.
If necessary, mount the DVD.
See “About mounting the NetBackup software media”
on page 38.
Enter the following command:
dvd_directory/install
The dvd_directory is the path to the directory where
you can access the DVD.

ESD images (downloaded
files)

■

■

Navigate to the location where the installation images
reside.
Enter the following command:
./install
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Native install tools

104

NetBackup supports the install and upgrade of the UNIX
and Linux client binaries with native installers. More
information is available.
See “Install and upgrade of the UNIX and Linux client
binaries with native installers” on page 106.

2

When the following message appears, press Enter to continue:
Veritas Installation Script
Copyright 1993 - 2016 Veritas Corporation, All Rights Reserved.

Installing NetBackup Client Software

Please review the VERITAS SOFTWARE LICENSE AGREEMENT located on
the installation media before proceeding. The agreement includes
details on the NetBackup Product Improvement Program.
For NetBackup installation and upgrade information specific to your
platform and to find out if your installed EEBs or hot fixes are
contained in this release, check out the Veritas Services and
Operations Readiness Tools (SORT) Installation and Upgrade Checklist
and Hot fix and EEB Release Auditor, respectively, at
https://sort.veritas.com/netbackup.
Do you wish to continue? [y,n] (y)

The client binaries represent the operating system versions where the binaries
were compiled. The binaries typically function perfectly on later versions of the
operating system. The installation procedure attempts to load the appropriate
binaries for your system. If the script does not recognize the local operating
system, it presents choices.

3

Type y and press Enter to continue with the software installation.
Do you want to install the NetBackup client software for this
client? [y,n] (y)

4

Type the name of your NetBackup master server and press Enter to continue.
Enter the name of the NetBackup master server:
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5
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Confirm the NetBackup client name and press Enter to continue.
Would you like to use "client_name" as the configured name of the
NetBackup client? [y,n] (y)

6

(Conditional) Enter one or more media servers if prompted:
This host cannot connect directly to the master server; therefore,
one or more media servers are required in order to contact the
master server for security information. Enter the media servers
(one per line) or X to skip the question. Enter Q to indicate all
media servers have been entered.
Enter a media server for host master.domain, Q to quit, or X to
skip this question:
media.domain
q

7

After you confirm you want to continue, the installer fetches the certificate
authority certificate details.
Getting CA certificate details.
Depending on the network, this action may take a few minutes. To
continue without setting up secure communication, press Ctrl+C.

Be aware if you press Ctrl+C, this action requires you to rerun the installation
or continue with the installation without the required security components. If
these security components are absent, backups and restores fail.

8

When prompted, review the fingerprint information and confirm that it is
accurate.
Master server [master_name] reports CA Certificate fingerprint
[fingerprint]. Is this correct? [y/n] (y)

After you confirm the fingerprint information, the installer stores the certificate
authority certificate details.
Storing CA certificate.
Depending on the network, this action may take a few minutes. To
continue without setting up secure communication, press Ctrl+C.

Be aware if you press Ctrl+C, this action requires you to rerun the installation
or continue with the installation without the required security components. If
these security components are absent, backups and restores fail.
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9

After the Certificate Authority certificate is stored, the installer fetches the host
certificate.
Getting host certificate.
Depending on the network, this action may take a few minutes. To
continue without setting up secure communication, press Ctrl+C.

Be aware if you press Ctrl+C, this action requires you to rerun the installation
or continue with the installation without the required security components. If
these security components are absent, backups and restores fail.

10 (Conditional) If prompted for the Authorization Token, please enter it.
An authorization token is required in order to get the host
certificate for this host. At the prompt, enter the authorization
token or q to skip the question. NOTE: The answer entered will
not be displayed to the terminal.
Enter the authorization token for master_server_FQDN or q to skip:

The token format is 16 upper case letters. Be aware if you press Ctrl+C, this
action requires you to rerun the installation or continue with the installation
without the required security components. If these security components are
absent, backups and restores fail.

11 Follow the prompts to complete the installation.
Additional information about installation folder restrictions is available.
See “Restrictions on the NetBackup installation directory” on page 8.

12 After the installation is complete, select Exit from this Script.

Install and upgrade of the UNIX and Linux client binaries with native
installers
You can now install and upgrade NetBackup UNIX and Linux clients with native
installers. You can use either the NetBackup install script or your preferred installer
method. This change does not include those clients that use the Debian package.
Those clients must be installed or upgraded with the NetBackup install script.
■

For AIX: lslpp, installp

■

For HP-UX: swlist, swinstall

■

For Linux: rpm, yum, etc.

■

For Solaris: pkginfo, pkgadd
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A successful installation or upgrade is recorded in the
/usr/openv/pack/install.history file.
To install or upgrade the UNIX or Linux client binaries using native installers:

1

Please create the NetBackup installation answer file (NBInstallAnswer.conf)
in the client /tmp directory. More information about the answer file and its
contents is available.
See “About the NetBackup answer file” on page 162.

2

Populate NBInstallAnswer.conf with the following information:
SERVER=master_server_name
CLIENT_NAME=client_name
CA_CERTIFICATE_FINGERPRINT=fingerprint

Example (the fingerprint value is wrapped for readability):
SERVER=master_01
CLIENT_NAME=client_101
CA_CERTIFICATE_FINGERPRINT=01:23:45:67:89:AB:CD:EF:01:23:45:67:
89:AB:CD:EF:01:23:45:67

Depending on the security configuration in your NetBackup environment, you
may need to add the AUTHORIZATION_TOKEN option to the answer file. Additional
information about the AUTHORIZATION_TOKEN option is available.
See “About the NetBackup answer file” on page 162.
Additionally, you can add either of the options shown to the
NBInstallAnswer.conf file. More information about each option is available.
See “About the NetBackup answer file” on page 162.

3

■

CLIENT_NAME=XLOCALHOSTX

■

SERVICES=no

Extract the required client files from the appropriate client package and copy
them to the client computer.
■

Download the CLIENTS1 package for UNIX clients to a system with sufficient
space.

■

Download the CLIENTS2 package for Linux clients to a system with sufficient
space.

■

Extract the contents of the CLIENTS1 or the CLIENTS2 file.
Example:
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AIX

gunzip NetBackup_8.1_CLIENTS1.tar.gz; tar –xvf NetBackup_8.1_CLIENTS1.tar

HP-UX

gunzip -dc NetBackup_8.1_CLIENTS1.tar.gz | tar -xvf

Linux

tar -xzvf NetBackup_8.1_CLIENTS2.tar.gz

Solaris

tar -xzvf NetBackup_8.1_CLIENTS1.tar.gz

■

Change to the directory for your desired operating system.
Example:

AIX

CLIENTS1/NBClients/anb/Clients/usr/openv/netbackup/client/RS6000/AIX6/

HP-UX

CLIENTS1/NBClients/anb/Clients/usr/openv/netbackup/client/HP-UX-IA64/HP-UX11.31/

Linux

For Linux RedHat:
CLIENTS2/NBClients/anb/Clients/usr/openv/netbackup/client/Linux/RedHat2.6.18/
For Linux SuSE:
CLIENTS2/NBClients/anb/Clients/usr/openv/netbackup/client/Linux/SuSE3.0.76

Linux s390x

For Linux-s390x RedHat:
CLIENTS2/NBClients/anb/Clients/usr/openv/netbackup/client/
Linux-s390x/IBMzSeriesRedHat2.6.18/
For Linux-s390x SuSE:
CLIENTS2/NBClients/anb/Clients/usr/openv/netbackup/client/
Linux-s390x/IBMzSeriesSuSE3.0.76

Solaris

For Solaris SPARC:
CLIENTS1/NBClients/anb/Clients/usr/openv/netbackup/client/Solaris/Solaris10/
For Solaris x86
CLIENTS1/NBClients/anb/Clients/usr/openv/netbackup/client/Solaris/Solaris_x86_10_64/

■

Copy the files that are shown to the client computer.
AIX

VRTSnbpck.image
VRTSpbx.image.gz
VRTSnbclt.image.gz
VRTSnbjre.image.gz
VRTSnbjava.image.gz
VRTSpddea.image.gz
VRTSnbcfg.image.gz

108

Installing NetBackup client software
About NetBackup client installation on UNIX/Linux

HP-UX

VRTSnbpck.depot
VRTSpbx.depot.gz
VRTSnbclt.depot.gz
VRTSnbjre.depot.gz
VRTSnbjava.depot.gz
VRTSpddea.depot.gz
VRTSnbcfg.depot.gz

Linux

VRTSnbpck.rpm
VRTSpbx.rpm
VRTSnbclt.rpm
VRTSnbjre.rpm
VRTSnbjava.rpm
VRTSpddea.rpm
VRTSnbcfg.rpm

Solaris

.pkg_defaults
VRTSnbpck.pkg.gz
VRTSpbx.pkg.gz
VRTSnbclt.pkg.gz
VRTSnbjre.pkg.gz
VRTSnbjava.pkg.gz
VRTSpddea.pkg.gz
VRTSnbcfg.pkg.gz

Note: The Solaris client binaries include a hidden administration
file called .pkg_defaults. This administration file contains default
installation actions.

Note: The NetBackup Java Console RPM, VRTSnbjava, is optional. You may
not want to install the NetBackup Java Console on every client in your
environment.

Note: Be aware there is no VRTSpddea.rpm for the z/Architecture client.
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4

(Conditional) For Solaris, HP-UX, and AIX, extract the compressed package
files with the command shown:
gunzip VRTS*.*

This action extracts all the package files as shown:
VRTSnbpck.pkg
VRTSpbx.pkg
VRTSnbclt.pkg
VRTSnbjre.pkg
VRTSnbjava.pkg
VRTSpddea.pkg
VRTSnbcfg.pkg

5

Install the files in the order that is shown with the command shown:
AIX

installp
installp
installp
installp
installp
installp
installp

–ad
–ad
–ad
–ad
–ad
–ad
–ad

VRTSnbpck.image all
VRTSpbx.image all
VRTSnbclt.image all
VRTSnbjre.image all
VRTSnbjava.image all
VRTSpddea.image all
VRTSnbcfg.image all

Alternatively use a single command to install all packages:
installp –ad folder_name all
HP-UX

swinstall
swinstall
swinstall
swinstall
swinstall
swinstall
swinstall

–s
–s
–s
–s
–s
–s
–s

VRTSnbpck.depot \*
VRTSpbx.depot \*
VRTSnbclt.depot \*
VRTSnbjre.depot \*
VRTSnbjava.depot \*
VRTSpddea.depot \*
VRTSnbcfg.depot \*

Alternatively use a single command to install all packages:
swinstall -s ./VRTSnbpck.depot \*;swinstall -s
./VRTSpbx.depot \*;swinstall -s ./VRTSnbclt.depot
\*;swinstall -s ./VRTSnbjre.depot \*;swinstall -s
./VRTSnbjava.depot \*;swinstall -s ./VRTSpddea.depot
\*;swinstall -s ./VRTSnbcfg.depot \*
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Linux

rpm
rpm
rpm
rpm
rpm
rpm
rpm

Solaris

Use the pkgadd -a admin -d device [pkgid] command as
shown to install the files:

–U
–U
–U
–U
–U
–U
–U

pkgadd
pkgadd
pkgadd
pkgadd
pkgadd
pkgadd
pkgadd
■

■

■

6

VRTSnbpck.rpm
VRTSpbx.rpm
VRTSnbclt.rpm
VRTSnbjre.rpm
VRTSnbjava.rpm
VRTSpddea.rpm
VRTSnbcfg.rpm

-a
-a
-a
-a
-a
-a
-a

.pkg_defaults
.pkg_defaults
.pkg_defaults
.pkg_defaults
.pkg_defaults
.pkg_defaults
.pkg_defaults

-d
-d
-d
-d
-d
-d
-d

VRTSnbpck.pkg VRTSnbpck
VRTSpbx.pkg VRTSpbx
VRTSnbclt.pkg VRTSnbclt
VRTSnbjre.pkg VRTSnbjre
VRTSnbjava.pkg VRTSnbjava
VRTSpddea.pkg VRTSpddea
VRTSnbcfg.pkg VRTSnbcfg

The -a option defines a specific admin (.pkg_defaults) to use in
place of the default administration file. The admin file contains default
installation actions.
The -d device option specifies the source of the software packages.
A device can be the path to a device, a directory, or a spool directory.
Use the pkgid parameter to specify a name for the package being
installed. This parameter is optional.

(Conditional) If you do not have the answer file in place or you do not populate
it correctly, you receive the error message shown:
WARNING: There is no answer file present and no valid bp.conf.
Therefore, security configuration is not complete. Manual steps
are required before backups and restores can occur. For more
information:
https://www.veritas.com/support/en_US/article.000127129

Change to the /usr/openv/netbackup/bin/private directory and run the
nb_init_cfg command to configure the bp.conf file. You can also manually
configure bp.conf file. You may have to set up the security and the certificate
configuration manually. More information is available.
https://www.veritas.com/support/en_US/article.000127129
Customers who use the NetBackup installation script for their UNIX and Linux clients
only see a single change to the installation behavior. The NetBackup installation
script no longer copies the installation package into the /usr/openv/pack/ directory
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on the client. A successful installation or upgrade is recorded in the
/usr/openv/pack/install.history file.

Installation error messages on UNIX and Linux, their
causes, and their solutions
Installation attempts that vary from the procedure that is shown may generate error
messages. Table 6-2 shows some of the actions and the message that is generated.
Table 6-2
Install action

Installation error messages and solutions

Error message

Solution

For AIX
User attempts to install # installp -ad VRTSnbpck.image all
the binaries on top of
package VRTSnbpck.image is already
the same version of the
installed
binaries.

Use the lslpp –L package_name
command to determine the name of the
installed package. Uninstall this package and
then retry the operation.

User attempts to install # installp -ad VRTSnbcfg.image all
the binaries in the
error: Failed dependencies:
incorrect order.
VRTSnbclt >= 8.1.0.0 is needed by
VRTSnbcfg-version-platform

Refer to the documentation for the correct
image package installation order. More
information is also available in the error which
lists the dependent packages.

User attempts to install
an older version of a
binary over the top of a
newer version of the
binary.

See “To install or upgrade the UNIX or Linux
client binaries using native installers:”
on page 107.

# installp –d VRTSnbclt.image all Use the lslpp –L package_name
command to determine the name of the
WARNING:
installed package. Uninstall this package and
file
then retry the operation.
/usr/openv/lib/java/nbvmwaretags.jar
from install of
VRTSnbclt-version-platform
conflicts with file from package
VRTSnbclt-version-platform

For HP-UX
User attempts to install # swinstall –s ./VRTSnbpck.depot
the binaries on top of
1 filesets have the selected
the same version of the
revision already installed.
binaries.

Use the swlist command to determine the
name of the installed package. Uninstall this
package and then retry the operation.
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Table 6-2
Install action

Installation error messages and solutions (continued)

Error message

User attempts to install # swinstall -s ./VRTSnbcfg.depot
the binaries in the
ERROR: "hostname:/": The software
incorrect order.
dependencies for 1 products or
filesets cannot be resolved.

Solution
Refer to the documentation for the correct
depot package installation order. More
information is also available in the error which
lists the dependent packages.
See “To install or upgrade the UNIX or Linux
client binaries using native installers:”
on page 107.

User attempts to install
an older version of a
binary over the top of a
newer version of the
binary.

Use the swlist command to determine the
name of the installed package. Uninstall this
WARNING: "hostname:/": 1 filesets
package and then retry the operation.
have a version with a higher
revision number already installed.
# swinstall –s ./VRTSnbclt.depot

For Linux
User attempts to install # rpm -U VRTSnbpck.rpm
Use the rpm command to determine the name
the binaries on top of
of the installed package. Uninstall this
package
the same version of the
package and then retry the operation.
VRTSnbpck.rpm-version-platform is
binaries.
already installed
User attempts to install # rpm -U VRTSnbcfg.rpm
Refer to the documentation for the correct
the binaries in the
RPM installation order. More information is
error: Failed dependencies:
incorrect order.
available.
VRTSnbclt >= 8.1.0.0 is needed by
See “To install or upgrade the UNIX or Linux
VRTSnbcfg-version-platform
client binaries using native installers:”
on page 107.
User attempts to install
an older version of a
binary over the top of a
newer version of the
binary.

For Solaris

# rpm -U VRTSnbclt.rpm
file
/usr/openv/lib/java/nbvmwaretags.jar
from install of
VRTSnbclt-version-platform
conflicts with file from package
VRTSnbclt-version-platform

Use the rpm command to determine the name
of the installed package. Uninstall this
package and then retry the operation.
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Table 6-2
Install action
User attempts to install
the binaries on top of
the same version of the
binaries

Error message

Installation error messages and solutions (continued)
Solution
Use the pkginfo command to determine the
name of the package that is currently installed.
Uninstall this package and then retry the
operation.
Alternatively, use the admin file that is
provided with the package to reinstall the
package.
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Table 6-2
Install action

Installation error messages and solutions (continued)

Error message
pkgadd -a .pkg_defaults -d
VRTSnbpck.pkg VRTSnbpck
Processing package instance
<VRTSnbpck> from
</root/packages/Solaris/
Solaris_x86_10_64/VRTSnbpck.pkg>
NetBackup Pre-Check(i386) 8.1.0.0
This appears to be an attempt to
install the same architecture and
version of a package which is
already installed. This
installation will attempt to
overwrite this package.
Copyright 2017 Veritas
Technologies LLC. All rights
reserved.
## Executing checkinstall script.
Using </> as the package base
directory.
## Processing package information.
## Processing system information.
6 package pathnames are already
properly installed.
## Verifying disk space
requirements.
Installing NetBackup Pre-Check as
<VRTSnbpck>
## Executing preinstall script.
Wednesday, May 10, 2017 03:15:44
PM IST: Installing package
VRTSnbpck.

Solution
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Table 6-2
Install action

Installation error messages and solutions (continued)

Error message

Solution

Installing NB-Pck.
## Installing part 1 of 1.
[ verifying class <NBclass> ]
## Executing postinstall script.
Wednesday, May 10, 2017 03:15:45
PM IST: Install of package
VRTSnbpck was successful.

User attempts to install # pkgadd -a .pkg_defaults -d
the binaries in the
VRTSnbclt.pkg VRTSnbclt
incorrect order.
ERROR: VRTSnbpck >=8.1.0.0 is
required by VRTSnbclt.
checkinstall script suspends

Refer to the documentation for the correct
package installation order. More information
is available.

User attempts to install
an older version of a
binary over the top of a
newer version of the
binary.

Use the pkginfo command to determine the
name of the package that is currently installed.
Uninstall this package and then retry the
operation.

# pkgadd -a .pkg_defaults -d
VRTSnbclt.pkg VRTSnbclt
Processing package instance
<VRTSnbclt> from
</root/80packages/Solaris/
Solaris_x86_10_64/VRTSnbclt.pkg>

See “To install or upgrade the UNIX or Linux
client binaries using native installers:”
on page 107.

NetBackup Client(i386) 8.0.0.0
The following instance(s) of the
<VRTSnbclt> package are already
installed on this machine:
1 VRTSnbclt NetBackup Client
(i386) 8.1.0.0
Do you want to overwrite this
installed instance [y,n,?,q]

About remote installation methods for UNIX/Linux clients
You can push the client software from a UNIX/Linux master server to a client host
by using the following methods:
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■

ssh

See “Installing client software with the ssh method” on page 117.
■

sftp

See “Installing client software with the sftp method” on page 118.
■

Password-less ssh
See “Installing client software on UNIX clients using password-less ssh method”
on page 119.

Note: For installation in clustered environments, enter the virtual name for the
NetBackup server and not the actual local host name. You can only push client
software from the active node.

Installing client software with the ssh method
This client installation method is based on the usage of the SunSSH and the
OpenSSH products, which must be at specific version and patch levels. For more
information about these patches, please refer to the Veritas NetBackup 8.1 Release
Notes.
Before you perform this procedure, read the following guidelines:
SSH daemon (sshd)

To use the ssh method, the UNIX client must have sshd
enabled and configured to allow root user logins.

Client software location

If you want to install client software to a location other than
the default, you must first create and link the desired directory.
Create the directory where you want the client software to
reside, and then create /usr/openv as a link to that
directory.
Additional information about installation folder restrictions is
available.
See “Restrictions on the NetBackup installation directory”
on page 8.

Backup policies

Make sure that the clients are assigned to a backup policy.

To install client software from a UNIX master server to UNIX clients with the
ssh method
◆

On the NetBackup server, run the install_client_files script.
Use one of the following commands:
■

To move software to only one client at a time:
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/usr/openv/netbackup/bin/install_client_files ssh client

The client is the host name of the client.
■

To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files ssh ALL

The ALL option specifies that you want to install all clients that are configured
in any backup policy on the server.

Installing client software with the sftp method
This client installation method is based on the usage of the SunSSH and the
OpenSSH products, which must be at specific version and patch levels. For more
information about these patches, please refer to the Veritas NetBackup 8.1 Release
Notes.
Before you perform this procedure, read the following guidelines:
SSH daemon (sshd)

To use this method, the UNIX client must have sshd enabled
and configured to allow root or non-root user logins.

Client file location

If you want to install client software to a location other than
the default, you must first create and link the desired directory.
Create the directory where you want the software to reside,
and then create /usr/openv as a link to that directory.
Additional information about installation folder restrictions is
available.
See “Restrictions on the NetBackup installation directory”
on page 8.

Backup policies

Make sure that the clients are assigned to a backup policy.

To install client software from a UNIX master server to UNIX clients with the
sftp method

1

To move the client software from the server to the /tmp directory on the client,
run the install_client_files script on the NetBackup server.
Use one of the following commands:
■

To move software to one client at a time:
/usr/openv/netbackup/bin/install_client_files sftp client user

The client is the host name of the client.
The user is the login ID that SSH requires on the client.
■

To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files sftp ALL user
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The ALL option specifies that you want to install all clients that are configured
in any backup policy on the server.
The user is the login ID required by the client.

2

After the script runs, the root user on each client computer must run the
following script:
sh /tmp/bp.<pid>/client_config

The pid is the process ID. The client_config script installs the binaries.

Installing client software on UNIX clients using
password-less ssh method
A secure UNIX client is a client which has password-less ssh configuration set
between the master and itself.
For UNIX clients which do not have password-less ssh configuration set, you can
install software on those UNIX clients locally by using either the installation DVDs
or a script.
You can install client software on UNIX clients from the policy Clients tab or from
the Actions menu when the Policies utility is selected.
Before you can install client software on UNIX clients, the following prerequisites
must be met:
■

You can install the client software from the NetBackup Administration Console
only from a UNIX NetBackup server. The server must be the server that was
specified in the logon dialog box when the interface was started. This server
must also be the master where you currently manage backup policies, and
clients must be in a policy on this master.

■

Each client that receives the software installation must have password-less ssh
set with the current master server.
The password-less ssh between the client and the master server is not required
for correct operation of NetBackup. The password-less ssh can be disabled
after the client software is installed.
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To install client software on UNIX clients

1

In the NetBackup Administration Console, expand NetBackup Management
> Policies.
Note: If you want to install client software, you cannot click File > Change
Server to get to another master server. The master server must be the server
that you specified in the logon dialog box.

2

Select the master server name at the top of the All Policies middle pane.

3

On the Actions menu, click Install UNIX Client Software.

4

Enter the authorization Token to connect to the master server.
Note: Depending on the certificate deployment security setting, NetBackup
hosts may require an authorization token to obtain a host ID-based certificate
from the Certificate Authority (master server). If the security setting is Very
High or High and in case of reinstallation, authorization token is mandatory.
For Medium security settings, authorization token is optional.
For more information about how to create an authorization token, refer to the
About Token Management for host ID-based certificates section in the
NetBackup Security and Encryption Guide.
Select the Show Token check box to view details about the authorization token
which you have entered.

5

In the Don’t install these clients box, select the clients in the list that you
want to receive the software. Click Add to move the client names to the Install
these clients box.

6

Click Install Client Software to start the installation.
Client software installation can take a minute or more per client. NetBackup
writes the messages in the Progress box as the installation proceeds. If the
installation fails on a client, NetBackup notifies you but keeps the client in the
policy. You cannot stop the installation once it starts.
During installation, NetBackup performs the following actions:
■

Copies the client software.
■

Copies from the/usr/openv/netbackup/client directory on the server.

■

Copies to the /usr/openv/netbackup directory on the client.
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■

7

Adds the required entries to the client’s /etc/services and inetd.conf
files.

When the install is complete, click Close.

To install client software to a different location on the client:
■

Create a directory where you want the software to reside.

■

Create /usr/openv/netbackup as a link to that directory before installing
software.

Adding a UNIX/Linux client after initial server installation
You may want to add UNIX/Linux clients after the server installation if you forgot
to select one during the installation. You may also add a new UNIX/Linux client
type to your backup environment.
To install client software later, you must first install the NetBackup client software
onto the NetBackup server.
To add UNIX/Linux client types to servers after initial installation

1

Use one of the following methods to start the installation script:
DVD

■

■

■

Insert the NetBackup UNIX Clients DVD into the
drive.
See “About the NetBackup media kit” on page 18.
If necessary, mount the DVD.
See “About mounting the NetBackup software media”
on page 38.
Enter the following command:
dvd_directory/install
The dvd_directory is the path to the directory where
you can access the DVD.
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ESD images (downloaded
files)

■

■
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Navigate to the location where the installation images
reside.
Enter the following command:
./install

2

When the following message appears, press Enter to continue:
Veritas Installation Script
Copyright 1993 - 2013 Veritas Corporation, All Rights Reserved.

Installing NetBackup Client Software

Please review the VERITAS SOFTWARE LICENSE AGREEMENT located on
the installation media before proceeding. The agreement includes
details on the NetBackup Product Improvement Program.
For NetBackup installation and upgrade information specific to your
platform and to find out if your installed EEBs or hot fixes are
contained in this release, check out the Veritas Services and
Operations Readiness Tools (SORT) Installation and Upgrade Checklist
and Hot fix and EEB Release Auditor, respectively, at
https://sort.veritas.com/netbackup.
Do you wish to continue? [y,n] (y)

The client binaries represent the operating system versions where the binaries
were compiled. The binaries typically function perfectly on later versions of the
operating system. The installation procedure attempts to load the appropriate
binaries for your system. If the script does not recognize the local operating
system, it presents choices.

3

Select the client type that you want to load and follow the prompts to install
that client type. Repeat as necessary until all of the client types you want are
loaded.
Make sure that you load the software for all of the UNIX/Linux client types that
you intend to install remotely from the server.

4

After the installation is complete, unmount the DVD.

5

Install the NetBackup client software on the clients you specified.
See “About remote installation methods for UNIX/Linux clients” on page 116.
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Upgrading clients after servers are upgraded
The update_clients installation script lets you push client software to clients. It
does not let you push client software to a remote client that is also a NetBackup
media or master server. You cannot push software this way because the server
software and client binaries must be of the same version on a single host.
The update_clients installation script can determine the full client list that is
configured on the server. When it is run without any parameters, it attempts to
update all clients (as determined by
/usr/openv/netbackup/bin/admincmd/bpplclients). If you do not want to
upgrade all clients, you can specify a subset of clients. Use the hardware type and
operating system parameters or use the -ClientList parameter.
You can run update_clients from a media server. The -ClientList parameter
is required in this situation. The script lets you maintain a media server and a set
of clients at an earlier release level than the master server. Doing so requires the
informed use of the update_clients -ClientList command on a master server
and a media server to avoid unwanted client upgrades.
For clustered environments, you can push client software only from the active node.
Note: Additional steps are required to deploy clients in a secure environment where
the clients do not have direct connectivity to the master server. More information
on this topic is available. See the topic on deploying certificates on clients without
connectivity to the master server in the Veritas NetBackup Security and Encryption
Guide.
During a client upgrade, the new client files are written to a directory in /tmp on the
client. This directory must have sufficient space to temporarily store the new client
files to ensure a successful upgrade. If sufficient space is not available, a status
message informs you that the upgrade script could not write to the location in the
/tmp directory. To resolve this issue, allocate more space to the /tmp directory and
perform the upgrade procedure again. The temporary directory is removed when
the upgrade is complete.
To upgrade clients after you have upgraded servers

1

Use one of the following methods to start the installation script:
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DVD

■

■

■

Insert the NetBackup UNIX Clients DVD into the
drive.
See “About the NetBackup media kit” on page 18.
If necessary, mount the DVD.
See “Mounting NetBackup software media on UNIX
or Linux systems” on page 38.
Enter the following command:
cd_directory/install
The cd_directory is the path to the directory where
you can access the DVD.

ESD images (downloaded
files)

■

■

Navigate to the location where the installation images
reside.
Enter the following command:
./install

2

When the following message appears, press Enter to continue:
Installing NetBackup Client Software.
Do you wish to continue? (y/n) [y]

The client binaries represent the operating system versions where the binaries
were compiled. The binaries typically function perfectly on later versions of the
operating system. For example, HP PA-RISC 11.11 binaries also are used on
the HP PA-RISC 11.23 level of the operating system.

3

Select the client type that you want to load and follow the prompts to load that
client type. Repeat as necessary until all desired client types have been loaded.
Make sure that you load the software for all of the UNIX client types that you
intend to push to from this server. Otherwise, you cannot add these client types
to the NetBackup policy configuration.

4

After the installation is complete, unmount the DVD.

5

As a root user on the NetBackup master server, enter the following command
to see whether bprd is running:
/usr/openv/netbackup/bin/bpps

If bprd is running, stop it with the following command:
/usr/openv/netbackup/bin/admincmd/bprdreq -terminate
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6

Enter the following command to make sure that backups or restores are not in
progress:
/usr/openv/netbackup/bin/admincmd/bpdbjobs

7

Update UNIX client software by running the update_clients script. Specify
the host names of the individual nodes (not virtual names) in the list of clients.
Use one of the following commands:
If you do not use a
-ClientList file:

/usr/openv/netbackup/bin/update_clients

If you use a
-ClientList file:

/usr/openv/netbackup/bin/update_clients
-ClientList filename

The -ClientList parameter is required on a media server.
For more than 30 clients, you can divide the list into multiple files and run
update_clients for each file.
To create a client list file, perform the following steps:
■

Change to the NetBackup admincmd directory, as follows:
cd /usr/openv/netbackup/bin/admincmd

■

Use the bpplclients command to create a file that contains a list of clients
currently configured in the NetBackup database. The options to use on this
command differ depending on whether you push from a master server or
from a media server, as follows:
If you push from the
master server:

./bpplclients -allunique -noheader > file

If you push from a media ./bpplclients -allunique -noheader -M \
server:
m_server_name > file

The option descriptions are as follows:
m_server_name

Name of the NetBackup master server in this environment.

file

Name of the file to contain the list of unique clients. If no clients
have been configured in the NetBackup database, the file is
empty.

The bpplclients command writes output to file in the following format:
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hardware os client
hardware

The hardware name. For example, run the ls command in
directory /usr/openv/netbackup/client.

os

The operating system name. For example, run the ls
command in directory
/usr/openv/netbackup/client/hardware.

client

The name of the client.

The contents of file might look like the following example:
Solaris Solaris9 curry
■

(Optional) Edit file.
Perform this step to change the contents of file. Edit file to contain only
those clients you want to update with NetBackup client software. The host
names of the clients must be the clients’ individual node names. They cannot
be virtual names. The hostname command and the domainname command
return the correct values for the individual node names. The format can be
either hostname or hostname.domainname.

8

The update_clients script requests master server information from you.
Starting update_clients script.
There are N clients to upgrade.
Do you want the bp.conf file on the clients updated to list this
server as the master server? (y/n) [y]

Type either y or n.
Press Enter.

9

Enter the number of updates you want to occur simultaneously.
Enter the number of simultaneous updates you wish to take
place. [1 - 30] (default: 15):
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10 The installer attempts to retrieve the certificate authority certificate details.
Getting CA certificate details.
Depending on the network, this action may take a few minutes. To
continue without setting up secure communication, press Ctrl+C.

Be aware if you press Ctrl+C, this action requires you to rerun the installation
or continue with the installation without the required security components. If
these security components are absent, backups and restores fail.
If a certificate authority certificate is found, you receive the message shown:

Using CA Certificate fingerprint from master server:
01:23:45:67:89:AB:CD:EF:01:23:45:67:89:AB:CD:EF:01:23:45:67
If clients need an authorization token for installation, please specify on
Token (leave blank for no authorization token):

If you leave the authorization token blank, you receive the message shown:
WARNING: Authorization Token was not specified.
Manual steps may be required before backups and restores can occur.

11 Type either y or n in response to the question.
The upgrade will likely take Y to Z minutes.
Do you want to upgrade clients now? (y/n) [y]

12 After all servers and clients are updated, start the bprd daemon as the root
user on the master server by entering the following command:
/usr/openv/netbackup/bin/initbprd

Chapter
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Configuring NetBackup
This chapter includes the following topics:
■

About NetBackup startup and shutdown scripts

■

About NetBackup server configuration

■

Update cloud configuration file on the master server immediately after install or
upgrade to NetBackup 8.1

About NetBackup startup and shutdown scripts
When you install NetBackup, the installation script also performs configuration of
startup and shutdown scripts. Startup scripts allow the NetBackup daemons to start
automatically when the system boots. Shutdown scripts automatically terminate
the startup scripts at system shutdown.
The installation process copies the NetBackup startup and shutdown scripts to the
appropriate operating system location.
For non-cluster upgrades, any existing NetBackup related startup and shutdown
scripts are saved, and the newly released versions of those scripts are installed.
Table 7-1 lists the links for the startup and the shutdown scripts for the various
platforms that are installed during NetBackup installation.
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Table 7-1

NetBackup startup and shutdown script links by platform

Platform

Links

AIX

/etc/rc.netbackup.aix

HP-UX

■

The NetBackup installation script edited the /etc/inittab
file and added the following entry to ensure that the script is
called during a level-two boot:
netbackup:2:wait:/etc/rc.netbackup.aix

■

To shut down, add the following line to the /etc/rc.shutdown
file:
/etc/rc.netbackup.aix stop

/sbin/rc1.d/K001netbackup ->/sbin/init.d/netbackup
/sbin/rc2.d/S777netbackup ->/sbin/init.d/netbackup

Linux Debian

/etc/rc0.d/K01netbackup ->/etc/init.d/netbackup
/etc/rc1.d/K01netbackup ->/etc/init.d/netbackup
/etc/rc2.d/S95netbackup ->/etc/init.d/netbackup

Linux Red Hat

/etc/rc.d/rc0.d/K01netbackup
->/etc/rc.d/init.d/netbackup
/etc/rc.d/rc1.d/K01netbackup
->/etc/rc.d/init.d/netbackup
/etc/rc.d/rc2.d/S77netbackup
->/etc/rc.d/init.d/netbackup
/etc/rc.d/rc3.d/S77netbackup
->/etc/rc.d/init.d/netbackup
/etc/rc.d/rc5.d/S77netbackup
->/etc/rc.d/init.d/netbackup
/etc/rc.d/rc6.d/K01netbackup
->/etc/rc.d/init.d/netbackup
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Table 7-1

NetBackup startup and shutdown script links by platform
(continued)

Platform

Links

Linux SUSE

/etc/init.d/rc0.d/K01netbackup
->/etc/init.d/netbackup
/etc/init.d/rc2.d/S77netbackup
->/etc/init.d/netbackup
/etc/init.d/rc3.d/S77netbackup
->/etc/init.d/netbackup
/etc/init.d/rc5.d/S77netbackup
->/etc/init.d/netbackup
/etc/init.d/rc6.d/K01netbackup
->/etc/init.d/netbackup

Solaris

/etc/rc0.d/K01netbackup ->/etc/init.d/netbackup
/etc/rc1.d/K01netbackup ->/etc/init.d/netbackup
/etc/rc2.d/S77netbackup ->/etc/init.d/netbackup

About NetBackup server configuration
After all server software is installed, you are ready to configure NetBackup to work
with the robotic and the storage devices in your environment. Remember the
operating system must recognize these devices as configured before you can
configure them in NetBackup.
See “About storage device configuration” on page 20.
Use the following guidelines when you configure NetBackup:
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NetBackup Enterprise servers The procedures for configuring master and media servers
are very similar. Veritas recommends, however, that you
configure all server information such as storage devices and
volumes from the master server. Following this order helps
ensure that the master servers properly administer the media
servers.

Warning: Communication problems between the master
server and the media server do not prevent you from running
the configuration wizards. Therefore, do not run the wizards
on the media server until the problems are corrected. If you
run any of the wizards when a communication problem exists,
the master server cannot recognize the information that you
enter. You must first correct the problem. After you correct
the problem, run the configuration wizards from the master
server.
Clustered environments

■

Configure devices on every node in the cluster.

■

Start by configuring all storage devices from the active
node so that they work with NetBackup.
For a NetBackup failover server, attach all of the devices
to each node in the cluster on which NetBackup is
installed. Refer to the clustering vendor’s documentation
for information on how to migrate to another node.
Unless otherwise noted, configure NetBackup to use the
virtual host names of master servers and media servers
in the cluster.
For complete information on to how to configure an add-on
product to fail over, see the NetBackup Clustered Master
Server Administrator's Guide.
http://www.veritas.com/docs/DOC5332

■

■

For initial NetBackup server configuration, Veritas recommends that you launch
the NetBackup Administration Console and click the Getting Started icon. A series
of wizards guide you through the following configuration procedures:
■

Configure Storage Devices
See “About the Device Configuration Wizard” on page 133.

■

Configure Volumes
See “About the Volume Configuration Wizard” on page 135.

■

Configure the Catalog Backup
See “About the Catalog Backup Wizard” on page 136.

■

Create a Backup Policy
See “About the Backup Policy Configuration Wizard” on page 137.
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If NetBackup is already configured and you want to change a specific area, click
the appropriate wizard on the NetBackup Administration Console.
For complete information on all of the NetBackup wizards and how to configure
NetBackup, see the NetBackup Administrator's Guide, Volume I.
http://www.veritas.com/docs/DOC5332
See “About storage device configuration” on page 20.

Starting the NetBackup Administration Console
Use the following procedures to open the NetBackup Administration Console to
configure NetBackup. The Getting Started wizard guides you through the primary
configuration steps to make NetBackup function.
Note: Other wizards are available from the initial NetBackup Administration Console
window that are not part of the Getting Started wizard. For example, you can
configure disk pools or create a snapshot backup policy. See the NetBackup
Administrator’s Guide, Volume I for complete information about all NetBackup
wizards.
http://www.veritas.com/docs/DOC5332
On Windows systems, if you clicked the check box Launch Administration Console
that appears at the end of NetBackup installation, you can skip this procedure.
To start the NetBackup Administration Console on Windows

1

Log on to the NetBackup server as the Administrator.

2

Click Start > Programs > Veritas NetBackup > NetBackup Administration
Console.

3

To begin configuration, on the Administration Console, click Getting Started.
The Getting Started screen appears and prompts you to begin device
configuration.
Note: If you still need to configure devices to work with the operating system,
close the wizard. You must first configure those devices as specified by the
device and the operating system vendors.
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To start the NetBackup Administration Console on UNIX

1

Log in to the NetBackup server as root.
For clustered environments, log in to the active node as root.
If you need to run the user interface on a computer other than the NetBackup
server, log on to that computer. For UNIX systems, log in as root.

2

Enter the following command:
/usr/openv/netbackup/bin/jnbSA &

3

Enter the password for root.
For clustered environments, when you log in to the NetBackup Administration
Console, specify the virtual host name in the Host field.

4

Click Login.

5

To begin configuration, on the Administration Console, click Getting Started.

6

On the initial Getting Started screen, review the content and click Next.
The following screen prompts you to Configure Storage Devices.
Note: If you still need to configure devices to work with the operating system,
close the wizard. You must first configure those devices as specified by the
device and the operating system vendors.

About the Device Configuration Wizard
Before you can run backups, you must define your storage devices for NetBackup.
This wizard guides you through this process. You must, however, be certain that
you have configured your storage devices correctly for your operating system.
NetBackup cannot function reliably unless devices are installed and configured
correctly.
See “About storage device configuration” on page 20.
For clustered environments, begin configuring all storage devices from the active
node. For a NetBackup failover server, Veritas recommends that you attach all of
the devices to every node on which NetBackup is installed.
For complete instructions, refer to the NetBackup Clustered Master Server
Administrator's Guide.
http://www.veritas.com/docs/DOC5332
This wizard takes you through the following processes:
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■

Scans the hosts for backup devices

■

Verifies the devices that were automatically detected

■

Verifies and corrects the drive configuration

■

Updates the device configuration

The wizard presents the following information when you configure devices:
Device configuration

■

■

■

When the wizard displays the Device Hosts screen, you
must specify the hosts on which to auto-discover and
configure devices (NetBackup Enterprise servers only).
When the wizard displays the Backup Devices screen,
confirm that the list of devices is complete and accurate.
If a known backup device does not appear in this list, take
the following action:
■ Verify that the backup device is physically attached to
the host.
■ Verify that all that specified device and operating
system vendor installation procedures are performed
successfully.
■ Verify that all drives correspond to the proper device.
If you need to move a drive, select the drive and drag
it to the correct location.
For clusters, ensure that you perform storage device
configuration on each node. Begin on the active node,
then move the NetBackup active node to another node
and perform the storage device configuration on that node.
Repeat for each node of the cluster on which NetBackup
runs.

Note: By default, robotic daemons and NetBackup
add-on products do not cause NetBackup to failover if
they fail. You can configure robotic devices and
NetBackup add-on products to fail over NetBackup if the
robot or the add-on product fails. The operating system
must recognize the robots as configured before you can
configure NetBackup to failover. For complete details
about fail over configuration, refer to the NetBackup
Clustered Master Server Administrator’s Guide.
http://www.veritas.com/docs/DOC5332
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Defining storage units

■

■

You define storage units from the Configure Storage
Units screen. If your system does not have a tape device,
you can store data on a disk by defining disk storage units.
When you enter a path for a storage unit, the following
rules apply:
■ Use the correct path separators (forward slash (/) for
UNIX and backward slash (\) for Windows).
■ Use a colon (:) to specify a drive separation on
Windows platforms.
■ Use the following characters only:
Alphabetic characters (ASCII A-Z, a-z)
Numeric characters (0-9)
Miscellaneous characters: plus (+), minus (-),
underscore (_), or period (.)

See “About the Volume Configuration Wizard” on page 135.

About the Volume Configuration Wizard
After you have configured your storage devices, the Getting Started Wizard starts
the Volume Configuration Wizard. However, if you only have disk storage capability,
NetBackup skips this wizard.
This wizard lets you initiate an inventory of each configured robot. NetBackup
automatically updates the volume database if it finds new robotic media during the
inventory. In addition, you can define new volumes for use in standalone drives.
For complete information about volumes or volume configuration for standalone
drives, refer to the NetBackup Administrator's Guide, Volume I.
http://www.veritas.com/docs/DOC5332
Note: For clustered environments, configure volumes from the active node.
This wizard lets you do the following tasks:
■

Select a device for volume configuration

■

Perform an inventory of the robot

■

Create new volumes

■

Create new volume groups

The wizard presents the following information when you configure volumes and
perform inventory:
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Robot or device inventory

■

■

■

Standalone drives

Multiple drive types

NetBackup conducts an inventory of the robot or the
device that you selected. To view the results after the
inventory has completed, see the Results: field.
After the device inventory has completed, the wizard
prompts you to identify which device slots contain cleaning
media.
If you upgraded NetBackup and have pre-existing barcode
rules, the barcode reader automatically detects the
designated slots for the cleaning media. If you do not
designate cleaning slots, NetBackup considers all media
(including cleaning media) as typical media and tries to
overwrite it.
After the inventory has completed, you are prompted to
identify which device slots contain cleaning media.
If you identify one or more slots as cleaning media in the
Identify Cleaning Media screen, you see the Robot
Inventory (Cleaning Media) screen. This screen displays
the results after the software updates the EMM database.
If you do not designate cleaning media, NetBackup
considers all media to be typical media (including cleaning
media) and tries to overwrite it.

■

Specify the number of volumes for the device.

■

The wizard does not let you configure cleaning tapes for
standalone drives.

When you specify multiple drive types, the following are true:
■

■

Media that is written by one robot drive may not work in
any other drive. If this situation occurs, NetBackup
considers the robot to have more than one type of drive.
If the robot has more than one type of drive, the wizard
cannot inventory the robot.

See “About the Catalog Backup Wizard” on page 136.

About the Catalog Backup Wizard
The NetBackup catalog contains information about your configuration and the
locations of backed up files and directories. If a disk fails and your catalog is lost,
a catalog backup makes it easy to restore your data and resume your backup
schedule.
Therefore, you must configure a catalog backup policy before any data gets backed
up.
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This wizard lets you create a policy for an online, hot catalog backup. Online, hot
catalog backups can back up the catalog while normal client backups are in progress.
A catalog backup policy lets you specify the following information:
■

The destinations for the catalog backup
A backup destination can be any configured storage device. For additional
disaster recovery protection, you can specify a second location for your catalog
backup.
Note: Although NetBackup supports catalog backup to disk, Veritas recommends
that you back up the catalog to a removable media that gets stored off-site.

■

The disaster recovery passphrase. More information about the passphrase is
available. See the Veritas NetBackup Troubleshooting Guide.

■

When the catalog backup occurs

■

The location of the disaster recovery file that is needed to recover from the
catalog backup

Use the following guidelines to configure a catalog backup:
■

Configure a catalog backup policy before any other files or data are backed up.

■

For clustered systems, configure the catalog backup policy from the active node.

For complete details about catalog backups, see the chapter “Protecting the
NetBackup catalog” in the NetBackup Administrator's Guide, Volume I.
http://www.veritas.com/docs/DOC5332
For instructions on how to configure a catalog backup in clustered environments,
see the NetBackup Clustered Master Server Administrator's Guide.
http://www.veritas.com/docs/DOC5332

About the Backup Policy Configuration Wizard
This wizard lets you define a backup policy for a group of one or more clients. For
clustered environments, configure the policy from the active node.
The wizard lets you specify the following:
■

Policy names and types

■

Clients

■

Files and directories to back up

■

Backup types
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■

Backup rotations

■

Starting times of backups

The wizard prompts you to choose the type of backup that you want a policy to
perform.
Table 7-2 describes the available backup types.
Table 7-2

Backup type descriptions

Backup type

Description

Full backup

Backs up all files that are specified in the file list.

Incremental backup

Backs up all the changed files that are specified in the file
list.

Differential backup

Also referred to as a Differential incremental backup.
Backs up the files that have changed since the last successful
incremental or full backup. All files are backed up if no
previous backup has been done.

Cumulative backup

Also referred to as a Cumulative incremental backup .
Only the files that changed since the last full backup that was
successful are backed up. All files are backed up if no
previous backup has been done.

User backup

Initiated manually by a user to back up specific files.

Use the following guidelines when you create backup policies:
■

The list that appears on the Client List screen of the Backup Policy Wizard is
a list of clients that are backed up. You can add, change, or delete clients from
the list.

■

You can select how often you want a backup policy to run for full or incremental
backups. In addition, you can select the retention period for the backups.

After you have completed the Backup Policy Wizard , you are asked if you want to
perform an installation verification test. To do this test, click the Activity Monitor
in the left pane of the NetBackup Administration Console. You can now monitor the
progress of the backup job.
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Update cloud configuration file on the master
server immediately after install or upgrade to
NetBackup 8.1
Note: If you use cloud storage in your NetBackup environment, you should update
your cloud configuration file on the NetBackup master server immediately after you
install or upgrade to NetBackup 8.1.
Veritas continuously adds new cloud support to the cloud configuration files between
releases. In fact, new cloud support has been added since the NetBackup 8.1 final
build. If you have updated your cloud configuration file since installing NetBackup
8.0, you must update your cloud configuration file because some recently-added
cloud providers and enchantments may not be included in the cloud configuration
file in the NetBackup 8.1 build. If a cloud provider or related enhancement is not
available in the cloud configuration file after upgrading to NetBackup 8.1, related
operations will fail.
Immediately after you upgrade to NetBackup 8.1, update to the latest cloud
configuration package to take advantage of the most recent cloud provider additions
and enhancements. See the following tech notes for more information:
https://www.veritas.com/docs/000125094
https://www.veritas.com/support/en_US/article.000126560
Refer to the following tech note for details of cloud providers and related
enhancements that were available in NetBackup 8.0 (deployed using the cloud
configuration packages) and are not available in the cloud configuration file that is
shipped with NetBackup 8.1:
https://www.veritas.com/support/en_US/article.000127978
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Upgrading NetBackup
software
This chapter includes the following topics:
■

About upgrading NetBackup

■

About the NetBackup 8.x Upgrade Portal

About upgrading NetBackup
Complete upgrade information can be found in the Veritas NetBackup Upgrade
Guide on the NetBackup Upgrade Portal. The portal can be accessed by clicking
on the following link:
http://www.veritas.com/docs/000115678
See “About Veritas Services and Operations Readiness Tools” on page 12.
See “About the NetBackup 8.x Upgrade Portal” on page 140.

About the NetBackup 8.x Upgrade Portal
The NetBackup 8.x Upgrade Portal contains the necessary information and
instructions for upgrades to version 8.1. The following is a link to the portal:
http://www.veritas.com/docs/000115678
You must perform an upgrade to NetBackup 8.1 as described in the portal
documentation.
To help you plan and prepare for an upgrade to NetBackup 8.1, the following
describes the important information that can be found on the portal:
■

Catalog backup

Upgrading NetBackup software
About the NetBackup 8.x Upgrade Portal

Before the upgrade, a catalog backup should be created to provide a backup
of the catalog in case of a failed upgrade.
■

NetBackup Catalog Check (NBCC) utility for NetBackup 8.1.
Before the upgrade, the catalog should be checked to make sure that it is free
of any inconsistencies that may cause the upgrade to fail. If the NBCC results
show any catalog inconsistencies, you must seek assistance from Veritas
Enterprise Support for additional guidance.

■

Upgrade to NetBackup OpsCenter 8.1
The Veritas NetBackup OpsCenter Administrator's Guide provides important
notes for upgrading to NetBackup OpsCenter 8.1. This upgrade must be done
before you upgrade to NetBackup 8.1.
http://www.veritas.com/docs/DOC5332

■

Catalog cleanup.
Your current NetBackup catalog must be free of any inconsistencies that may
prevent a successful upgrade.

■

Upgrade to NetBackup 8.1
After the catalog cleanup and the NBCC results are declared as acceptable and
you have upgraded to NetBackup OpsCenter 8.1, begin the NetBackup 8.1
upgrade.

If you have any questions or concerns about the upgrade process for NetBackup
8.1, please contact Veritas Enterprise Support.
See “About Veritas Services and Operations Readiness Tools” on page 12.
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server and client software
This chapter includes the following topics:
■

About NetBackup server software removal on UNIX systems

■

About NetBackup client software removal on UNIX and Linux systems

■

Removing NetBackup from UNIX and Linux servers and clients

■

About NetBackup server software removal on Windows systems

■

Removing NetBackup server and client software from Windows servers, clusters,
and clients

■

Removing NetBackup LiveUpdate from Windows systems

■

About removal of the Java Console state data from Windows servers and
Windows clients

■

Removing a clustered media server by migrating all data to a new media server

About NetBackup server software removal on
UNIX systems
NetBackup removal procedures remove NetBackup completely, along with any
installed add-on products. Each procedure gives you the opportunity to save any
data that you want and to remove add-on products before you remove NetBackup.
Veritas recommends that you use the following order when you remove NetBackup
server software:
■

Save any data that you require.

Removing NetBackup server and client software
About NetBackup client software removal on UNIX and Linux systems

This task is very important if you plan to reinstall NetBackup at a later date.
■

Remove any add-on products before you remove NetBackup server software.

■

Remove the NetBackup server software.
Note: As part of the removal of the NetBackup server software, the security
certificates are automatically deleted. If you want to retain the certificates, please
save them before removing NetBackup.
More information about this topic is available. Please refer to the information on
retaining host ID-based certificates when reinstalling NetBackup in the
NetBackupSecurity and Encryption Guide.

See “Removing NetBackup from UNIX and Linux servers and clients” on page 144.
See “About NetBackup client software removal on UNIX and Linux systems”
on page 143.

About NetBackup client software removal on UNIX
and Linux systems
Use the following guidelines when you remove NetBackup from UNIX/Linux clients:
When you remove NetBackup client software, PBX is not removed. You must
remove PBX manually. The client software removal procedure in this document
includes a step that describes how to perform this task.
As part of the removal of the NetBackup client software, the security certificates
are automatically deleted. If you want to retain the certificates, please save them
before removing NetBackup.
More information about this topic is available. Please refer to the information on
retaining host ID-based certificates when reinstalling NetBackup in the
NetBackupSecurity and Encryption Guide.
Warning: Do not remove PBX if your client uses other Veritas software products
that require PBX to run.
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Removing NetBackup from UNIX and Linux
servers and clients
Use this procedure to remove NetBackup from UNIX and Linux servers and clients.
You may also need to reference other documents for procedures of specific tasks
to remove NetBackup successfully.
Use the following guidelines when you remove NetBackup from UNIX and Linux
servers and clients:
NetBackup relational
database (NBDB) location

If you moved the NBDB files in /usr/openv/db/data from
their default installation location, this procedure includes a
step that describes how to remove these files.

Clustered environments

Before you begin to remove NetBackup, you must remove
NetBackup from the cluster application. Follow the instructions
in your cluster documentation on how to remove a group,
then you can remove NetBackup.
The virtual host name security certificates are automatically
removed from the shared drive of the cluster as a part of
NetBackup server software removal.
You must remove NetBackup from each node in the cluster.

HP-UX Service Guard
Clusters

If NetBackup has been configured to run as a clustered
package, you must also delete the following directory:
/etc/cmcluster/netbackup

PBX

When you remove NetBackup, PBX is not removed. You
must remove PBX manually. This procedure includes a step
that describes how to perform this task.

Warning: Do not remove PBX if your server uses other
Veritas software products that require PBX to run.
NetBackup Administration
Console

The NetBackup Administration Console must be closed when
you remove NetBackup. Otherwise, NetBackup may cause
a failure that forces you to restart the procedure.

To remove NetBackup from UNIX servers

1

Log on as the root user on the server or the client.

2

(Conditional: servers only) Perform a catalog backup.

3

If the NetBackup Administration Console is open, you must close it now.
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4

(Conditional: servers only) Save all important data from any add-on products
that you have installed.

5

Stop the NetBackup/Media Manager daemons with the following command:
/usr/openv/netbackup/bin/bp.kill_all

6

Identify any installed add-on products by using the following command:
AIX

lslpp -L

HP-UX

swlist

Linux

rpm -qa

Solaris

pkginfo

Seven add-on products can be installed on servers and clients. They are:

VRTSfrnb (Applies only to servers)
VRTSfrnbclt
VRTSjanb (Applies only to servers)
VRTSjanbclt
VRTSzhnb (Applies only to servers)
VRTSzhnbclt
VRTSnbsds (Applies only to servers)

Remove any add-on products found.

7

(Conditional: servers only) For Solaris systems only, run the following command:
/usr/openv/volmgr/bin/driver/sg.install -deinstall

8

To unregister NetBackup from the VxUL master configuration that is stored in
the /etc/vx/vrtslog.conf file, run the following command:
/usr/openv/netbackup/bin/vxlogcfg -r -p 51216

The -p option specifies the product ID, which is 51216 for NetBackup.

9

(Conditional: servers only) If BMR is supported and enabled on the server,
remove the associated files with the following command:
/usr/openv/netbackup/bin/bmrsetupmaster -undo -f

10 To unregister all NetBackup products with LiveUpdate, enter the following
command:
/usr/openv/netbackup/bin/nblu_registration -r
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11 (Conditional: servers only) If you moved the NBDB files from their default
installation location, you must delete these files manually as follows:
■

Navigate to the following directory where the NBDB files reside:
/usr/openv/db/data

■

Open the vxdbms.conf file.
This file contains a list of the database-related files and the path for each
file.

■

Delete each of the database-related files.

12 (Conditional: servers only) If NetBackup Fibre Transport is supported and
enabled on the server, remove the associated files with the following command:
/usr/openv/netbackup/bin/admincmd/nbftsrv_config -d

13 Remove the NetBackup configuration package with the appropriate command
as follows:
AIX

installp -u VRTSnbcfg

HP-UX

swremove VRTSnbcfg

Linux

rpm -e VRTSnbcfg

Solaris

pkgrm VRTSnbcfg

14 For the clients that support PureDisk, remove all PureDisk files with the following
command:
/opt/pdde/pddeuninstall.sh -forceclean

15 (Conditional: servers only) For the clients that support MSDP, remove all MSDP
files with the following command:
/opt/pdde/pddeuninstall.sh -basedir /usr/openv/pdde/ -ostdir
/usr/openv/lib/ost-plugins/ -forceclean

Note: Be aware the preceding command is a single command which takes
three parameters (basedir, , ostdir, and forceclean), and two directory
parameters take paths as input.

16 (Conditional: servers only) To remove the NetBackup server package, run the
command shown.
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Note: The virtual host name security certificates are automatically removed
from the shared drive of the cluster as a part of NetBackup server software
removal.
More information about this topic is available. Please refer to the information
on retaining host ID-based certificates when reinstalling NetBackup in the
Veritas NetBackupSecurity and Encryption Guide.
AIX

installp -u VRTSnetbp

HP-UX

swremove VRTSnetbp

Linux

rpm -e VRTSnetbp

Solaris

pkgrm VRTSnetbp
■

When the script asks if you want to remove the
installed package VRTSnetbp, enter y and press
Enter.

■

When the script asks if you want to continue with
the package removal using superuser permission,
enter y and press Enter.

17 Remove the NetBackup-Java Display Console by using the appropriate native
command as follows:
AIX

installp -u VRTSnbjava

HP-UX

swremove VRTSnbjava

Linux

rpm -e VRTSnbjava

Solaris

pkgrm VRTSnbjava

18 Remove the NetBackup Java Runtime Environment by using the appropriate
native command as follows:
AIX

installp -u VRTSnbjre

HP-UX

swremove VRTSnbjre

Linux

rpm -e VRTSnbjre

Solaris

pkgrm VRTSnbjre
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19 Remove the NetBackup client by using the appropriate native command as
shown.
Note: As part of the removal of the NetBackup server software, the security
certificates are automatically deleted. If you want to retain the certificates,
please save them before removing NetBackup.
More information about this topic is available. Please refer to the information
on retaining host ID-based certificates when reinstalling NetBackup in the
NetBackupSecurity and Encryption Guide.
AIX

installp -u VRTSnbclt

HP-UX

swremove VRTSnbclt

Linux

rpm -e VRTSnbclt

Solaris

pkgrm VRTSnbclt

Note: If there are running NetBackup processes and daemons, terminate them
manually for a successful NetBackup removal.

20 Remove PBX with the appropriate native command as follows:
Note: Remember, you should not remove PBX if your server uses other Veritas
software products that require PBX to run.
AIX

installp -u VRTSpbx

HP-UX

swremove VRTSpbx

Linux

rpm -e VRTSpbx

Solaris

pkgrm VRTSpbx
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21 Remove NetBackup Pre-Check package with the appropriate command as
follows:
AIX

installp -u VRTSnbpck

HP-UX

swremove VRTSnbpck

Linux

rpm -e VRTSnbpck

Solaris

pkgrm VRTSnbpck

22 To remove the /usr/openv directory, select one of the following methods:
Warning: The rm -f /usr/openv command also removes any add-on products
that are installed on the computer where you perform this command.
■

If /usr/openv is the actual directory, run the following command:
rm -rf /usr/openv

■

If /usr/openv is a symbolic link to that directory, run the following
commands:
cd /usr/openv
pwd
ls

Warning: Before you continue, make sure that you are at the correct location
and verify that the subdirectories are what you expect them to be. To help
prevent removing the wrong directories, the previous commands verify your
current location and list the files in that directory. After you verify the directory
location and its contents, remove the directory with the next commands.
rm -rf *
cd /
rm -f /usr/openv

Note: Depending on your operating system, you may need to use the rmdir
command to remove the /usr/openv directory.
rmdir /usr/openv
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23 For Linux systems only:
If you modified the startup and the shutdown scripts, run the following command:
/sbin/chkconfig --del netbackup

See “About NetBackup startup and shutdown scripts” on page 128.
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24 Remove the following startup scripts:
On AIX systems:

/etc/rc.netbackup.aix

On HP-UX systems:

/sbin/init.d/netbackup
/sbin/rc1.d/K001netbackup
/sbin/rc2.d/S777netbackup

On Linux Debian
systems:

/etc.init.d/netbackup
/etc/rc0.d/K01netbackup
/etc/rc1.d/K01netbackup
/etc/rc2.d/S95netbackup

On Linux Red Hat
systems:

/etc/rc.d/init.d/netbackup
/etc/rc.d/rc0.d/K01netbackup
/etc/rc.d/rc1.d/K01netbackup
/etc/rc.d/rc2.d/S77netbackup
/etc/rc.d/rc3.d/S77netbackup
/etc/rc.d/rc5.d/S77netbackup
/etc/rc.d/rc6.d/K01netbackup
The following startup scripts are only on servers and appear
only if NetBackup Fiber Transport was enabled on the
server:
/etc/rc.d/init.d/nbftserver
/etc/rc.d/rc0.d/K03nbftserver
/etc/rc.d/rc1.d/K03nbftserver
/etc/rc.d/rc2.d/S21nbftserver
/etc/rc.d/rc3.d/S21nbftserver
/etc/rc.d/rc5.d/S21nbftserver
/etc/rc.d/rc6.d/K03nbftserver
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On Linux SUSE systems: /etc/init.d/netbackup
/etc/init.d/rc0.d/K01netbackup
/etc/init.d/rc2.d/S77netbackup
/etc/init.d/rc3.d/S77netbackup
/etc/init.d/rc5.d/S77netbackup
/etc/init.d/rc6.d/K01netbackup
The following startup scripts are only on servers and appear
only if NetBackup Fiber Transport was enabled on the
server:
/etc/init.d/nbftserver
/etc/init.d/rc2.d/K01nbftserver
/etc/init.d/rc2.d/S05nbftserver
/etc/init.d/rc3.d/K01nbftserver
/etc/init.d/rc3.d/S05nbftserver
/etc/init.d/rc5.d/K01nbftserver
/etc/init.d/rc5.d/S05nbftserver

On other servers and
clients:

/etc/init.d/netbackup
/etc/rc0.d/K01netbackup
/etc/rc1.d/K01netbackup
/etc/rc2.d/S77netbackup
The following startup scripts are only on servers and appear
only if NetBackup Fiber Transport was enabled on the
server:
/etc/init.d/nbftserver
/etc/rc0.d/K03nbftserver
/etc/rc1.d/K03nbftserver
/etc/rc2.d/S21nbftserver

25 For AIX systems only:
■

In the /etc/inittab file, remove the following NetBackup entry:
/etc/rc.netbackup.aix

■

In the /etc/rc.shutdown file, remove the following line:
/etc/rc.netbackup.aix stop

26 Remove the LiveUpdate components as follows:

152

Removing NetBackup server and client software
Removing NetBackup from UNIX and Linux servers and clients

■

First, examine the following file to see if NetBackup is the only product that
uses LiveUpdate:
/etc/Product.Catalog.JavaLiveUpdate

■

If NetBackup is the only product that currently uses LiveUpdate, run the
following command:
/opt/Symantec/LiveUpdate/uninstall.sh -a

■

If LiveUpdate is the only product installed in the /opt/Symantec directory,
remove the following files:
rm -f /etc/Symantec.conf

Note: Before you remove the following product catalog file, make sure that
it is empty. The empty file size is equal to 0 bytes. If the product catalog
file is not empty, do not remove it because other products still require it.
rm -f /etc/Product.Catalog.JavaLiveUpdate

27 To remove the NetBackup-Java application state data for the root account, run
the appropriate command as follows:
Warning: Do not insert a space between the slash character (/) and the period
or the dot character (.) of /.veritas. A space between these characters
removes all of your files from the root level and beyond.
■

To remove the NetBackup-Java application state data for the root account
for all releases, run the following command:
/bin/rm -rf /.veritas

■

To remove the NetBackup-Java application state data for the root account
for a specific release, run the following command:
/bin/rm -rf /.veritas/java/version

Where version is the six-digit NetBackup version number. For example,
NetBackup version 8.0 with no upgrades applied would be entered as
800000.
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28 Inform NetBackup-Java users that they can remove their $HOME/.veritas
directory.
The $HOME/.veritas and the $HOME/.veritas/java directories contain
application state information, that is saved when the user exits NetBackup-Java
applications. The saved information includes table column order and size. The
process removes this directory for the root user only.
The common subdirectory in $HOME/.veritas/java/.userPrefs/vrts can be
removed.

29 If you enabled NetBackup Access Control, NetBackup placed several files on
clients and servers. These files can be divided into the following categories:
■

NetBackup application temporary files
These files are removed with NetBackup.

■

Individual user (cache) files
These cache files reside in the $HOME/.vxss directory. Inform all users that
they can remove this directory.
Files are generated in the /.vxss directory by a Single Sign-On operation
of the NetBackup Administration Console on the host where the console
runs. The NetBackup Administration Console cleans these files when an
exit function is performed, so the directory does not always contain
temporary files. However, if a system crash were to occur, any files in the
directory may be left behind. With the console shutdown , you can delete
these files safely with no data loss.
NetBackup also creates cached certificates for client and server NetBackup
applications. These files reside within the /.vxss directory. These files
typically have a name that is consistent with a DNS entry for a network
interface, as in machine.company.com. Example directory entries are as
follows:
/usr/openv/var/vxss/credentials/machine.company.com
/usr/openv/var/vxss/credentials/dhcp

These files are created with the command bpnbat -LoginMachine. If you
plan to reinstall NetBackup on the same computer at a later date, do one
of the following:
■

Preserve the certificates in the vxss/credentials directory.

If you do not preserve the certificates, you must provide the computer
identity password as originally set on the Root+AB broker. As an
alternative, you can reset the password on the Root+AB broker when
you reinstall.
For more information on Root+AB brokers, see the NetBackup Security
and Encryption Guide.
■
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http://www.veritas.com/docs/DOC5332
For more information on NetBackup Access Control and how to remove it,
see the NetBackup Security and Encryption Guide.
http://www.veritas.com/docs/DOC5332

About NetBackup server software removal on
Windows systems
When you remove NetBackup server software, the process deletes the
VERITAS/NetBackup directories from the server.
You can remove NetBackup server software in the following ways:
■

Remove server software, configuration, and catalog information.

■

Remove server software and save NetBackup configuration and catalog
information.
If you intend to reinstall NetBackup, use this procedure to save the configuration,
catalog, and log file information before you remove NetBackup.
Note: As part of the removal of the NetBackup server software, the security
certificates are automatically deleted. If you want to retain the certificates, please
save them before removing NetBackup.
More information about this topic is available. Please refer to the information on
retaining host ID-based certificates when reinstalling NetBackup in the
NetBackupSecurity and Encryption Guide.

Note: After an uninstall, some registry and some directory information remain
on a Windows computer. This behavior is by design, as these files may be in
use by either the NetBackup Authentication Service or the NetBackup
Authorization Service.
See “Removing NetBackup server and client software from Windows servers,
clusters, and clients” on page 155.

Removing NetBackup server and client software
from Windows servers, clusters, and clients
Use the following procedures to remove NetBackup software and NetBackup
configuration and catalog information.
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To remove NetBackup server and client software

1

(Conditional: cluster only) Follow the instructions in your cluster documentation
for removing a group.
No method exists to remove NetBackup from multiple nodes at the same time.

2

(Conditional: server and cluster only) If the NetBackup Administration Console
is open, close it.
(Conditional: client only) If the NetBackup Backup, Archive, and Restore
interface is open, close it.
If either of these interfaces is open when you try to remove NetBackup, a failure
may occur that forces you to restart this procedure.

3

Select Start > Settings > Control Panel.

4

On the Control Panel window, select the appropriate utility for installed
programs and applications.

5

On the Currently Installed Programs list, click Veritas NetBackup for servers
and clusters. Select Veritas NetBackup Client for clients.

6

Click Remove.
For Windows 2008/Vista and later systems, after you click Yes to continue,
another dialog box appears to inform you that PBX is still running.
Veritas recommends that you click Do not close applications. (A reboot will
be required.) to continue with NetBackup removal. PBX is stopped and
restarted automatically as needed for removal.

7

(Conditional: server and cluster only) Remove the NetBackup deduplication
user directory as follows:
In the Documents and Settings directory, delete the purediskdbuser
directory.
The virtual host name security certificates are automatically removed from the
shared drive of the cluster as a part of NetBackup server software removal.

Use the following procedure to remove NetBackup server software and save
NetBackup configuration and catalog information.
To remove and save NetBackup configuration and catalog information

1

If the NetBackup Administration Console is open, close it.
If a console session is open when you try to remove NetBackup, a failure may
occur that forces you to restart this procedure.

2

Select Start > Settings > Control Panel.
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3

On the Control Panel window, select the appropriate utility for installed
programs and applications. .

4

In the Currently Installed Programs list, click Veritas NetBackup .

5

Click Change. This action lets you modify, repair, or remove NetBackup.

6

On the Program Maintenance dialog box, select Remove.

7

Clear the check mark next to Remove all NetBackup Configuration, Catalog,
and Log files to disable this function. (The box is checked by default.)

8

Click Next.

9

If you enabled NetBackup Access Control, NetBackup placed several files on
clients and servers. These files can be divided into the following categories:
NetBackup application
temporary files

These files are removed with NetBackup.
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Individual user (cache) files

User cache files exist in their home directories, as
follows:
user\Local Settings\Application
Data\VERITAS\NetBackup
Files are generated in the \NetBackup directory by a
Single Sign-On operation of the NetBackup
Administration Console on the host where the console
runs. The NetBackup Administration Console cleans
these files when an exit function is performed, so the
directory does not always contain temporary files. If a
system crash were to occur, however, any files in the
directory may be left behind. With the console shutdown,
you can delete these files safely with no data loss.
NetBackup also creates cached certificates for client
and server NetBackup applications. These files reside
within the \NetBackup directory. These files typically
have a name that is consistent with a DNS entry for a
network interface, such as machine.company.com.
Example directory entries are as follows:
user\Local Settings\Application
Data\VERITAS\NetBackup\pc.comp.com
user\Local Settings\Application
Data\VERITAS\NetBackup\dhcp
These files are created with the command bpnbat
-LoginMachine. If you plan to reinstall NetBackup on
the same computer at a later date, do one of the
following:
■

■

Preserve the certificates in the \NetBackup
directory.
If you do not preserve the certificates, you must
provide the computer identity password as originally
set on the Root+AB broker. As an alternative, you
can reset the password on the Root+AB broker when
you reinstall. See the NetBackup Security and
Encryption Guide.
http://www.veritas.com/docs/DOC5332
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10 Remove the NetBackup deduplication user directory as follows:
Note: This step is necessary only if you upgraded to version 8.1 from a previous
or earlier version of NetBackup.
In the Documents and Settings directory, delete the purediskdbuser directory.

Removing NetBackup LiveUpdate from Windows
systems
NetBackup LiveUpdate and Veritas LiveUpdate share the same LiveUpdate agent.
When you remove LiveUpdate, you can no longer distribute NetBackup updates
automatically or other Veritas product updates.
Before you remove LiveUpdate, make sure that no other installed Veritas products
use LiveUpdate.
Use the following procedure to remove LiveUpdate files on Windows systems.
To remove NetBackup LiveUpdate on Windows systems

1

Select Start > Control Panel.

2

On the Control Panel window, select the appropriate utility for installed
programs and applications.

3

Click on LiveUpdate and select Remove.

About removal of the Java Console state data
from Windows servers and Windows clients
The NetBackup Java Console stores state data on a per-user basis. This information
includes user preferences, toolbar locations, and related settings. After you uninstall
the NetBackup Java Console, remove the state data by deleting the following folder:
USERPROFILE_DIR\Veritas\Java\JAVA_VERSION
■

For roaming user profiles, USERPROFILE_DIR is %APPDATA%.

■

For local user profiles on Windows 2008/Vista, and later, USERPROFILE_DIR is
%LOCALAPPDATA%.

■

JAVA_VERSION is a six-digit NetBackup version number. For example, NetBackup

version 8.0 with no upgrades applied would be 800000.
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Example:
On a Windows 2008 system with the 8.0 NetBackup Java Console previously
installed, and a local user profile policy, the Java Console state folder exists at
%LOCALAPPDATA%\Veritas\Java\800000.

Removing a clustered media server by migrating
all data to a new media server
You can remove clustered media servers from the NetBackup environment. You
must migrate all data from the cluster to a new standalone server, and then
decommission the old clustered server.
The steps required to migrate all NetBackup resources and decommission a media
server is covered in depth in the Veritas NetBackup Administrator's Guide, Volume
I. Please see the About decommissioning a media server topic in the Veritas
NetBackup Administrator's Guide, Volume I.
http://www.veritas.com/docs/DOC5332
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This chapter includes the following topics:
■

Generate a certificate on the inactive nodes of a clustered master server

■

About the NetBackup answer file

■

NetBackup master server web server user and group creation

■

About the NetBackup Java Runtime Environment

■

Using NetApp disk arrays with Replication Director

■

Security updates to the NetBackup database

Generate a certificate on the inactive nodes of a
clustered master server
After finishing a clustered master server installation or upgrade, you must generate
a certificate on all inactive nodes. This procedure is required for backups and
restores of the inactive node of the cluster to succeed.
Generating the certificate on the inactive nodes in a clustered master server
Note: Unless otherwise indicated, all commands are issued from the inactive node
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1

(Conditional) Add all inactive nodes to the cluster.
If all the nodes of the cluster are not currently part of the cluster, start by adding
them to the cluster. Please consult with your operating system cluster
instructions for assistance with this process.

2

Run the nbcertcmd command to store the Certificate Authority certificate on
the inactive node.
UNIX: /usr/openv/netbackup/bin/nbcertcmd -getCACertificate
Windows: install_path\NetBackup\bin\nbcertcmd -getCACertificate

3

Run the nbcertcmd command to generate the host certificate on the inactive
node.
nbcertcmd -getCertificate

4

(Conditional) If the nbcertcmd -getCertificate command fails with an error
message indicating that a token is needed, you need a token from the Certificate
Authority. Use the steps that are shown to get and correctly use the token.
■

On the active node, use the bpnbat command as shown to authorize the
necessary changes. When you are prompted for the authentication broker,
enter the virtual server name, not the local node name.
bpnbat -login -loginType WEB

■

On the active node, use the nbcertcmd command to create a token.
nbcertcmd -createToken -name token_name

The token name is not important to this procedure. When the command
runs, it displays the token string value. Note this value as it is necessary
for the next command.
■

On the inactive node, use the authorization token with the nbcertcmd
command to store the host certificate.
nbcertcmd -getCertificate -token

This command prompts you for the token string value. Enter the token string
from the nbcertcmd -createToken command.
Additional information about certificates is available. Please see the section on
deploying certificates on master server nodes in the Veritas NetBackup Security
and Encryption Guide.

About the NetBackup answer file
The NetBackup answer file (/tmp/NBInstallAnswer.conf) is used during UNIX
and Linux installs and upgrades to:
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■

Override some default values.

■

Avoid answering some questions during interactive installation.

■

Perform unattended or silent UNIX and Linux client installs and upgrades on
most supported operating systems.

Populate the NetBackup answer file on the target host before you run the installation
script. Create the file if it does not exist. The supported entries are shown along
with any relevant information.
■

AUTHORIZATION_TOKEN=ABCDEFGHIJKLMNOP | SKIP

This option tells NetBackup to automatically use an authorization or a reissue
token to retrieve the host certificate. The AUTHORIZATION_TOKEN is 16 upper
case letters. Some environments require an authorization token for backups
and restores to work correctly. If this information is required and is not provided
in the answer file, the installation fails. If you specify SKIP, the installer proceeds
without a required authorization token. This results in additional manual steps
following the installation. This entry is optional and is used only on client and
media server deployments.
■

CA_CERTIFICATE_FINGERPRINT=fingerprint | SKIP

This entry allows the installation or upgrade to automatically validate the
Certificate Authority (CA) Certificate Fingerprint. The Certificate Fingerprint is
retrieved from the CA during installation or upgrade. The fingerprint format is
59 characters and is a combination of the digits 0-9, the letters A-F, and colons
(that is 01:23:45:67:89:AB:CD:EF:01:23:45:67:89:AB:CD:EF:01:23:45:67).
The fingerprint value must be the fingerprint for the server that is specified in
the SERVER=master_server_name. To continue the installation or upgrade without
configuring security, specify CA_CERTIFICATE_FINGERPRINT=SKIP. This entry
is required for client and media server installation and upgrade.
■

CLIENT_NAME=client name | XLOCALHOSTX

This entry tells NetBackup the name of the client. The XLOCALHOSTX value allows
the local host to provide the client name. If you specify this option, you can use
the same answer file on all clients within a single master server domain. These
entries are also added to the bp.conf file. This entry is required for client
installation.
■

MEDIA_SERVER=media_server_name

This option tells NetBackup to use the named host to tunnel secure web requests
for this client. A tunnel is required when communication between the client and
the NetBackup Web Service on the master server is blocked. This communication
is required to obtain a host certificate during the NetBackup installation or
upgrade. Multiple MEDIA_SERVER entries may exist in the answer file. Each one
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is used as candidate to tunnel https requests. These entries are added to the
bp.conf file. This entry is optional for client installation and upgrade.
■

SERVER=master_server_name

This entry tells NetBackup to use the named host as the master server name.
If there are multiple server entries in the answer, the first one is used as the
master server. These entries are added to the bp.conf file. This entry is required
for client installation and upgrade.
■

SERVICES=no

This option tells NetBackup not to start the NetBackup services after the
installation or upgrade. This option lets you perform additional configuration
steps after the install or upgrade complete but before you start the services on
the NetBackup client. This entry is optional for client installation and upgrade.
■

WEBSVC_GROUP=custom_group_account_name

This option tells NetBackup to override the default web server group account
name (nbwebgrp). This group must already exist on the system. This option is
only used on the master server.
■

WEBSVC_USER=custom_user_account_name

This option tells NetBackup to override the default web server user account
name (nbwebsvc). This account must already exist on the system. This option
is only used on the master server.

NetBackup master server web server user and
group creation
Beginning with NetBackup 8.0, the NetBackup master server includes a configured
web server to support critical backup operations. This web server operates under
user account elements with limited privileges. These user account elements must
be available on each master server (or each node of a clustered master server).
Note: For security purposes, do not create web server users or groups with
administrator or superuser privileges.
You can use numerous procedures to create users and groups in operating systems.
Some specific approaches are shown, but other methods may accomplish the same
goal. The home directory path, user name, and group names are not hard-coded,
and can be changed. The default local user name is nbwebsvc, and the default local
group name is nbwebgrp. The user and group must have sufficient permissions to
run daemons.
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More information about this topic is available.
See “Installation and upgrade requirements for UNIX and Linux” on page 31.
Please be aware of the operating system-specific account and group requirements:
■

In UNIX and Linux clustered environments, make sure that the local accounts
are defined consistently on all cluster nodes. The UID must be the same for
each local account. You can use LDAP accounts on UNIX.

■

For Windows clustered master servers, you must use a domain account. You
can use a domain account for non-clustered environments, but it is not required.

■

For Windows clustered master servers, you must use a domain group.

The NetBackup Master Server installation fails if any of these requirements are not
met. On Windows, you are asked to provide the password for the user account as
part of the installation process.
Note: If the password associated with the web server account expires after initial
configuration, NetBackup provides no notification the password has expired. This
behavior is normal and expected, as the operating system manages the account
and the password.
As long as the web server remains active, the account and the web server continue
to operate normally.
When the web server is restarted, or if you attempt to restart the nbwmc service, the
service fails to start, due to the expired password. Navigate to the appropriate area
in the operating system, supply the correct password, and restart the service.
More information about the web services account and group is available. See the
Veritas NetBackup Security and Encryption Guide and the section on the web
services account.
To create the local user account and the local group:

1

2

Create a local group.
■

Linux and non-AIX UNIX: # groupadd nbwebgrp

■

AIX: # mkgroup nbwebgrp

■

Windows: C:\>net localgroup nbwebgrp /add

Create a local user.
■

Linux and non-AIX UNIX: # useradd -g nbwebgrp -c 'NetBackup Web
Services account' -d /usr/openv/wmc nbwebsvc

■

AIX: # mkuser home='/usr/openv/wmc' groups='nbwebgrp' nbwebsvc
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■

3

Windows: C:\>net user nbwebsvc strong_password /add

(Conditional) For Windows only, make the user a member of the group:
C:\>net localgroup nbwebgrp nbwebsvc /add

4

(Conditional) For Windows only, grant the Log on as a service right to the
user:
■

Go to Control Panel > Administrative Tools > Local Security Policy.

■

Under Security Settings, click Local Policies > User Rights Assignment.

■

Right-click on Log on as a service and select Properties

■

Add the local user. The default local user name is nbwebsvc.

■

Save your changes and close the Properties dialog for Log on as a
service.

About the NetBackup Java Runtime Environment
Veritas installs a customized version of the Java Runtime Environment (JRE) when
you install any of these products:
■

NetBackup master server, media server, or client software

■

NetBackup Remote Administration Console

■

OpsCenter Server, Agent, or View Builder

The customized version of JRE does not include all the directories that a standard
JRE installation includes, such as man and plugin.
Previously, the JRE package that is installed with NetBackup or OpsCenter were
only updated when you upgraded to a later release of either software. You can use
the nbcomponentupdate utility to update the JRE to a supported version for the
products shown:
■

NetBackup master server, media server, or client software

■

NetBackup Remote Administration Console

■

OpsCenter Server, Agent, or View Builder

Note: You cannot use this utility to update the JRE for the NetBackup Plug-in for
VMware vCenter.
If your system is running NetBackup 8.0 or later, use Table 10-1 to determine the
location of the nbcomponentupdate utility.
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Table 10-1

Location of JRE update utility

Product

Operating Path
system

NetBackup

Windows

install_path\netbackup\java\nbcomponentupdate.exe

UNIX or
Linux

/usr/openv/java/nbcomponentupdate

OpsCenter Server Windows

install_path\server\bin\nbcomponentupdate.exe

UNIX or
Linux

SYMCOpsCenterServer/bin/nbcomponentupdate

OpsCenter Agent

Windows

install_path\agent\bin\nbcomponentupdate.exe

OpsCenter View
Builder

Windows

install_path\viewbuilder\bin\nbcomponentupdate.exe

Remote
Administration
Console

Windows

install_path\java\nbcomponentupdate.exe

If you have a NetBackup 7.7.x or earlier, download the nbcomponentupdate utility
from the location shown:
https://www.veritas.com/support/en_US/article.000115043
More information about the nbcomponentupdate command and its parameters is
available.
NetBackup Commands Reference Guide
The NetBackup installed version of the JRE is the supported major version for that
NetBackup release. Use this utility to update to a minor version of the supported
major JRE version. For example, if NetBackup 8.0 installed JRE 1.8.0.31, the
supported major version is 1.8. Use this utility to update to JRE 1.8.0.92.
Veritas recommends that you update to another major JRE version only if the JRE
vendor declares an end-of-life for the installed JRE version. If the JRE vendor
declares an end-of-life for JRE 1.8, which is also the installed JRE version in your
environment, update to JRE 1.9.
Close the product, such as NetBackup, before you attempt to update the JRE. If
the product is active when you attempt the update, the utility exits with an error
message that requests you to close the product.
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Caution: Do not stop the utility while the JRE update is in progress. This action
can cause the product that uses the JRE, such as NetBackup, to become unstable.
If there are additional versions of the JRE installed on your system for other
applications, the NetBackup JRE does not interfere with them. The NetBackup JRE
does not provide integration with web browsers and does not allow Java Applets
or Web Start to run. For that reason, the NetBackup JRE cannot be used in a
browser-based attack that uses Java Applet or Web Start vulnerabilities.
More information about NetBackup JRE alerts is available.
http://www.veritas.com/docs/TECH50711

Using NetApp disk arrays with Replication
Director
Replication Director can replicate snapshots on a NetApp disk array in two different
situations:
■

In non-cluster mode: 7-mode is used to replicate snapshots on NAS and SAN.
The plug-in must be installed on the OnCommand Unified Manager (OCUM)
server (Figure 10-1).

■

In cluster-mode: Clustered Data ONTAP (cDOT) is used to replicate snapshots
between storage virtual machines (SVMs or vServers). Support is for NAS only.
The plug-in must be installed on either a Windows or a Linux computer other
than the OCUM server, the master server, or any media servers (Figure 10-2).

Both modes support the same topologies.
Table 10-2 describes the association between NetBackup versions and the NetApp
plug-ins.
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Table 10-2

Version compatibility

NetBackup NetApp
version
plug-in
version

Description

Ratio of master server to
OCUM server

7.7 and later

1.1

Provides 7-mode support One master server supports
MS-Windows, Standard,
for all NetBackup 7.7
many OCUM servers.
NDMP, VMware, Oracle
Replication Director
The plug-in must be installed on
features.
the OnCommand Unified
Manager (OCUM) server.

1.1 P1

Provides 7-mode support One master server supports
for all NetBackup 7.7
many OCUM servers.
Replication Director
features.

MS-Windows, Standard,
NDMP, VMware, Oracle

2.0

Provides cDOT support.

MS-Windows, Standard,
NDMP, VMware, Oracle

One master server supports
many OCUM servers.

Supported policy
types

The plug-in must be installed on
either a Windows or a Linux
computer other than the OCUM
server, the master server, or any
media servers.

Note: You must upgrade the entire NetBackup environment before upgrading the
plug-in. Upgrade all master servers, media servers, clients, and any hosts which
communicate with the plug-in.
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Figure 10-1

Communication between NetBackup and the NBUPlugin for
7-mode

NetBackup 7.7 master server
NetBackup
client 1

NetBackup
client 2

NetBackup 7.7 media server

iSCSI/FC

NetApp OnCommand Unified Manager
NBUPlugin for 7-mode

NFS/CIFS

iSCSI/FC

NFS/CIFS

Communicate via OpenStorage Technology plug-in

SnapMirror
SnapVault

7-mode Primary

7-mode Secondary
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Figure 10-2

Communication between NetBackup and the NBUPlugin for
Clustered Data ONTAP

NetBackup 7.7 master server
NetBackup
client 1

NetBackup
client 2

NetBackup 7.7 media server

NFS/CIFS

NFS/CIFS

Communicate via OpenStorage Technology plug-in
NBUPlugin for cDOT
(Linux or Windows)

NetApp OnCommand Unified Manager

Cluster 1
SVM1

Cluster 2
SnapMirror
SnapVault

SVM1

SVM2

SVM2

SVM3

SVM3
C-mode Secondary

Determining the version of the plug-in
To determine the NBUPlugin version, look for the following version file on the system
where the NBUPlugin is installed:
On Windows: Install_path\Program Files\Netapp\NBUPlugin\version.txt
On UNIX: /usr/NetApp/NBUPlugin/version.txt
The contents of the file lists the product name, the build date, and the NBUPlugin
version. If more than one plug-in is installed, both are listed.
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Upgrading the plug-in
If upgrading the NetApp Plug-in for Veritas NetBackup, make sure that all storage
lifecycle policy jobs that use the old plug-in are complete before upgrading.
To determine whether all of the jobs that are associated with a storage lifecycle
policy are complete, in process, or not started, use the following command:
On Windows: install_path\NetBackup\bin\admincmd>nbstlutil.exe stlilist
-U

On UNIX: /usr/openv/netbackup/bin/admincmd/nbstlutil stlilist -U

Security updates to the NetBackup database
As a part of security changes in NetBackup, Veritas may make changes to your
NetBackup (NBDB) database password. If you changed the password on the
NetBackup database from the default value, no changes to the password are made.
Any existing NetBackup databases which still have the default password are updated
with a new, randomly generated password. All new installations of NetBackup have
a randomly generated password assigned to the NetBackup database for improved
security. This password is not provided to the user during installation or upgrade.
You can use the nbdb_admin command to change this randomly generated
password. See the Veritas NetBackup Commands Reference Guide for more
information about the nbdb_admin command.
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